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CS610 Solved MCQS 100% Correct

of TCP/IP layering model, corresponds to basic network hardware.

+ - Physical Layer

- Network Interface Layer

« - Internet Layer

- - Transport Layer

protocols of TCP/IP layering model specify how to ensure reliable transfer.

- Physical Layer

- Network Interface Layer

« - Internet Layer

- Transport Layer

is called an end-to-end protocol because it provide a connection directly
from an application on one computer to an application on a remote computer.

- -IP
- - UDP
- -TCP

+ - None of the given

uses distance vector approach to define routing

« -BGP
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- - OSPF
« -RIP
« - None of the given

is ideal in a situation where the group is small and all members are
attached to contiguous Local Area Networks.

+ - Flood-and -Prune

+ - Configuration-and -Tunneling
+ - Core-Based Discovery

« - None of the given

Router that decrements TTL to __ sends ICMP time exceeded message, with router s
address as source address

. -3
. -2
e -1
. -0

Protocol addresses are abstractions provided by

o - hardware

. - software

« -internet


http://www.vustudents.ning.com/

www.vustudents.ning.com

Although message exchange can be used to bind addresses, sending a request for
each binding is hopelessly inefficient.

« - True

- - False
ARP is almost always used to bind a _ -bit IP address to a __ -bit Ethernet
address.

« -32,48

. -24,32

- -32,64

« 32,128

In the 1970s large organizations began to acquire multiple networks. Each network
in the organization formed island. Employees needed to choose a computer
appropriate for each task. So they needed multiple screens, keyboards and

computers.
« - False
o -True

In which method of Address Resolution Protocol the protocol address is determined
by hardware address? Were "T" stands for Table lookup, "C" for Closed-form
Computation and "D" for Data Exchange?

« T
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. -T,C

Which method of Address Resolution Protocol is useful with any hardware?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data
Exchange?

.« -T
. -C
« D
. -C,D

In which method of Address Resolution Protocol the implimentation is more
difficult?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data
Exchange?

. -T,C
« T
. -C
. D

Which method of Address Resolution Protocol resolution with minimum delay?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data
Exchange?

- T,D
] - C
e T


http://www.vustudents.ning.com/

www.vustudents.ning.com

The general form of an IP datagram is with a header followed by data. The header
contains information that controls where and how the datagram is to be sent.

e -True
. - False

To save trafficc an EGP does not summerize routing information from the
autonomous system before passing it to another autonomous system.

e - True
- - False

————————————— was especially concerned about the lack of high powered computers.

- - IEEE

+ - APRA (wrong spelling)
- -EIA

+ - None

Missing eot indicates sending computer crashed in frame format.

« - True
+ - False
The ------------- term refers to the general concept of a small block of data.
+ - Packets
- - Data

o - Frame


http://www.vustudents.ning.com/

www.vustudents.ning.com

+ - None of given

CRC can detect more errors than a simple checksum.

« - True
+ - False
The network that uses a ------------- , usually consist of a single long cable to which

computer attach.

» - Star topology

+ - Bus topology

+ - Ring topology

+ - None of the given

LAN that use ATM technology have a -------------

» - Star topology

+ - Bus topology

+ - Ring topology

+ - None of the given

A bridge uses --------------- to determine which computer is connected to which
segment, and uses the --------------- to determine whether to forward a copy of frame.
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_______________ has a jitter zero

- Virtual Private Network

- Isochronous Network

- Asynchronous Network

- None of the given

The network with Throughput T and Delay D has a total --------------- bits in transit
at a time.

« ‘D+T

.« -D-T

. DXT

. D/T

One repeater -------------

limitation.

+ - Double, triple

« - Double, 4 time

- half, triple

« - Double, half

End-to-end delivery service is connection oriented.

the maximum cable length
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e - True

. - False

A single networking technology is best for all needs.

o - True

. - False

Twice NAT allows a site to run servers.

e -True

. - False

device is used for multicasting.

- -Hub
o - Switch
« - Router

« - none of the given

does not depend on any particular unicast routing protocol.

- - PIM-DM
- - PIM-SM
- - PIM-AM

« - none of the given

A routing table contains
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. - The destination network ID

+ - The hop count to reach the network

+ - The router ID of the next hop

- All of the given

can be used to propagate information about remote networks.

+ - Dynamic routing

- Static routing

- Address resolution

+ - None of the given

protocol is designed to use within an organization.

- OSPF

- MEOSPF

- MOSPF

« - none of the given

NAPT stands for

. - Network Address and Protocol Translation

« - Network Address and Port Translation

+ - Network Address and Packet Translation
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+ - None of the given

In dynamic routing, the routing table is initialized when system boots.

« - True
+ - False
OSPF includes address mask with each address.
- - 30Bit
« - 32Bit
+ - 34Bit

« - none of the given

Twice NAT fails if an application uses the IP addresses instead of Domain Name.

o -True

« - False

uses window mechanism to control the flow of data.

- -IP
- -UDP
- -TCP

« - none of the given

TCP uses mechanism to control the flow of data.

« -door
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. - window
+ - acknowledgment
o - retransmission

IGPs stand for

- Internal Gateway Protocols

+ - Interior Gateway Protocols

+ - Intermediate Gateway Protocols

« - None of the given

protocol uses distance vector algorithm.

- -IGP
- -BGP
- - RIP

+ - none of the given

measures distance in network hops, where each network between the
source and destination counts as single hop.

- -BGP
« - OSPF
- - RIP

« - Non of these
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Network Address Translation (NAT) requires device to perform packet translation.

+ - True
« - False
We use the term to refer to a measure of the path that routing software use

when choosing a route.

+ - routing path

+ - routing metric

« - routing

+ - switching

Part of the 3-way handshake used to create a connection, requires each end to

generate a random ________Sedquence number.
. - 32bit
+ -16Dbit
- -8bit
« - 64bit

Reconstruction of original datagram is called reassembly.

e -True

. - False

Reliability is the responsibility of the layer.
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- Transport

- Network

- Physical
o - Internet

is ideal in a situation where the group is small and all members are
attached to contiguous Local Area Networks.

+ - Flood-and -Prune

« - Configuration-and -Tunneling
+ - Core-Based Discovery

+ - None of the given

In Direct point to point communication adding the Nth computer requires------------
new connections.

+ - None of the given

. N2
« -N-1
« - (N*-N)/2

The number of connections needed for N computer in direct point to point
communication is equal to:

« - (N>-N)/2

« -N(N-1)
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. -N?
+ - None of the given

Hardware that calculates a CRC uses two simple components.

+ - AND unit and XOR unit

+ - Shift register and XOR unit
+ - Shift register and AND unit

« - None of the given

The Gigabit Ethernet hardware operates at a rate of --------

« 10 Mbps

+ - 100 Mbps

+ - 1000 Mbps

« - None of the given

computes shortest paths in a graph by using weights on edges as a

measure of distance.

+ - Greedy algorithm

» - Distance vector algorithm
« - Dijksta’s algorithm

+ - Non of the given

Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a
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+ - Connectionless service paradigm

+ - Connection-oriented service paradigm

- Both Connectionless and Connection-oriented service paradigm

+ - None of the given

An Internet Address (IP address) is a unique binary number assigned to
a host and used for all communication with host

« - 48-bit
. -32-bit
o - 24-bit

+ - None of the given

The address identifies the physical network to which the computer is
attached, while the identifies an individual computer on that network.

+ - prefix , suffix

« - suffix , prefix

. - suffix , suffix

+ - None of the given

places the boundary between the first and second octets

- -Class A

o« -ClassB

o -ClassC
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« -ClassD

places the boundary between the second and third octets.

+ -Class A
+ -Class B
+ -ClassC
« -ClassD

places the boundary between the third and fourth octets.

+ -Class A
+ -ClassB
+ -Class C
+ -ClassD

Field of header indicates whether a datagram is a fragment or a complete
datagram.

- - FLAGS

« + FLAGMENT OFFSET
« - IDENTIFICATION

+ - None of the given

provides connectionless service.

- - TCP
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- - UDP

- -IP

« - None of the given

UDP and TCP are both layer protocols
+ - Physical
« - Data link
+ - Network

- - Transport

identifies which application program on receiving computer should receive

the data
Logical address

- - Source port

« - Source port

+ - Destination Port

+ - None of the given

identifies the application program that sent the data.

« - Destination Port
« - Source port

+ - Logical address
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+ - None of the given

The Border Gateway Protocol (BGP) uses for all communication
- - UDP
« -TCP

- Both UDP and TCP

+ - None of the given

Which of the following protocols allows the sender and receiver to enforce polices.

- -RIP
« - OSPF
- -BGP

e - RIP and OSPF

ICMP message transport is acted upon by getting ICMP encrypted in IP.

« - True
- - False
These ICMP message transport is acted upon as frames on

« - Intranet, LAN

« - Internet, WAN

« - Intranet, WAN

« - Internet, LAN
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Address mask defines how many bits of address are in suffix?

o -True
- - False

A computer attached to a given network can only communicate with other
computers attached to the same network. Is this a problem with multiple networks?

e - True
« - False

The term self-identifying is used for Classful IP addresses because the class of the
address can be computed from the address

« -itself
+ - prefix
« - suffix
« -mask

Find the class of the address:
11110011 10011011 11111011 00001111

. A
. - C
. -E
. B

There are three standard implementations to improve computational efficiency: Hashing,
Direct Indexing and Indirect
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Indexing

False

A address-binding table is used for each physical network.
New

Similar

Separate

Old

layer Provides reliable delivery of datagram.

Network

Transport

Datalink

none of the given

Due to revolutionalization of IP-V6 the speed has increased from

512to 1 GB
encapsulates IP datagram as data area in hardware frame.

Network Interface Layer
Datalink Layer

Network Layer

none of the given

Field of header indicates whether a datagram is a fragment or a complete
datagram.
FRAGMENT OFFSET

as the Internet grew, the original Classful addressing scheme became a limitation. The IP
address space was being exhausted because all networks had to choose one of four

possible sizes.
False

As the Internet grew, the original Classful addressing scheme became a limitation. The IP
address space was being exhausted because all networks had to choose one of

possible sizes.

Three

Header contains all information needed to deliver datagram to the destination computer.
But which one of the following is not included:
Rectifier
contains all information needed to deliver datagram to the destination.
Header
one of the parameters, which motivated IP for change is address space. The
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address space allows for over a million networks. But most networks are
class C and too small for many organizations.

32-bit

Class A mask is 255.0.0.0 which is used for _____

Sub netting

Postfix defines how much of address used to identify network.

False
field is used to identify a specific path through the network

FLOW LABEL

is a technique used to Limit datagram size to small MTU of any network
Fragmentation
Hashing is the transformation of a string of characters into a usually shorter fixed-length
value or a key that represents the original string.
True
In , the protocol address assigned to a computer is chosen carefully so

that computer’s hardware address can be computed from the protocol address using basic
Boolean and arithmetic operations.

Closed-form Computation
Routers use to forward datagram along prearranged path.
Flow label

Mapping between a protocol address and a hardware address is called Address
Resolution.

True
Preliminary version of IP was called

IP - Next Generation (IPng)
Source is responsible for fragmentation.

IPV6
End to End delivery Service of IP datagram is
Connectionless
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Every hardware technology specification includes the definition of the maximum size of

the frame data area, which is called the Transmission Unit.
Maximum

IPV6 addresses are bits.

128

MTU Stands for
Maximum transmission unit
shows senders preference for low latency, high Reliability.

SERVICE TYPE

NEXT HEADER field in the base header defines type of header it appears at the end of
fixed-size base header.

True

There are two standard implementations to improve computational efficiency: Hashing
and direct indexing

True

A datagram cannot be larger than of a network over which it is sent.

IP header

The protocol address of the next hop must be to an equivalent hardware

address before a packet can be sent.

Translated
The physical addressing in a WAN is similar as in LAN in the way................

The data is transmitted in packets equivalent to frames.

Each packet has a format with header.

The packet header includes destination and source addresses.

All of the above

In Asynchronous Transfer Mode VPI/VCI fields identify the cells--------------

Which one of the following is a method for computing routing table information?

Manual entry
Boot time routing
Static routing
None of the above
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All destinations on same switch have same

Router
Information

Next hop

None of the above

Which of the following statement is wrong regarding ATM?
It is a single technology for voice, video and data

It has low jitter and high capacity.

It uses fixed size, small cells, and 48 octet’s data

None of the above

Which one of the following is the responsibility of Djikstra’ algorithm?

To compute the shortest path between two nodes
To extract next hop information from path information
To insert next hop information into routing table

All of the above

Which of the following statement is true regarding Link-state routing?
Network topology is separated from route computation.

Each switch builds its own routing tables.

Link-state routing uses Djikstra’s algorithm.

All of the above

Jitter is significance for ------------------

Voice

Video

Data

All of above

The routing table contains information about the .................. immediately around
it.

Topology of the network
Destination

Both of the above

None of the above

(1) There are three types of Hubs that exist. Which of the following options
correctly describes these three?
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aoc o

b

ap e

Passive, dormant, special
Active , dormant , passive
Passive, Active, Turbo

. Passive, Active, Intelligent

A number of different factors determine the cost of a Hub. Which of the
following is among these factors?

Speed rating
Durability
Brand

Class

Which of the following network topologies among the list below is incorrect?

o TR

Star
Internet
Ring

Bus

Which of the following is not a feature of Base band Coaxial Cable?

ae o

Bi-directional

Few Kilometer range

Proton based

Ethernet(basis for 802.3) at 10 Mbps

Which of the following is not a function of a repeater?
Uses Jumper Settings

Transmits data in both directions

No Buffering

Joins two (2) segments of cables

Which level of the TCP/IP reference model routes data/information across a
network channel?

Application layer

Data Link Layer

Transport Layer

Network Layer
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The function of a modem is to convert signals. Identify the correct signals it
converts.

Analogue to Digital

Analogue to Baud rate

Baud rate to Analogue

Digital to Binary

Which of the following is not a LAN — Architecture?.

(a) Protocol architecture

Media access control

Logical Protocol

Logical Link Control

Identify the statement which best describes TCP and UDP.
TCP is a connection oriented Protocol whiles UDP is a datagram service
TCP is a protocol for the Network Layer of the OSI

UDP and TCP could be used interchangeably

TCP is an advanced protocol whiles UDP is a single protocol
Which of the following characteristics best describes a frame?
Data link layer(Header, Trailer, Data)

Network Layer(Header, Trailer, Data)

Transport Layer(Header, Trailer, Data)

Physical Layer(Header, Trailer, Data)

What does the terminology ISDN mean?
Internal Digital Services Network
Integrated Systems Digital Network
Integrated Services Digital Naming System
Integrated Services Digital Network

What does the terminology ATM mean?
Automatic transfer mode

Automatic translation mode
Asynchronous transfer mode

Asynchronous transformation mode

A simple Architecture for File Transfer is made up of :

File transfer application; Communications service module; Network access module

File transfer application; transport layer; Network access module
Network access layer; Transport layer; Application layer
Application layer; Network layer; Session layer

Which of the following statements is true about standards?
Standards create additional cost
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Standards help individuals’ users to increase effectiveness
Standards allow products from multiple vendors to communicate
Standards cannot freeze technology

Which of the following statement is true about FLOW CONTROL?

Flow control is a function performed by a receiving entity to limit the
amount or rate of data on a network.

Flow control adjusts the weights on a network

Flow control is a function performed by the MODEM

Flow control is an advanced form of network management

Identify the most suitable description for ERROR CONTROL?

Error control is an activity that manages deadlock.

Error control is an advanced form of parity bit

Error control is a sub-function of a modem and Hub

Error control is needed to guard against loss or damage of data

What is the full meaning of the terminology SMTP?

State Mail Transfer Protocol

Simple Mail Tailor Protocol

Simple Management Transfer Protocol
Simple Mail Transfer Protocol

Several Computers connected together is called:

Client-server

Client

Computer network
Hub

In which of the following networks does the client submit a task to the server, then
the server executes and returns the result for the requesting client station?

(a) Peer-to-Peer
(b) Client-Server
Server-Based

All of the above

In which network topology are all workstations connected in cascade form?
Star

Ring

Mesh
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Bus

Which network topology uses a Hub?

Star

Bus

Mesh

Ring

Which of the following topologies is used for Ethernet?

Star

Bus

Ring

All of the above

Computers on a university campus are connected by a/an:
MAN

WAN

LAN

INTERNET

The primary function of the network layer is:

Error detection
Set up a session
Routing
Encryption

Which of the following standards apply to logical link control?

IEEE 802.3
IEEE 802.2
IEEE 802.5
IEEE 802.4

Which organization defines standards for telecommunication?
ITU
IEEE

EIA
ISO

Which of the following statements is a true description of fibre Optic Cable?
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Fiber optic cables transfer data in a mesh

Fiber optic cables transfer data in light form
Fiber optic cables are similar to coaxial cables
Non of the above

Which of the following is not true of switching technology?

Packet Switching

Link Switching

Packets are switched in the form of datagram
Circuit switching techniques

Which of the following is a true description of Multi-stage Switching?

More simple control

Increased number of crossed points
More complex control

Reduced Reliability

Flooding in networks and data communication has certain properties. Which of the
options below is a property of flooding?

All possible routes are tried
All paths are loaded

All nodes are linked
Can not be used to set up virtual circuit

Identify any of the following statements which truly describe a virtual circuit.

(a) Packets are forwarded more quickly and no routing decisions
(b) More reliable in functionality
(c) Call set up phases are present

Packets are centralized at random and more routing decisions are made
Which of the following operating systems software is most suitable for wide area
network?

DOS

0S/2

WINDOWS NT
NOVELL NETWARE

Binding is an important function in establishing communication between a Client
and a Server. Which of the following statements truly describes binding in
protocols?
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(a) Binding protocols to network interfaces specifies that the selected
protocol can be sent and received through the selected LAN interface card.
(b) Binding is a function of the Network Operating Systems Software

Binding is a configuration process in mail server management.

Binding serves as a security layer in operating systems.

(36) In configuring Windows NT 4.0 for Network Access. There are seven (7) areas
to be addressed. Identify from the options below the area that should not be
addressed.

Protocols

Bindings

IP Address

Autoexec Management

Which of the following is not a network adapter?

3 com LPIII

3 com Ether link III ISA

3 com Ether link II Adapter

3 com 3C508 ISA 16 BIT

Which of the following statement is true about an IP address?
IP address is based on your computer network card

IP address is issued by a computer vendor

IP address is a Transport Protocol

IP address is not used on the internet

Which of the following is not associated with the session layer?
Control of dialogue between applications

Dialogue discipline

Data compression
Synchronization
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CS 610 Solved (Correct) MCQOS (References are given in Blue

Font) UMAIR SID

The protocol address of the next hop must be to an equivalent hardware
address before a packet can be sent.

Encrypted

Decrypted

Translated

Non of these

A address-binding table is used for each physical network.

New

Similar

Separate

Old

UDP provides connection-oriented service.

True

False

TCP provides connection oriented reliable data streaming service, whereas UDP provides
connection-less unreliable messaging service.

The UDP stands for
Universal Datagram Protocol
User Datagram Protocol
United Datagram Protocol
None of the given

In 3-way handshake TCP requires to generate a random sequence number.
30 bit

32 bit

34 bit

none of the given

TCP stands for

Transport control protocol
Transmission control protocol
Terminal control protocol

None of the given

As the Internet grew, the original Classful addressing scheme became a limitation.
The IP address space was being exhausted because all networks had to choose one
of three possible sizes.

Select correct option:

True

www.vustudents.ning.com
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False
Question # 4 of 20 ( Start time: 06:44:07 PM )
TotalMarks: 1
Twice NAT allows a site to run servers.
Select correct option:
True
False
Preliminary version of IP was called
Select correct option:
IP - New Generation (IPng)
IP - Next Generation (IPng)
IP - Net Generation (IPng)
None of the given
As the Internet grew, the original Classful addressing scheme became a limitation.
The IP address space was being exhausted because all networks had to choose one
of two possible sizes.
Select correct option:
True
False
uses window mechanism to control the flow of data.

Select correct option:
IP
UDP
TCP
none of the given
TCP uses window mechanism to control the flow of data.
The Internet service providers coordinate with the Internet assigned number
authority to obtain their network numbers.
Select correct option:
True
False
Which protocol is used to test different tools.
Select correct option:
ICMP
IGMP
TCP/IP
none of the given
USING ICMP TO TEST REACHABILITY:
ICMP can also be used to test different tools. An Internet host A, is reachable from
another host B, if datagram’s can be delivered from A to B. Ping program tests reach
ability. It sends datagram from B to A, that echoes back to B. it uses ICMP echo request
and echo reply messages. Internet layer includes code to reply to incoming ICMP
echo request messages.

identifies the application program that sent the data.
Select correct option:

www.vustudents.ning.com
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Destination Port

Source port

Logical address

None of the given

The Source can configure outgoing datagram’s to avoid
Select correct option:

Segmentation

Defragmentation

Fragmentation

None of the given

Fragmentation should be avoided. Source can configure outgoing datagrams to avoid
fragmentation. Source determines path MTU- smallest network MTU on path from
source to destination.

Question # 18 of 20 ( Start time: 06:57:12 PM )
TotalMarks: 1

The time for acknowledgement to arrive depends on
Select correct option:

Distance to destination

Current traffic conditions

Both a and b

None of the given

The time for acknowledgement to arrive depends on:

* Distance to destination

* Current traffic conditions

which is not the type of error messages defined by ICMP.
Select correct option:

Source quench

Time exceeded

Destination unreachable

None of the given

ERROR MESSAGES:

These are as follows:

* Source quench

* Time exceeded

* Destination unreachable

* Redirect

* Fragmentation required

is used to attach two autonomous systems.
Select correct option:

BGP
IGP
EGP
none of the given

www.vustudents.ning.com
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Question # 2 of 20
Due to revolutionalization of IP-V6 the speed has increased from
Select correct option:

56kbps to 512kbps

512kbps to 1gbps

56kbps to 1gbps

none of the given

Scale is also dramatically changed. Size from a few tens to a few tens of millions

Of computers has been revolutionized. Speed has increased from 56Kbps to 1Gbps. Also
There is an increased frame size in hardware

Question # 3 of 20

Whenever it handles a packet, IP software needs to separate the destination address into a
prefix.

Select correct option:

True

False

COMPUTING THE CLASS OF AN ADDRESS:

Whenever it handles a packet, IP software needs to separate the destination

Address into a prefix and suffix.

Question # 4 of 20
TTL stands for
Select correct option:

Time to Learn
Time to Leave
Time to Live
none of the given

Question # 5 of 20
IGPs stand for
Select correct option:

Internal Gateway Protocols

Interior Gateway Protocols

Intermediate Gateway Protocols

None of the given

Question # 6 of 20

identifies which application program on receiving computer should

receive the data
Select correct option:

Logical address
Source port
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Destination Port

None of the given

Field Destination Port identifies which application program on receiving computer should
receive the data. While field source port identifies the application programs that sent the
data.

Question # 7 of 20

encapsulates IP datagram as data area in hardware frame.

Select correct option:

Network Interface Layer

Datalink Layer

Network Layer

None of the given

The network interface layer encapsulates an entire datagram in the data area of a
hardware frame

vuzs.net

Question # 8 of 20

Class A mask is 255.0.0.0 which is used for

Select correct option:

Unicasting

Multicasting

Subnetting

All of the given

class A mask is 255.0.0.0 which is used for subnetting.

Question # 9 of 20

NAT is not useful at a residence with Cable Modem or DSL connectivity.
Select correct option:

True

False

Question # 10 of 20

Autonomous System chooses a routing protocol to exchange routing information which is
passed before being summarized to another group.

Select correct option:

True

False

Question # 11 of 20
layer Provides reliable delivery of datagram.
Select correct option:
Network
Transport
Datalink
none of the given

Transport layer provides reliable delivery. Network layer — IP — can detect and
report errors without actually fixing them. It focuses on datagram delivery. Application
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layer is not interested in differentiating among delivery problems at intermediate routers
Question # 12 of 20

The process of using a routing table to select a next hop for a given datagram is
called

Select correct option:

Encapsulation

Reassembling

Routing or forwarding

None of the given

The process of using a routing table to select a next hop for a given datagram is called
routing or forwarding.

Question # 13 of 20

The process of learning the path MTU is known as path MTU discovery.

Select correct option:

True

False

The process of learning the path MTU is known as path MTU discovery.

Question # 14 of 20

As the Internet grew, the original Classful addressing scheme became a limitation. The IP
address space was being exhausted because all networks had to choose one of
possible sizes.

Select correct option:

three

two

four

five

Three

As the Internet grew, the original Classful addressing scheme became a limitation.
The IP address space was being exhausted because all networks had to choose one of
Three possible sizes. Many addresses were unused.

Two new mechanisms were invented to overcome the limitations, which are as
Follows:

* Subnet addressing

* Classless addressing

Question # 15 of 20

End to End delivery Service of IP datagram is

Select correct option:

Connection oriented
Connectionless
bothaandb

none of the given

Question # 16 of 20

EGP stands for
Select correct option:
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Extension Gateway Protocol
Exterior Gateway Protocol
Explicit Gateway Protocol
none of the given

Question # 17 of 20

Hashing is the transformation of a string of characters into a usually shorter fixed-length
value or a key that represents the original string.

Select correct option:

True

False

Hashing is the transformation of a string of characters into a usually shorter fixed-length
value or a key that represents the original string. Hashing is used to index and retrieve
items in a database because it is faster to find the item using the shorter hashed key than
to find it using the original value. It is also used in many encryption algorithms.
Question # 18 of 20

Although the ARP message format is sufficiently general to allow arbitrary protocol and
hardware addresses. ARP is almost always used to bind a 32-bit IP addresstoa _____
Ethernet address.

Select correct option:

16-bit

48-bit

64-bit

128-bit

Although the ARP message format is sufficiently general to allow arbitrary protocol and
hardware addresses. ARP is almost always used to bind a 32-bit IP address to a 48-bit
Ethernet address

Question # 19 of 20

Reliability is not the responsibility of the Transport layer.

Select correct option:

True

False

Reliability is the responsibility of the Transport layer. In TCP/IP, TCP provides reliable
transport service. Most Internet applications use TCP as no other protocol has proved to
work better.

Question # 20 of 20

IPV6 address with leading zeros is interpreted to hold an IPV4 address.

Select correct option:

http://vustudents.ning.com//

96

100
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120

none of the given

IPv6 address with 96 leading zeros is interpreted to hold an IPv4 addressQuestion # 1 of
20

NAT software does not allow a PC to connect with the Internet and act as a NAT device
at the same time.

Select correct option:

True

False

Question # 2 of 20

TCP uses the term segment to refer to a

Select correct option:

packet

message

both (a) and (b)

None of the given

both a and b?

TCP uses single format for all messages. TCP uses the term segment to refer to a
message. Each message sent from TCP on one machine to TCP on another machine uses
this format including data and acknowledgement.

Question # 3 of 20

The Universal Datagram Protocol is a message-oriented protocol.

Select correct option:

True

False

UDP has the following characteristics.

« It is an end-to-end protocol. It provides application-to-application communication.
« It provides connectionless service.

* It is a Message-Oriented protocol.

* It uses best-effort delivery service.

« It follows arbitrary interaction.

« It is operating system independent

Question # 4 of 20

field tells the receiver how to order fragments within a given datagram.
Select correct option:

FLAGS

FLAGMENT OFFSET

IDENTIFICATION

None of the given

The FRAGMENT OFFSET field tells a receiver how to order fragments within a given
datagram

Question # 5 of 20

IP datagram can contains octets.
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Select correct option:

0-65,535
1-65,535
1-65,536
none of the given
Datagrams can have different sizes i.e.
Header area is usually fixed (20 octets) but can have options. Data area can contain
between 1 octet and 65.535 octets (216-1).
Usually, data area is much larger than header.
Question # 6 of 20
The amount of buffer space available at any time is called the window.
Select correct option:
True
False
Question # 7 of 20
Source is responsible for fragmentation.
Select correct option:

IPV4

IPV6

IPv6 source (not intermediate routers) is responsible for fragmentation. Routers
simply drop datagrams larger than network MTU (Maximum Transmission Unit). So
source must fragment datagram to reach destination.

Question # 8 of 20

Routers use to forward datagrams along prearranged path.

Select correct option:

Traffic class
Flow label
Destination address
none of the given
Routers use flow label to forward datagrams along prearranged path
Question # 9 of 20
protocol uses three way handshake to begin a connection.
Select correct option:

UDP

TCP

1P

none of the given

Question # 10 of 20

Typical internet routing uses uses a combination of two metrics

Select correct option:

routing metrics
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administrative cost and routing metrics

hop cost

administrative cost and hop count

Question # 14 of 20

Network Address and Port Translation (NAPT) is by far the most popular form of

Select correct option:

Network Address Transmission

Network Address Translation

Network Address Transformation

None of the given

Question # 15 of 20

The routers within an autonomous system use a to exchange routing
information.

Select correct option:

Interior Gateway protocols(IGPs)

Exterior Gateway protocol (EGPs)

Both Interior Gateway protocols(IGPs) and Exterior Gateway protocol (EGPs)

None of the given

It is used among routers within autonomous system. The destinations lie within IGP.
Question # 17 of 20

Interior Gateway Protocols (IGPs) and Exterior Gateway Protocols (EGPs) two broad
classes of Internet Routing Protocol.

Select correct option:

True

False

Question # 18 of 20

The Network Layer Protocol ICMP stands for
Select correct option:

Instant Control Message Protocol

Internet Control Message Protocol

Initial Control Message Protocol

None of the given

Question # 19 of 20

The Current version of IP-Version 4 is old
Select correct option:

18 years
20 years
22 years
none of given
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TCP is a connectionless and reliable transport protocol.
Select correct option:

True
False

ATM header is about the of the cell.
Select correct option:

15%

10% page 66

20%

5%

Jitter is significance for
Select correct option:
Voice
Video
Data
Al of above page 66
How many methods exist for building routing table?

Select correct option

1

2 pages

34
The process of forwarding the packets of information is called routing
The routing table contains information about the immediately
around it
Select correct option:

* Topology of the network

* Destination page 58

* Both of the above

* None of the above

Asynchronous Transfer Mode uses the concept of

Select correct option:

Connection-less networking
* Connection-oriented networking page 66

Which of the following statement is true regarding ATM?
Select correct option:

* It is a single technology for voice, video and data

* It has low jitter and high capacity

It uses fixed sized small cells. 48 octet's data

* All of the above page 65

A can forward or block messages based on the information in the message
itself
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Select correct option

Message digest

Proxy firewall

* Packet filter firewall not found in handouts

* Private Key

You can use an IP packet filter firewall to create a set of rules that either discards or
accepts traffic over a network connection.(Source to confirm
http://publib.boulder.ibm.com/infocenter/powersys/v3rlm5/index.jsp?
topic=/ipha5/packetfilterfirewall.htm)

Transmission media are usually categorized as

Select correct option:

* Guided or unguided

Fixed or unfixed

Determinate or indeterminate

Metallic or nonmetallic

Which of the following is not a guided medium?

Select correct option:

Twisted-pair cable

Fiber-optic cable

e Atmosphere

Coaxial Cable

Which multiplexing technique transmits digital signals?
Select correct option:

WDM

FDM

* TDM

None of the above

All destinations on same switch have same

Select correct option:

Router

Information

* Next Hop page 58

None of thee above

Which of the following statement is true regarding Distance-Vector Routing?
Select correct option:

It is very simple to implement.

* Packet switch updates its own routing table first. Page 64
It is used in RIP.

* All of the above

An exterior switch is one with which

Select correct option:

* Computers are attached page 59

No computer is attachede

Hubs are attached externally None of the above

Frame relay is
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Select correct option:

* Connection oriented service page 64

» Connectionless service It is typically ranges from 5Mbps to 1000Mbps. None of the
above

An interior switch is one with which

Select correct option:

Computers are attached

* No computer is attached page 59

Computers are attached internally

None of the above

Which of the following is not a benefit of source independence?

Select correct option:

It allows fast and efficient routing.

* Packet switch do not need to have complete information about all destinations
Network functions even if topology changes

None of the above

Which of the following statement regarding ATM is true?
Select correct option:

Connections in ATM are called virtual channels

The VC is identified by a 24-bit value formed from the VPI
* Both (a) and (b)

None of the above
ATM header is about the ---------- of the cell.

Select correct option:

15%

10%

20%

5%

How many methods exist for computing routing table?
Select correct option:

5

4

3

2

Which of the following statement is true regarding Distance-vector routing?
Select correct option:

It is very simple to implement.

* Packet switch updates its own routing table first.

It is used in RIP.

All of the above

Which one of the following is a property of static routing?
Select correct option:

It is inflexible

It is done at boot time
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It has low network overload

All of the above

Asynchronous Transfer Mode uses the concept of
Select correct option:

Connection-less networking

Connection-oriented networking

Which multiplexing technique shifts each signal to a different carrier frequency?
Select correct option:

TDM

FDM

Bothaandb

None of the above

An interior switch is one with which ......................

Select correct option:

Computers are attached

No computer is attached

Computers are attached internally

None of the above

LAN networks can not be extended to very large networks because of the limitations

Select correct option:

Area

Distance

Routers

Technology

Which of the following statement is wrong regarding ATM?
Select correct option:

* It is a single technology for voice, video and data

e It has low jitter and high capacity.

e It uses fixed size, small cells, and 48 octet’s data

* None of the above

Which one of the following is the responsibility of Djikstra’ algorithm?
Select correct option:

To compute the shortest path between two nodes

To extract next hop information from path information

To insert next hop information into routing table

All of the above

Which one of the following is a property of dynamic routing?
Select correct option:

e It is inflexible

* It has low network overload

* It can work around network failure

All of thee above

Which of the following statement is true regarding ATM?
Select correct option:

ATM is a single technology that is designed to meet the goals of both LANs and WANSs.
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ATM uses the concept of connection-oriented networking.

Both (a) and (b)

None of the above

Source independence is a phenomena in which next hop to destination does not
dependonthe .....................

Select correct option:

Source of packet

Destination of packet

No of hops

Source of protocol

If a computer on the network shares resources for others to use, it is called _____
a. Server

b. Client

c. Mainframe

Answer: a

2. Terminators are used in topology.
a. Bus

b. Star

Answer: a

3.In topology, if a computer’s network cable is broken, whole network goes
down.

a. Bus

b. Star

Answer: a

4. For large networks, topology is used.
a. Bus

b. Star

c. Ring

Answer: b

5. ISO stands for

a. International Standard Organization
b. International Student Organization
c. Integrated Services Organization
Answer: a

6. ISO OSI model is used in
a. Stand alone PC

b. Network environment
Answer: b

7. Network cable lies on layer
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a. Application
b. Network

c. Physical
Answer: c

8. Layer decides which physical pathway the data should take.
a. Application

b. Network

c. Physical

Answer: c

9. ISDN is an example of network
a. Circuit switched

b. Packet switched

Answer: a

10. X.25 is an example of network
a. Circuit switched

b. Packet switched

Answer: b

11. allows LAN users to share computer programs and data.
a. Communication server

b. Print server

c. File server

Answer: c

12. Print server uses which is a buffer that holds data before it is send to
the printer.

a. Queue

b. Spool

c. Node

Answer: b

13. A standalone program that has been modified to work on a LAN by including
concurrency controls such as file and record locking is an example of

a LAN intrinsic software

b. LAN aware software

¢. Groupware

d. LAN ignorant software

Answer: a

14. The portion of LAN management software restricts access, records user

activities and audit data etc.
a. Configuration management
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b. Security management
c. Performance management
Answer : b

15. What is the max cable length of STP?
a. 100 ft

b. 200 ft

c. 100 m

d. 200 m

Answer : d

16. What is the max data capacity of STP?
a. 10 mbps

b. 100 mbps

c. 1000 mbps

d. 10000 mbps

Answer: b

17. Which connector STP uses?
a. BNC

b.RJ-11

c. RJ-45

d. RJ-69

Answer : c

18. What is the central device in star topology?
a. STP server

b. Hub/switch

c. PDC

d. Router

Answer : b

19. What is max data capacity for optical fiber cable?
a. 10 mbps

b. 100 mbps

¢. 1000 mbps

d. 10000 mbps

Answer : ¢

In Direct point to point communication adding the Nth computer requires------------
connections.

» None of the given

> N2
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» N-1
> (N2 -N)/2

disadvantage In Direct point to point communication is that adding a new computer to
the network requires N-1 new connections .(P# 23)

Question No: 2(Marks: 1)

In Point-to-Point topology there are two topologies.
» Tree and Ring

» Star and Ring

» Star and Tree

» None of the given

POINT-TO-POINT:

In Point-to-Point topology there are two topologies.
1) STAR topology

2) TREE topology

Question No: 3(Marks:1)

In ------mmmmme- , network occupies the smaller area like a room a floor or a building

» LAN

» WAN

» MAN

» None of the given

In LAN network occupies the smaller area like a room a floor or a building.(P# 4)
Hardware that calculates a CRC uses two simple components.

» AND unit and XOR unit

» Shift register and XOR unit
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» Shift register and AND unit

» none of the given

CRC uses just two hardware components:

« Shift register

* Exclusive OR ( XOR unit ) .(P# 20)

Question No: 6 (M ar k s: 1) http://vustudents.ning.com/
The Gigabit Ethernet hardware operates at a rate of --------
» 10 Mbps

» 100 Mbps

» 1000 Mbps

» None of the given

Gigabit Ethernet that operates at 1 Gbps (1000 Mbps) over fiber optics and twisted pair
Ethernet cables.

http://vustudents.ning.com/

formally named informally known as the twisted pair Ethernet or TP
Ethernet.

» 10 Base 2

» 10 Base 5

» 10 Base T

» none of the given

10BASE-T:

This is another standard of wiring scheme. It is commonly called 10Base-T, Twisted Pair
or TP Ethernet. (P# 43)

An interface for thin Ethernet must have an connector , and must
generate signals according to the specification.
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» RJ-45, 10 Base T

» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T
A system with redundant bridges might have a problem with in the system.

» Loop
» Filters
» Spanning Trees

» All given choices

computes shortest paths in a graph by using weights on edges as a
measure of distance.

» Greedy algorithm

» Distance vector algorithm

» Dijksta’s algorithm

» none of the given

Djikstra’s algorithm can accommodate weights on edges in graph. The shortest

Path is then the path with lowest total weight (sum of the weight with all edges). It should
be noted that the shortest path is not necessarily with fewest edges (or hops).

Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a .
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» Connectionless service paradigm
» Connection-oriented service paradigm
» Both Connectionless and Connection-oriented service paradigm

» None of the given

protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer
» Network Interface Layer
» Internet Layer

» Transport Layer
LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer.

An Internet Address (IP address) is a unique binary number assigned
to a host and used for all communication with host

» 48-bit
» 32-bit
» 24-bit

» None of the given

An Internet address (IP address) is a unique 32-bit binary number assigned to a
Host and used for all communication with the host

the address identifies the physical network to which the computer is
attached, while the identifies an individual computer on that network.

www.vustudents.ning.com


http://www.vustudents.ning.com/
http://www.vustudents.ning.com/

www.vustudents.ning.com

» Prefix, suffix
» suffix, prefix
» suffix, suffix
» none of the given

PREFIX:
It identifies the physical network to which the computers are attached.

SUFFIX:
It identifies an individual computer on the network.

places the boundary between the first and second octets

» Class A
» Class B
» Class C

» Class D

Class A places the boundary between the first and second octets. Class B places the
boundary between the second and third octets, and class C places the boundary between

the third and fourth octets.

places the boundary between the third and fourth octets.

» Class A
» Class B
» Class C

» Class D

Class A places the boundary between the first and second octets. Class B places the
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boundary between the second and third octets, and class C places the boundary between
the third and fourth octets.

field of header indicates whether a datagram is a fragment or a complete
datagram.

» FLAGS
» FLAGMENT OFFSET
» IDENTIFICATION
» None of the given
FRAGMENTATION:
IP uses fragmentation i.e. datagram’s can be split into pieces to fit in network with small
MTU. Each fragment is an independent datagram. It includes all header fields. Bit in
header indicates that the datagram is a fragment
provides connectionless service.
» TCP
» UDP
» IP
» none of the given
UDP has the following characteristics.
» It is an end-to-end protocol. It provides application-to-application communication.
« [t provides connectionless service.
« It is a Message-Oriented protocol.
* It uses best-effort delivery service.

« It follows arbitrary interaction.
« It is operating system independent
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UDP and TCP are both layer protocols

» Physical
» Data link

» Network

» Transport

Connection-oriented service, Point-to-point, Complete reliability, Full-duplex
communication, Stream interface, Reliable connection start-up and Graceful
connection shutdown are the services provided by

» [P
» None of the given
» TCP

» UDP

SERVICE PROVIDED BY TCP:

Following are the services provided by TCP:
» Connection-oriented service

* Point-to-point

* Complete reliability

* Full-duplex communication

* Stream interface

* Reliable connection start-up

* Graceful connection shutdown

protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer

» Internet Layer
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» Transport Layer

LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer

identifies which application program on receiving computer should receive
the data

» Logical address
» Source port

» Destination Port
» None of the given

Field Destination Port identifies which application program on receiving computer

should receive the data field source port identifies the application programs that sent the
data.

Question No: 23 (M arks: 1)

identifies the application program that sent the data.
» Destination Port
» Source port
» Logical address
» None of the given
Field Destination Port identifies which application program on receiving computer

should receive the data While field source port identifies the application programs that
sent the data. (Reference from E-books)

The Border Gateway Protocol (BGP) uses for all communication

» UDP

» TCP
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» Both UDP and TCP

» none of the given

BORDER GATEWAY PROTOCOL:

It is most popular Exterior Gateway Protocol in Internet. It has following characteristics:
"It provides routing among autonomous systems (EGP).

"It provides policies to control routes advertised.

"It uses reliable transport (TCP).

uses distance vector approach to define routing

» BGP
» OSPF
» RIP

» None of the given

ROUTING INFORMATION PROTOCOL (RIP):

It has the following characteristics:

"It is used for routing within an autonomous system (IGP).

"Hop Count Metric: RIP measures distance in network hops, where each network
between the source and destination counts as a single hop.

"It uses UDP for all message transmissions.

"RIP is used over LAN. Version 1 of RIP uses hardware broadcast and version 2 allows
Delivery via multicast.

"It can be used to advertise default route propagation. An organization can use RIP to
Install a default route in each router.

"It uses distance vector algorithm.

ICMP message transport is acted upon by getting ICMP encrypted in IP.
» True

» False
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ICMP message transport is acted upon by getting ICMP encapsulated in IP (P# 117)

Protocol addresses are abstractions provided by
» hardware

» software

» operating system

» internet

Protocol addresses are abstractions provided by software (reference)

These packets serve same purpose on as frames on
» Intranet, LAN
» Internet, WAN
» Intranet, WAN
» Internet, LAN

VIRTUAL PACKETS:
These packets serve same purpose in Internet as frames on LAN

Address mask defines how many bits of address are in suffix?
» True
» False

Address mask defines how many bits of address are in prefix. Prefix defines how much of
address used to identify network.

www.vustudents.ning.com


http://www.vustudents.ning.com/
http://www.vustudents.ning.com/

www.vustudents.ning.com

a single networking technology is best for all needs.
» True
» False

There is no single networking technology that is best for all needs

A computer attached to a given network can only communicate with other
computers attached to the same network. Is this a problem with multiple networks?
» True

» False

the chief problems with multiple networks are as follows:

* A computer attached to a given network can only communicate with other
Computers attached to the same network.

The term self-identifying is used for Classful IP addresses because the class of the
address can be computed from the address

» Itself
» prefix
» suffix
» mask
Classful IP addresses are self-identifying because the class of the address can be

computed from the address itself

Find the class of the address.
10100111 11011011 10001011 01101111

> A

» B
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» E

» C

Reference table handouts P # 87

Find the class of the address:

11110011 10011011 11111011 00001111
> A

» C

» E

» B

Reference table handouts P # 87

In which method of Address Resolution Protocol the protocol address is determined
by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» T

» D

» C

» T, C
Reference table handouts P # 97

Which method of Address Resolution Protocol requires hardware broadcast?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» D
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> T
» C
» T,D

Reference table handouts P # 97

Which method of Address Resolution Protocol resolution with minimum delay?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» T,D

» C

> T

» T,C

Reference table handouts P # 97

In which method of Address Resolution Protocol the implimentation is more
difficult?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» T,C

> T

» C

» D

Reference table handouts P # 97://vuzs.net

On of the design goals for unicast route propagation is
» Consistency

» inconsistency
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» stability

» dynamic addressing

On of the design goals for unicast route propagation is stability—continual changes in
route are undesirable because they lead to higher jitter and datagram arriving out of

order. Thus, once a unicast routing protocol finds a shortest path, it usually retains the
route until a failure makes the path unusable. (Reference from E-book)

Propagation multicast routing information differs dramatically from unicast route
propagation?

» True

» False

Propagating multicast routing information differs dramatically from unicast route
propagation. The difference arises because internet multicast allows dynamic group

membership and autonomous senders
http://vustudents.ning.com/

To save traffic, an EGP does not summarize routing information from the
autonomous system before passing it to another autonomous system.

» True

» False

To save trdffic, an EGP summarize routing information from the autonomous system
before passing it to another autonomous system. More important an EGP implements

policy constraint that allows a system manager to determine exactly what information is
released outside the organization. (Reference from E-book)

In IPv6 the type of address used for collection of computers with same prefix. Are
known as

» Anycast
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» Unicast

» Multicast

» Non of the given

Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same site.

Cluster: This type of address is used for collection of computers with same prefix,
Datagram is delivered to one out of cluster.

Special types of addresses in IPv6 used for multiple destinations; possibly not same
site. Are known as

» Unicast

» Anycast

» Multicast

» none of the given

Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same site.

Cluster: This type of address is used for collection of computers with same prefix,
Datagram is delivered to one out of cluster.

UDP offers application programs a Message-Oriented Interface, applications can
depend on protocol to preserve data boundaries.

» True
» False
UDP offers application programs a Message-Oriented Interface. It does not divide

messages into packets for transmission and does not combine messages for delivery.
ADVANTAGES:
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* Applications can depend on protocol to preserve data boundaries.

Reliability is the responsibility of the layer
» Network

» Data link

» Transport

» Application

Reliability is the responsibility of the Transport layer

TCP uses mechanism to control the flow of data.

» door
» window
» acknowledgment

» retransmission

In Direct point to point communication adding the Nth computer requires------------
new connections.

» None of the given

> N2

> N-1

> (N2 -N)/2

disadvantage In Direct point to point communication is that adding a new computer to

the network requires N-1 new connections .(P# 23)

In Point-to-Point topology there are two topologies.
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» Tree and Ring

» Star and Ring

» Star and Tree

» None of the given
POINT-TO-POINT:

In Point-to-Point topology there are two topologies.
1) STAR topology

2) TREE topology

In -------mm-- , network occupies the smaller area like a room a floor or a building
» LAN

» WAN

» MAN

» None of the given

In LAN network occupies the smaller area like a room a floor or a building.(P# 4)

Hardware that calculates a CRC uses two simple components.
» AND unit and XOR unit

» Shift register and XOR unit

» Shift register and ANDunit

» none of the given

CRC uses just two hardware components:

« Shift register
* Exclusive OR ( XOR unit ) .(P# 20)
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The Gigabit Ethernet hardware operates at a rate of --------
» 10 Mbps

» 100 Mbps

» 1000 Mbps

» None of the given

Gigabit Ethernet that operates at 1 Gbps (1000 Mbps) over fiber optics and twisted pair
Ethernet cables.

formally named informally known as the twisted pair Ethernet or TP
Ethernet.

» 10 Base 2

» 10 Base 5

» 10 Base T

» none of the given

10BASE-T:

This is another standard of wiring scheme. It is commonly called 10Base-T, Twisted Pair

or TP Ethernet. (P# 43)

An interface for thin Ethernet must have an connector , and must
generate signals according to the specification.

» RJ-45, 10 Base T

» RJ-45, 10 Base 5
» BNC, 10 Base 2

» BNC, 10 Base T
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A system with redundant bridges might have a problem with in the system.

» Loop
» Filters
» Spanning Trees

» All given choices

computes shortest paths in a graph by using weights on edges as a
measure of distance.

» Greedy algorithm
» Distance vector algorithm
» Dijksta’s algorithm

» none of the given

Djikstra’s algorithm can accommodate weights on edges in graph. The shortest
Path is then the path with lowest total weight (sum of the weight with all edges). It should
Be noted that the shortest path is not necessarily with fewest edges (or hops).

Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a .

» Connectionless service paradigm
» Connection-oriented service paradigm

» Both Connectionless and Connection-oriented service paradigm

» none of the given
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protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer
» Network Interface Layer
» Internet Layer

» Transport Layer

LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer.

An Internet Address (IP address) is a unique binary number assigned
to a host and used for all communication with host

» 48-bit
» 32-bit
» 24-bit
» None of the given

An Internet address (IP address) is a unique 32-bit binary number assigned to a
host and used for all communication with the host

The address identifies the physical network to which the computer is
attached, while the identifies an individual computer on that network.

» prefix , suffix
» suffix , prefix
» suffix , suffix

» None of the given
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PREFIX:
It identifies the physical network to which the computers are attached.

SUFFIX:
It identifies an individual computer on the network.

places the boundary between the first and second octets

» Class A
» Class B
» Class C

» Class D

Class A places the boundary between the first and second octets. Class B places the
boundary between the second and third octets, and class C places the boundary between

the third and fourth octets.

places the boundary between the third and fourth octets.

» Class A
» Class B
» Class C

» Class D

Class A places the boundary between the first and second octets. Class B places the
boundary between the second and third octets, and class C places the boundary between

the third and fourth octets.
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field of header indicates whether a datagram is a fragment or a complete
datagram.
» FLAGS
» FLAGMENT OFFSET
» IDENTIFICATION

» None of the given

FRAGMENTATION:

provides connectionless service.
» TCP
» UDP
» IP
» none of the given
UDP has the following characteristics.
« [t is an end-to-end protocol. It provides application-to-application communication.
* It provides connectionless service.
* It is a Message-Oriented protocol.
* It uses best-effort delivery service.

* It follows arbitrary interaction.
* It is operating system independent

UDP and TCP are both layer protocols

» Physical
» Data link

» Network
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» Transport

Connection-oriented service, Point-to-point, Complete reliability, Full-duplex
communication, Stream interface, Reliable connection startup and Graceful
connection shutdown are the services provided by

» IP

» None of the given

» TCP

» UDP

SERVICE PROVIDED BY TCP:

Following are the services provided by TCP:
 Connection-oriented service

* Point-to-point

» Complete reliability

* Full-duplex communication

* Stream interface

* Reliable connection start-up

* Graceful connection shutdown

protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
» Internet Layer
» Transport Layer

LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer

identifies which application program on receiving computer should receive
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the data

» Logical address
» Source port

» Destination Port

» None of the given

identifies the application program that sent the data.
» Destination Port
» Source port
» Logical address

» None of the given

The Border Gateway Protocol (BGP) uses for all communication

» UDP

» TCP

» Both UDP and TCP

» None of the given

BORDER GATEWAY PROTOCOL:

It is most popular Exterior Gateway Protocol in Internet. It has following characteristics:

"It provides routing among autonomous systems (EGP).
"It provides policies to control routes advertised.
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"It uses reliable transport (TCP).

uses distance vector approach to define routing

» BGP
» OSPF
» RIP

» None of the given

ROUTING INFORMATION PROTOCOL (RIP):

It has the following characteristics:

"It is used for routing within an autonomous system (IGP).

"Hop Count Metric: RIP measures distance in network hops, where each network
between the source and destination counts as a single hop.

"It uses UDP for all message transmissions.

"RIP is used over LAN. Version 1 of RIP uses hardware broadcast and version 2 allows
delivery via multicast.

"It can be used to advertise default route propagation. An organization can use RIP to
install a default route in each router.

"It uses distance vector algorithm.

ICMP message transport is acted upon by getting ICMP encrypted in IP.
» True
» False

ICMP message transport is acted upon by getting ICMP encapsulated in IP (P# 117)
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Protocol addresses are abstractions provided by
» hardware

» software

» operating system

» internet

Protocol addresses are abstractions provided by software

These packets serve same purpose on as frames on
» Intranet, LAN
» Internet, WAN
» Intranet, WAN
» Internet, LAN

VIRTUAL PACKETS:
These packets serve same purpose in Internet as frames on LAN

Address mask defines how many bits of address are in suffix?

» True

» False

Address mask defines how many bits of address are in prefix. Prefix defines how much of
address used to identify network.

A single networking technology is best for all needs.

» True
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» False

There is no single networking technology that is best for all needs

A computer attached to a given network can only communicate with other
computers attached to the same network. Is this a problem with multiple networks?
» True

» False

the chief problems with multiple networks are as follows:

* A computer attached to a given network can only communicate with other
Computers attached to the same network.

The term self-identifying is used for Classful IP addresses because the class of the
address can be computed from the address

> Itself
» prefix
» suffix
» mask

Classful IP addresses are self-identifying because the class of the address can be
computed from the address itself

Find the class of the address.
10100111 11011011 10001011 01101111

> A
» B
> E

» C
Reference table handouts P # 87
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Find the class of the address:
11110011 10011011 11111011 00001111

> A
> C
» E
» B

Reference table handouts P # 87

In which method of Address Resolution Protocol the protocol address is determined
by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

> T

» D

> C

» T, C
Reference table handouts P # 97

Which method of Address Resolution Protocol requires hardware broadcast?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» D

> T

» C

» T,D
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Reference table handouts P # 97

Which method of Address Resolution Protocol resolution with minimum delay?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» T,D

» C

> T

» T,C

Reference table handouts P # 97

In which method of Address Resolution Protocol the implementation is more
difficult?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» T,C

> T

» C

» D

Reference table handouts P # 97

On of the design goals for unicast route propagation is
» Consistency

» inconsistency

» stability

» dynamic addressing
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On of the design goals for unicast route propagation is stability—continual changes in
route are undesirable because they lead to higher jitter and datagram arriving out of
order. Thus, once a unicast routing protocol finds a shortest path, it usually retains the
route until a failure makes the path unusable. (Reference from E-book)

Propagation multicast routing information differs dramatically from unicast route
propagation?

» True

» False

Propagating multicast routing information differs dramatically from unicast route
propagation. The difference arises because internet multicast allows dynamic group
membership and autonomous senders

to save traffic an EGP does not summarize routing information from the
autonomous system before passing it to another autonomous system.

» True

» False

to save trdffic, an EGP summarize routing information from the autonomous system
before passing it to another autonomous system. More important an EGP implements

policy constraint that allows a system manager to determine exactly what information is
released outside the organization. (Reference from E-book)

In IPv6 the type of address used for collection of computers with same prefix. Are
known as

» Anycast
» Unicast
» Multicast

» none of the given
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Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same site.

Cluster: This type of address is used for collection of computers with same prefix,
Datagram is delivered to one out of cluster.

vuzs.net

Special types of addresses in IPv6 used for multiple destinations; possibly not at
same site.

» Unicast

» Anycast

» Multicast

» none of the given

Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same site.

Cluster: This type of address is used for collection of computers with same prefix,
Datagram is delivered to one out of cluster.

UDP offers application programs a Message-Oriented Interface, applications can
depend on protocol to preserve data boundaries.

» True

» False

UDP offers application programs a Message-Oriented Interface. It does not divide
messages into packets for transmission and does not combine messages for delivery.

ADVANTAGES:
» Applications can depend on protocol to preserve data boundaries.

Reliability is the responsibility of the layer
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» Network
» Data link
» Transport
» Application

Reliability is the responsibility of the Transport layer

TCP uses mechanism to control the flow of data.
» Door

» window

» acknowledgment

» retransmission

TCP uses window mechanism to control the flow of data.

the time for acknowledgement to arrival of packet depends on.

» Distance to destination and Current traffic conditions
» Current traffic conditions

» Distance to destination

» non of these

The time for acknowledgement to arrive depends on:

* Distance to destination
* Current traffic conditions

FDDI can transmits data at a rate of ----------
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» 100 million bits per second
» 10 million bits per second
» 1000 million bits per second

» None of the given

the time for acknowledgement to arrival of packet depends on.

» Distance to destination and Current traffic conditions
» Current traffic conditions

» Distance to destination

» non of these

The time for acknowledgement to arrive depends on:

* Distance to destination
* Current trdffic conditions

FDDI can transmits data at a rate of ----------

» 100 million bits per second
» 10 million bits per second
» 1000 million bits per second

» None of the given
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CS 610 Solved (Correct) MCQOS (References are given in Blue

Font) UMAIR SID

The protocol address of the next hop must be to an equivalent hardware
address before a packet can be sent.

Encrypted

Decrypted

Translated

Non of these

A address-binding table is used for each physical network.

New

Similar

Separate

Old

UDP provides connection-oriented service.

True

False

TCP provides connection oriented reliable data streaming service, whereas UDP provides
connection-less unreliable messaging service.

The UDP stands for
Universal Datagram Protocol
User Datagram Protocol
United Datagram Protocol
None of the given

In 3-way handshake TCP requires to generate a random sequence number.
30 bit

32 bit

34 bit

none of the given

TCP stands for

Transport control protocol
Transmission control protocol
Terminal control protocol

None of the given

As the Internet grew, the original Classful addressing scheme became a limitation.
The IP address space was being exhausted because all networks had to choose one
of three possible sizes.

Select correct option:

True
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False
Question # 4 of 20 ( Start time: 06:44:07 PM )
TotalMarks: 1
Twice NAT allows a site to run servers.
Select correct option:
True
False
Preliminary version of IP was called
Select correct option:
IP - New Generation (IPng)
IP - Next Generation (IPng)
IP - Net Generation (IPng)
None of the given
As the Internet grew, the original Classful addressing scheme became a limitation.
The IP address space was being exhausted because all networks had to choose one
of two possible sizes.
Select correct option:
True
False
uses window mechanism to control the flow of data.

Select correct option:
IP
UDP
TCP
none of the given
TCP uses window mechanism to control the flow of data.
The Internet service providers coordinate with the Internet assigned number
authority to obtain their network numbers.
Select correct option:
True
False
Which protocol is used to test different tools.
Select correct option:
ICMP
IGMP
TCP/IP
none of the given
USING ICMP TO TEST REACHABILITY:
ICMP can also be used to test different tools. An Internet host A, is reachable from
another host B, if datagram’s can be delivered from A to B. Ping program tests reach
ability. It sends datagram from B to A, that echoes back to B. it uses ICMP echo request
and echo reply messages. Internet layer includes code to reply to incoming ICMP
echo request messages.

identifies the application program that sent the data.
Select correct option:
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Destination Port

Source port

Logical address

None of the given

The Source can configure outgoing datagram’s to avoid
Select correct option:

Segmentation

Defragmentation

Fragmentation

None of the given

Fragmentation should be avoided. Source can configure outgoing datagrams to avoid
fragmentation. Source determines path MTU- smallest network MTU on path from
source to destination.

Question # 18 of 20 ( Start time: 06:57:12 PM )
TotalMarks: 1

The time for acknowledgement to arrive depends on
Select correct option:

Distance to destination

Current traffic conditions

Both a and b

None of the given

The time for acknowledgement to arrive depends on:

* Distance to destination

* Current traffic conditions

which is not the type of error messages defined by ICMP.
Select correct option:

Source quench

Time exceeded

Destination unreachable

None of the given

ERROR MESSAGES:

These are as follows:

* Source quench

* Time exceeded

* Destination unreachable

* Redirect

* Fragmentation required

is used to attach two autonomous systems.
Select correct option:

BGP
IGP
EGP
none of the given
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Question # 2 of 20
Due to revolutionalization of IP-V6 the speed has increased from
Select correct option:

56kbps to 512kbps

512kbps to 1gbps

56kbps to 1gbps

none of the given

Scale is also dramatically changed. Size from a few tens to a few tens of millions

Of computers has been revolutionized. Speed has increased from 56Kbps to 1Gbps. Also
There is an increased frame size in hardware

Question # 3 of 20

Whenever it handles a packet, IP software needs to separate the destination address into a
prefix.

Select correct option:

True

False

COMPUTING THE CLASS OF AN ADDRESS:

Whenever it handles a packet, IP software needs to separate the destination

Address into a prefix and suffix.

Question # 4 of 20
TTL stands for
Select correct option:

Time to Learn
Time to Leave
Time to Live
none of the given

Question # 5 of 20
IGPs stand for
Select correct option:

Internal Gateway Protocols

Interior Gateway Protocols

Intermediate Gateway Protocols

None of the given

Question # 6 of 20

identifies which application program on receiving computer should

receive the data
Select correct option:

Logical address
Source port
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Destination Port

None of the given

Field Destination Port identifies which application program on receiving computer should
receive the data. While field source port identifies the application programs that sent the
data.

Question # 7 of 20

encapsulates IP datagram as data area in hardware frame.

Select correct option:

Network Interface Layer

Datalink Layer

Network Layer

None of the given

The network interface layer encapsulates an entire datagram in the data area of a
hardware frame

vuzs.net

Question # 8 of 20

Class A mask is 255.0.0.0 which is used for

Select correct option:

Unicasting

Multicasting

Subnetting

All of the given

class A mask is 255.0.0.0 which is used for subnetting.

Question # 9 of 20

NAT is not useful at a residence with Cable Modem or DSL connectivity.
Select correct option:

True

False

Question # 10 of 20

Autonomous System chooses a routing protocol to exchange routing information which is
passed before being summarized to another group.

Select correct option:

True

False

Question # 11 of 20
layer Provides reliable delivery of datagram.
Select correct option:
Network
Transport
Datalink
none of the given

Transport layer provides reliable delivery. Network layer — IP — can detect and
report errors without actually fixing them. It focuses on datagram delivery. Application
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layer is not interested in differentiating among delivery problems at intermediate routers
Question # 12 of 20

The process of using a routing table to select a next hop for a given datagram is
called

Select correct option:

Encapsulation

Reassembling

Routing or forwarding

None of the given

The process of using a routing table to select a next hop for a given datagram is called
routing or forwarding.

Question # 13 of 20

The process of learning the path MTU is known as path MTU discovery.

Select correct option:

True

False

The process of learning the path MTU is known as path MTU discovery.

Question # 14 of 20

As the Internet grew, the original Classful addressing scheme became a limitation. The IP
address space was being exhausted because all networks had to choose one of
possible sizes.

Select correct option:

three

two

four

five

Three

As the Internet grew, the original Classful addressing scheme became a limitation.
The IP address space was being exhausted because all networks had to choose one of
Three possible sizes. Many addresses were unused.

Two new mechanisms were invented to overcome the limitations, which are as
Follows:

* Subnet addressing

* Classless addressing

Question # 15 of 20

End to End delivery Service of IP datagram is

Select correct option:

Connection oriented
Connectionless
bothaandb

none of the given

Question # 16 of 20

EGP stands for
Select correct option:
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Extension Gateway Protocol
Exterior Gateway Protocol
Explicit Gateway Protocol
none of the given

Question # 17 of 20

Hashing is the transformation of a string of characters into a usually shorter fixed-length
value or a key that represents the original string.

Select correct option:

True

False

Hashing is the transformation of a string of characters into a usually shorter fixed-length
value or a key that represents the original string. Hashing is used to index and retrieve
items in a database because it is faster to find the item using the shorter hashed key than
to find it using the original value. It is also used in many encryption algorithms.
Question # 18 of 20

Although the ARP message format is sufficiently general to allow arbitrary protocol and
hardware addresses. ARP is almost always used to bind a 32-bit IP addresstoa _____
Ethernet address.

Select correct option:

16-bit

48-bit

64-bit

128-bit

Although the ARP message format is sufficiently general to allow arbitrary protocol and
hardware addresses. ARP is almost always used to bind a 32-bit IP address to a 48-bit
Ethernet address

Question # 19 of 20

Reliability is not the responsibility of the Transport layer.

Select correct option:

True

False

Reliability is the responsibility of the Transport layer. In TCP/IP, TCP provides reliable
transport service. Most Internet applications use TCP as no other protocol has proved to
work better.

Question # 20 of 20

IPV6 address with leading zeros is interpreted to hold an IPV4 address.

Select correct option:

http://vustudents.ning.com//

96

100
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120

none of the given

IPv6 address with 96 leading zeros is interpreted to hold an IPv4 addressQuestion # 1 of
20

NAT software does not allow a PC to connect with the Internet and act as a NAT device
at the same time.

Select correct option:

True

False

Question # 2 of 20

TCP uses the term segment to refer to a

Select correct option:

packet

message

both (a) and (b)

None of the given

both a and b?

TCP uses single format for all messages. TCP uses the term segment to refer to a
message. Each message sent from TCP on one machine to TCP on another machine uses
this format including data and acknowledgement.

Question # 3 of 20

The Universal Datagram Protocol is a message-oriented protocol.

Select correct option:

True

False

UDP has the following characteristics.

« It is an end-to-end protocol. It provides application-to-application communication.
« It provides connectionless service.

* It is a Message-Oriented protocol.

* It uses best-effort delivery service.

« It follows arbitrary interaction.

« It is operating system independent

Question # 4 of 20

field tells the receiver how to order fragments within a given datagram.
Select correct option:

FLAGS

FLAGMENT OFFSET

IDENTIFICATION

None of the given

The FRAGMENT OFFSET field tells a receiver how to order fragments within a given
datagram

Question # 5 of 20

IP datagram can contains octets.
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Select correct option:

0-65,535
1-65,535
1-65,536
none of the given
Datagrams can have different sizes i.e.
Header area is usually fixed (20 octets) but can have options. Data area can contain
between 1 octet and 65.535 octets (216-1).
Usually, data area is much larger than header.
Question # 6 of 20
The amount of buffer space available at any time is called the window.
Select correct option:
True
False
Question # 7 of 20
Source is responsible for fragmentation.
Select correct option:

IPV4

IPV6

IPv6 source (not intermediate routers) is responsible for fragmentation. Routers
simply drop datagrams larger than network MTU (Maximum Transmission Unit). So
source must fragment datagram to reach destination.

Question # 8 of 20

Routers use to forward datagrams along prearranged path.

Select correct option:

Traffic class
Flow label
Destination address
none of the given
Routers use flow label to forward datagrams along prearranged path
Question # 9 of 20
protocol uses three way handshake to begin a connection.
Select correct option:

UDP

TCP

1P

none of the given

Question # 10 of 20

Typical internet routing uses uses a combination of two metrics

Select correct option:

routing metrics
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administrative cost and routing metrics

hop cost

administrative cost and hop count

Question # 14 of 20

Network Address and Port Translation (NAPT) is by far the most popular form of

Select correct option:

Network Address Transmission

Network Address Translation

Network Address Transformation

None of the given

Question # 15 of 20

The routers within an autonomous system use a to exchange routing
information.

Select correct option:

Interior Gateway protocols(IGPs)

Exterior Gateway protocol (EGPs)

Both Interior Gateway protocols(IGPs) and Exterior Gateway protocol (EGPs)

None of the given

It is used among routers within autonomous system. The destinations lie within IGP.
Question # 17 of 20

Interior Gateway Protocols (IGPs) and Exterior Gateway Protocols (EGPs) two broad
classes of Internet Routing Protocol.

Select correct option:

True

False

Question # 18 of 20

The Network Layer Protocol ICMP stands for
Select correct option:

Instant Control Message Protocol

Internet Control Message Protocol

Initial Control Message Protocol

None of the given

Question # 19 of 20

The Current version of IP-Version 4 is old
Select correct option:

18 years
20 years
22 years
none of given
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TCP is a connectionless and reliable transport protocol.
Select correct option:

True
False

ATM header is about the of the cell.
Select correct option:

15%

10% page 66

20%

5%

Jitter is significance for
Select correct option:
Voice
Video
Data
Al of above page 66
How many methods exist for building routing table?

Select correct option

1

2 pages

34
The process of forwarding the packets of information is called routing
The routing table contains information about the immediately
around it
Select correct option:

* Topology of the network

* Destination page 58

* Both of the above

* None of the above

Asynchronous Transfer Mode uses the concept of

Select correct option:

Connection-less networking
* Connection-oriented networking page 66

Which of the following statement is true regarding ATM?
Select correct option:

* It is a single technology for voice, video and data

* It has low jitter and high capacity

It uses fixed sized small cells. 48 octet's data

* All of the above page 65

A can forward or block messages based on the information in the message
itself
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Select correct option

Message digest

Proxy firewall

* Packet filter firewall not found in handouts

* Private Key

You can use an IP packet filter firewall to create a set of rules that either discards or
accepts traffic over a network connection.(Source to confirm
http://publib.boulder.ibm.com/infocenter/powersys/v3rlm5/index.jsp?
topic=/ipha5/packetfilterfirewall.htm)

Transmission media are usually categorized as

Select correct option:

* Guided or unguided

Fixed or unfixed

Determinate or indeterminate

Metallic or nonmetallic

Which of the following is not a guided medium?

Select correct option:

Twisted-pair cable

Fiber-optic cable

e Atmosphere

Coaxial Cable

Which multiplexing technique transmits digital signals?
Select correct option:

WDM

FDM

* TDM

None of the above

All destinations on same switch have same

Select correct option:

Router

Information

* Next Hop page 58

None of thee above

Which of the following statement is true regarding Distance-Vector Routing?
Select correct option:

It is very simple to implement.

* Packet switch updates its own routing table first. Page 64
It is used in RIP.

* All of the above

An exterior switch is one with which

Select correct option:

* Computers are attached page 59

No computer is attachede

Hubs are attached externally None of the above

Frame relay is
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Select correct option:

* Connection oriented service page 64

» Connectionless service It is typically ranges from 5Mbps to 1000Mbps. None of the
above

An interior switch is one with which

Select correct option:

Computers are attached

* No computer is attached page 59

Computers are attached internally

None of the above

Which of the following is not a benefit of source independence?

Select correct option:

It allows fast and efficient routing.

* Packet switch do not need to have complete information about all destinations
Network functions even if topology changes

None of the above

Which of the following statement regarding ATM is true?
Select correct option:

Connections in ATM are called virtual channels

The VC is identified by a 24-bit value formed from the VPI
* Both (a) and (b)

None of the above
ATM header is about the ---------- of the cell.

Select correct option:

15%

10%

20%

5%

How many methods exist for computing routing table?
Select correct option:

5

4

3

2

Which of the following statement is true regarding Distance-vector routing?
Select correct option:

It is very simple to implement.

* Packet switch updates its own routing table first.

It is used in RIP.

All of the above

Which one of the following is a property of static routing?
Select correct option:

It is inflexible

It is done at boot time
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It has low network overload

All of the above

Asynchronous Transfer Mode uses the concept of
Select correct option:

Connection-less networking

Connection-oriented networking

Which multiplexing technique shifts each signal to a different carrier frequency?
Select correct option:

TDM

FDM

Bothaandb

None of the above

An interior switch is one with which ......................

Select correct option:

Computers are attached

No computer is attached

Computers are attached internally

None of the above

LAN networks can not be extended to very large networks because of the limitations

Select correct option:

Area

Distance

Routers

Technology

Which of the following statement is wrong regarding ATM?
Select correct option:

* It is a single technology for voice, video and data

e It has low jitter and high capacity.

e It uses fixed size, small cells, and 48 octet’s data

* None of the above

Which one of the following is the responsibility of Djikstra’ algorithm?
Select correct option:

To compute the shortest path between two nodes

To extract next hop information from path information

To insert next hop information into routing table

All of the above

Which one of the following is a property of dynamic routing?
Select correct option:

e It is inflexible

* It has low network overload

* It can work around network failure

All of thee above

Which of the following statement is true regarding ATM?
Select correct option:

ATM is a single technology that is designed to meet the goals of both LANs and WANSs.
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ATM uses the concept of connection-oriented networking.

Both (a) and (b)

None of the above

Source independence is a phenomena in which next hop to destination does not
dependonthe .....................

Select correct option:

Source of packet

Destination of packet

No of hops

Source of protocol

If a computer on the network shares resources for others to use, it is called _____
a. Server

b. Client

c. Mainframe

Answer: a

2. Terminators are used in topology.
a. Bus

b. Star

Answer: a

3.In topology, if a computer’s network cable is broken, whole network goes
down.

a. Bus

b. Star

Answer: a

4. For large networks, topology is used.
a. Bus

b. Star

c. Ring

Answer: b

5. ISO stands for

a. International Standard Organization
b. International Student Organization
c. Integrated Services Organization
Answer: a

6. ISO OSI model is used in
a. Stand alone PC

b. Network environment
Answer: b

7. Network cable lies on layer
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a. Application
b. Network

c. Physical
Answer: c

8. Layer decides which physical pathway the data should take.
a. Application

b. Network

c. Physical

Answer: c

9. ISDN is an example of network
a. Circuit switched

b. Packet switched

Answer: a

10. X.25 is an example of network
a. Circuit switched

b. Packet switched

Answer: b

11. allows LAN users to share computer programs and data.
a. Communication server

b. Print server

c. File server

Answer: c

12. Print server uses which is a buffer that holds data before it is send to
the printer.

a. Queue

b. Spool

c. Node

Answer: b

13. A standalone program that has been modified to work on a LAN by including
concurrency controls such as file and record locking is an example of

a LAN intrinsic software

b. LAN aware software

¢. Groupware

d. LAN ignorant software

Answer: a

14. The portion of LAN management software restricts access, records user

activities and audit data etc.
a. Configuration management
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b. Security management
c. Performance management
Answer : b

15. What is the max cable length of STP?
a. 100 ft

b. 200 ft

c. 100 m

d. 200 m

Answer : d

16. What is the max data capacity of STP?
a. 10 mbps

b. 100 mbps

c. 1000 mbps

d. 10000 mbps

Answer: b

17. Which connector STP uses?
a. BNC

b.RJ-11

c. RJ-45

d. RJ-69

Answer : c

18. What is the central device in star topology?
a. STP server

b. Hub/switch

c. PDC

d. Router

Answer : b

19. What is max data capacity for optical fiber cable?
a. 10 mbps

b. 100 mbps

¢. 1000 mbps

d. 10000 mbps

Answer : ¢

In Direct point to point communication adding the Nth computer requires------------
connections.

» None of the given

> N2
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» N-1
> (N2 -N)/2

disadvantage In Direct point to point communication is that adding a new computer to
the network requires N-1 new connections .(P# 23)

Question No: 2(Marks: 1)

In Point-to-Point topology there are two topologies.
» Tree and Ring

» Star and Ring

» Star and Tree

» None of the given

POINT-TO-POINT:

In Point-to-Point topology there are two topologies.
1) STAR topology

2) TREE topology

Question No: 3(Marks:1)

In ------mmmmme- , network occupies the smaller area like a room a floor or a building

» LAN

» WAN

» MAN

» None of the given

In LAN network occupies the smaller area like a room a floor or a building.(P# 4)
Hardware that calculates a CRC uses two simple components.

» AND unit and XOR unit

» Shift register and XOR unit
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» Shift register and AND unit

» none of the given

CRC uses just two hardware components:

« Shift register

* Exclusive OR ( XOR unit ) .(P# 20)

Question No: 6 (M ar k s: 1) http://vustudents.ning.com/
The Gigabit Ethernet hardware operates at a rate of --------
» 10 Mbps

» 100 Mbps

» 1000 Mbps

» None of the given

Gigabit Ethernet that operates at 1 Gbps (1000 Mbps) over fiber optics and twisted pair
Ethernet cables.

http://vustudents.ning.com/

formally named informally known as the twisted pair Ethernet or TP
Ethernet.

» 10 Base 2

» 10 Base 5

» 10 Base T

» none of the given

10BASE-T:

This is another standard of wiring scheme. It is commonly called 10Base-T, Twisted Pair
or TP Ethernet. (P# 43)

An interface for thin Ethernet must have an connector , and must
generate signals according to the specification.
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» RJ-45, 10 Base T

» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T
A system with redundant bridges might have a problem with in the system.

» Loop
» Filters
» Spanning Trees

» All given choices

computes shortest paths in a graph by using weights on edges as a
measure of distance.

» Greedy algorithm

» Distance vector algorithm

» Dijksta’s algorithm

» none of the given

Djikstra’s algorithm can accommodate weights on edges in graph. The shortest

Path is then the path with lowest total weight (sum of the weight with all edges). It should
be noted that the shortest path is not necessarily with fewest edges (or hops).

Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a .
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» Connectionless service paradigm
» Connection-oriented service paradigm
» Both Connectionless and Connection-oriented service paradigm

» None of the given

protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer
» Network Interface Layer
» Internet Layer

» Transport Layer
LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer.

An Internet Address (IP address) is a unique binary number assigned
to a host and used for all communication with host

» 48-bit
» 32-bit
» 24-bit

» None of the given

An Internet address (IP address) is a unique 32-bit binary number assigned to a
Host and used for all communication with the host

the address identifies the physical network to which the computer is
attached, while the identifies an individual computer on that network.
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» Prefix, suffix
» suffix, prefix
» suffix, suffix
» none of the given

PREFIX:
It identifies the physical network to which the computers are attached.

SUFFIX:
It identifies an individual computer on the network.

places the boundary between the first and second octets

» Class A
» Class B
» Class C

» Class D

Class A places the boundary between the first and second octets. Class B places the
boundary between the second and third octets, and class C places the boundary between

the third and fourth octets.

places the boundary between the third and fourth octets.

» Class A
» Class B
» Class C

» Class D

Class A places the boundary between the first and second octets. Class B places the
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boundary between the second and third octets, and class C places the boundary between
the third and fourth octets.

field of header indicates whether a datagram is a fragment or a complete
datagram.

» FLAGS
» FLAGMENT OFFSET
» IDENTIFICATION
» None of the given
FRAGMENTATION:
IP uses fragmentation i.e. datagram’s can be split into pieces to fit in network with small
MTU. Each fragment is an independent datagram. It includes all header fields. Bit in
header indicates that the datagram is a fragment
provides connectionless service.
» TCP
» UDP
» IP
» none of the given
UDP has the following characteristics.
» It is an end-to-end protocol. It provides application-to-application communication.
« [t provides connectionless service.
« It is a Message-Oriented protocol.
* It uses best-effort delivery service.

« It follows arbitrary interaction.
« It is operating system independent
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UDP and TCP are both layer protocols

» Physical
» Data link

» Network

» Transport

Connection-oriented service, Point-to-point, Complete reliability, Full-duplex
communication, Stream interface, Reliable connection start-up and Graceful
connection shutdown are the services provided by

» [P
» None of the given
» TCP

» UDP

SERVICE PROVIDED BY TCP:

Following are the services provided by TCP:
» Connection-oriented service

* Point-to-point

* Complete reliability

* Full-duplex communication

* Stream interface

* Reliable connection start-up

* Graceful connection shutdown

protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer

» Internet Layer
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» Transport Layer

LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer

identifies which application program on receiving computer should receive
the data

» Logical address
» Source port

» Destination Port
» None of the given

Field Destination Port identifies which application program on receiving computer

should receive the data field source port identifies the application programs that sent the
data.

Question No: 23 (M arks: 1)

identifies the application program that sent the data.
» Destination Port
» Source port
» Logical address
» None of the given
Field Destination Port identifies which application program on receiving computer

should receive the data While field source port identifies the application programs that
sent the data. (Reference from E-books)

The Border Gateway Protocol (BGP) uses for all communication

» UDP

» TCP
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» Both UDP and TCP

» none of the given

BORDER GATEWAY PROTOCOL:

It is most popular Exterior Gateway Protocol in Internet. It has following characteristics:
"It provides routing among autonomous systems (EGP).

"It provides policies to control routes advertised.

"It uses reliable transport (TCP).

uses distance vector approach to define routing

» BGP
» OSPF
» RIP

» None of the given

ROUTING INFORMATION PROTOCOL (RIP):

It has the following characteristics:

"It is used for routing within an autonomous system (IGP).

"Hop Count Metric: RIP measures distance in network hops, where each network
between the source and destination counts as a single hop.

"It uses UDP for all message transmissions.

"RIP is used over LAN. Version 1 of RIP uses hardware broadcast and version 2 allows
Delivery via multicast.

"It can be used to advertise default route propagation. An organization can use RIP to
Install a default route in each router.

"It uses distance vector algorithm.

ICMP message transport is acted upon by getting ICMP encrypted in IP.
» True

» False
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ICMP message transport is acted upon by getting ICMP encapsulated in IP (P# 117)

Protocol addresses are abstractions provided by
» hardware

» software

» operating system

» internet

Protocol addresses are abstractions provided by software (reference)

These packets serve same purpose on as frames on
» Intranet, LAN
» Internet, WAN
» Intranet, WAN
» Internet, LAN

VIRTUAL PACKETS:
These packets serve same purpose in Internet as frames on LAN

Address mask defines how many bits of address are in suffix?
» True
» False

Address mask defines how many bits of address are in prefix. Prefix defines how much of
address used to identify network.
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a single networking technology is best for all needs.
» True
» False

There is no single networking technology that is best for all needs

A computer attached to a given network can only communicate with other
computers attached to the same network. Is this a problem with multiple networks?
» True

» False

the chief problems with multiple networks are as follows:

* A computer attached to a given network can only communicate with other
Computers attached to the same network.

The term self-identifying is used for Classful IP addresses because the class of the
address can be computed from the address

» Itself
» prefix
» suffix
» mask
Classful IP addresses are self-identifying because the class of the address can be

computed from the address itself

Find the class of the address.
10100111 11011011 10001011 01101111

> A

» B
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» E

» C

Reference table handouts P # 87

Find the class of the address:

11110011 10011011 11111011 00001111
> A

» C

» E

» B

Reference table handouts P # 87

In which method of Address Resolution Protocol the protocol address is determined
by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» T

» D

» C

» T, C
Reference table handouts P # 97

Which method of Address Resolution Protocol requires hardware broadcast?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» D
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> T
» C
» T,D

Reference table handouts P # 97

Which method of Address Resolution Protocol resolution with minimum delay?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» T,D

» C

> T

» T,C

Reference table handouts P # 97

In which method of Address Resolution Protocol the implimentation is more
difficult?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» T,C

> T

» C

» D

Reference table handouts P # 97://vuzs.net

On of the design goals for unicast route propagation is
» Consistency

» inconsistency
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» stability

» dynamic addressing

On of the design goals for unicast route propagation is stability—continual changes in
route are undesirable because they lead to higher jitter and datagram arriving out of

order. Thus, once a unicast routing protocol finds a shortest path, it usually retains the
route until a failure makes the path unusable. (Reference from E-book)

Propagation multicast routing information differs dramatically from unicast route
propagation?

» True

» False

Propagating multicast routing information differs dramatically from unicast route
propagation. The difference arises because internet multicast allows dynamic group

membership and autonomous senders
http://vustudents.ning.com/

To save traffic, an EGP does not summarize routing information from the
autonomous system before passing it to another autonomous system.

» True

» False

To save trdffic, an EGP summarize routing information from the autonomous system
before passing it to another autonomous system. More important an EGP implements

policy constraint that allows a system manager to determine exactly what information is
released outside the organization. (Reference from E-book)

In IPv6 the type of address used for collection of computers with same prefix. Are
known as

» Anycast
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» Unicast

» Multicast

» Non of the given

Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same site.

Cluster: This type of address is used for collection of computers with same prefix,
Datagram is delivered to one out of cluster.

Special types of addresses in IPv6 used for multiple destinations; possibly not same
site. Are known as

» Unicast

» Anycast

» Multicast

» none of the given

Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same site.

Cluster: This type of address is used for collection of computers with same prefix,
Datagram is delivered to one out of cluster.

UDP offers application programs a Message-Oriented Interface, applications can
depend on protocol to preserve data boundaries.

» True
» False
UDP offers application programs a Message-Oriented Interface. It does not divide

messages into packets for transmission and does not combine messages for delivery.
ADVANTAGES:
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* Applications can depend on protocol to preserve data boundaries.

Reliability is the responsibility of the layer
» Network

» Data link

» Transport

» Application

Reliability is the responsibility of the Transport layer

TCP uses mechanism to control the flow of data.

» door
» window
» acknowledgment

» retransmission

In Direct point to point communication adding the Nth computer requires------------
new connections.

» None of the given

> N2

> N-1

> (N2 -N)/2

disadvantage In Direct point to point communication is that adding a new computer to

the network requires N-1 new connections .(P# 23)

In Point-to-Point topology there are two topologies.
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» Tree and Ring

» Star and Ring

» Star and Tree

» None of the given
POINT-TO-POINT:

In Point-to-Point topology there are two topologies.
1) STAR topology

2) TREE topology

In -------mm-- , network occupies the smaller area like a room a floor or a building
» LAN

» WAN

» MAN

» None of the given

In LAN network occupies the smaller area like a room a floor or a building.(P# 4)

Hardware that calculates a CRC uses two simple components.
» AND unit and XOR unit

» Shift register and XOR unit

» Shift register and ANDunit

» none of the given

CRC uses just two hardware components:

« Shift register
* Exclusive OR ( XOR unit ) .(P# 20)
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The Gigabit Ethernet hardware operates at a rate of --------
» 10 Mbps

» 100 Mbps

» 1000 Mbps

» None of the given

Gigabit Ethernet that operates at 1 Gbps (1000 Mbps) over fiber optics and twisted pair
Ethernet cables.

formally named informally known as the twisted pair Ethernet or TP
Ethernet.

» 10 Base 2

» 10 Base 5

» 10 Base T

» none of the given

10BASE-T:

This is another standard of wiring scheme. It is commonly called 10Base-T, Twisted Pair

or TP Ethernet. (P# 43)

An interface for thin Ethernet must have an connector , and must
generate signals according to the specification.

» RJ-45, 10 Base T

» RJ-45, 10 Base 5
» BNC, 10 Base 2

» BNC, 10 Base T
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A system with redundant bridges might have a problem with in the system.

» Loop
» Filters
» Spanning Trees

» All given choices

computes shortest paths in a graph by using weights on edges as a
measure of distance.

» Greedy algorithm
» Distance vector algorithm
» Dijksta’s algorithm

» none of the given

Djikstra’s algorithm can accommodate weights on edges in graph. The shortest
Path is then the path with lowest total weight (sum of the weight with all edges). It should
Be noted that the shortest path is not necessarily with fewest edges (or hops).

Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a .

» Connectionless service paradigm
» Connection-oriented service paradigm

» Both Connectionless and Connection-oriented service paradigm

» none of the given
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protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer
» Network Interface Layer
» Internet Layer

» Transport Layer

LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer.

An Internet Address (IP address) is a unique binary number assigned
to a host and used for all communication with host

» 48-bit
» 32-bit
» 24-bit
» None of the given

An Internet address (IP address) is a unique 32-bit binary number assigned to a
host and used for all communication with the host

The address identifies the physical network to which the computer is
attached, while the identifies an individual computer on that network.

» prefix , suffix
» suffix , prefix
» suffix , suffix

» None of the given
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PREFIX:
It identifies the physical network to which the computers are attached.

SUFFIX:
It identifies an individual computer on the network.

places the boundary between the first and second octets

» Class A
» Class B
» Class C

» Class D

Class A places the boundary between the first and second octets. Class B places the
boundary between the second and third octets, and class C places the boundary between

the third and fourth octets.

places the boundary between the third and fourth octets.

» Class A
» Class B
» Class C

» Class D

Class A places the boundary between the first and second octets. Class B places the
boundary between the second and third octets, and class C places the boundary between

the third and fourth octets.
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field of header indicates whether a datagram is a fragment or a complete
datagram.
» FLAGS
» FLAGMENT OFFSET
» IDENTIFICATION

» None of the given

FRAGMENTATION:

provides connectionless service.
» TCP
» UDP
» IP
» none of the given
UDP has the following characteristics.
« [t is an end-to-end protocol. It provides application-to-application communication.
* It provides connectionless service.
* It is a Message-Oriented protocol.
* It uses best-effort delivery service.

* It follows arbitrary interaction.
* It is operating system independent

UDP and TCP are both layer protocols

» Physical
» Data link

» Network
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» Transport

Connection-oriented service, Point-to-point, Complete reliability, Full-duplex
communication, Stream interface, Reliable connection startup and Graceful
connection shutdown are the services provided by

» IP

» None of the given

» TCP

» UDP

SERVICE PROVIDED BY TCP:

Following are the services provided by TCP:
 Connection-oriented service

* Point-to-point

» Complete reliability

* Full-duplex communication

* Stream interface

* Reliable connection start-up

* Graceful connection shutdown

protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
» Internet Layer
» Transport Layer

LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer

identifies which application program on receiving computer should receive
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the data

» Logical address
» Source port

» Destination Port

» None of the given

identifies the application program that sent the data.
» Destination Port
» Source port
» Logical address

» None of the given

The Border Gateway Protocol (BGP) uses for all communication

» UDP

» TCP

» Both UDP and TCP

» None of the given

BORDER GATEWAY PROTOCOL:

It is most popular Exterior Gateway Protocol in Internet. It has following characteristics:

"It provides routing among autonomous systems (EGP).
"It provides policies to control routes advertised.
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"It uses reliable transport (TCP).

uses distance vector approach to define routing

» BGP
» OSPF
» RIP

» None of the given

ROUTING INFORMATION PROTOCOL (RIP):

It has the following characteristics:

"It is used for routing within an autonomous system (IGP).

"Hop Count Metric: RIP measures distance in network hops, where each network
between the source and destination counts as a single hop.

"It uses UDP for all message transmissions.

"RIP is used over LAN. Version 1 of RIP uses hardware broadcast and version 2 allows
delivery via multicast.

"It can be used to advertise default route propagation. An organization can use RIP to
install a default route in each router.

"It uses distance vector algorithm.

ICMP message transport is acted upon by getting ICMP encrypted in IP.
» True
» False

ICMP message transport is acted upon by getting ICMP encapsulated in IP (P# 117)
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Protocol addresses are abstractions provided by
» hardware

» software

» operating system

» internet

Protocol addresses are abstractions provided by software

These packets serve same purpose on as frames on
» Intranet, LAN
» Internet, WAN
» Intranet, WAN
» Internet, LAN

VIRTUAL PACKETS:
These packets serve same purpose in Internet as frames on LAN

Address mask defines how many bits of address are in suffix?

» True

» False

Address mask defines how many bits of address are in prefix. Prefix defines how much of
address used to identify network.

A single networking technology is best for all needs.

» True
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» False

There is no single networking technology that is best for all needs

A computer attached to a given network can only communicate with other
computers attached to the same network. Is this a problem with multiple networks?
» True

» False

the chief problems with multiple networks are as follows:

* A computer attached to a given network can only communicate with other
Computers attached to the same network.

The term self-identifying is used for Classful IP addresses because the class of the
address can be computed from the address

> Itself
» prefix
» suffix
» mask

Classful IP addresses are self-identifying because the class of the address can be
computed from the address itself

Find the class of the address.
10100111 11011011 10001011 01101111

> A
» B
> E

» C
Reference table handouts P # 87
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Find the class of the address:
11110011 10011011 11111011 00001111

> A
> C
» E
» B

Reference table handouts P # 87

In which method of Address Resolution Protocol the protocol address is determined
by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

> T

» D

> C

» T, C
Reference table handouts P # 97

Which method of Address Resolution Protocol requires hardware broadcast?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» D

> T

» C

» T,D
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Reference table handouts P # 97

Which method of Address Resolution Protocol resolution with minimum delay?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» T,D

» C

> T

» T,C

Reference table handouts P # 97

In which method of Address Resolution Protocol the implementation is more
difficult?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for
Data Exchange?

» T,C

> T

» C

» D

Reference table handouts P # 97

On of the design goals for unicast route propagation is
» Consistency

» inconsistency

» stability

» dynamic addressing
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On of the design goals for unicast route propagation is stability—continual changes in
route are undesirable because they lead to higher jitter and datagram arriving out of
order. Thus, once a unicast routing protocol finds a shortest path, it usually retains the
route until a failure makes the path unusable. (Reference from E-book)

Propagation multicast routing information differs dramatically from unicast route
propagation?

» True

» False

Propagating multicast routing information differs dramatically from unicast route
propagation. The difference arises because internet multicast allows dynamic group
membership and autonomous senders

to save traffic an EGP does not summarize routing information from the
autonomous system before passing it to another autonomous system.

» True

» False

to save trdffic, an EGP summarize routing information from the autonomous system
before passing it to another autonomous system. More important an EGP implements

policy constraint that allows a system manager to determine exactly what information is
released outside the organization. (Reference from E-book)

In IPv6 the type of address used for collection of computers with same prefix. Are
known as

» Anycast
» Unicast
» Multicast

» none of the given
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Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same site.

Cluster: This type of address is used for collection of computers with same prefix,
Datagram is delivered to one out of cluster.

vuzs.net

Special types of addresses in IPv6 used for multiple destinations; possibly not at
same site.

» Unicast

» Anycast

» Multicast

» none of the given

Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same site.

Cluster: This type of address is used for collection of computers with same prefix,
Datagram is delivered to one out of cluster.

UDP offers application programs a Message-Oriented Interface, applications can
depend on protocol to preserve data boundaries.

» True

» False

UDP offers application programs a Message-Oriented Interface. It does not divide
messages into packets for transmission and does not combine messages for delivery.

ADVANTAGES:
» Applications can depend on protocol to preserve data boundaries.

Reliability is the responsibility of the layer
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» Network
» Data link
» Transport
» Application

Reliability is the responsibility of the Transport layer

TCP uses mechanism to control the flow of data.
» Door

» window

» acknowledgment

» retransmission

TCP uses window mechanism to control the flow of data.

the time for acknowledgement to arrival of packet depends on.

» Distance to destination and Current traffic conditions
» Current traffic conditions

» Distance to destination

» non of these

The time for acknowledgement to arrive depends on:

* Distance to destination
* Current traffic conditions

FDDI can transmits data at a rate of ----------
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» 100 million bits per second
» 10 million bits per second
» 1000 million bits per second

» None of the given

the time for acknowledgement to arrival of packet depends on.

» Distance to destination and Current traffic conditions
» Current traffic conditions

» Distance to destination

» non of these

The time for acknowledgement to arrive depends on:

* Distance to destination
* Current trdffic conditions

FDDI can transmits data at a rate of ----------

» 100 million bits per second
» 10 million bits per second
» 1000 million bits per second

» None of the given
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Question No: 1 ( Marks: 1) - Please choose one
No error detection scheme is perfect because transmission errors can affect the
additional information as well as the data.

_ True (Reference is given below)
_ False

(No error detection scheme is perfect because transmission errors can affect the
additional information as well as the data. A cyclically redundancy check, which is
slightly more difficult to computer can detect more errors then a Parity or Check sum
mechanism.)

Question No: 2 ( Marks: 1) - Please choose one
------ Program sends a message to a remote computer and reports whether the
computer responds.

_Ping (P-11)

_ Trace route
_ICMP

_ Non of the given

Question No: 3 ( Marks: 1) - Please choose one
---------- was especially concerned about the lack of high powered computers.

_ ARPA (Search by Internet) click here to see
_ IEEE

_EIA

_ Non of the given

Question No: 4 ( Marks: 1) - Please choose one
The term -------- is used to denote the definition of a packet used with a specific type
of network.

_ Packet

_Frame (p-16)

_ Data

_ None of the given
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Question No: 5 ( Marks: 1) - Please choose one
Computer networks are often called -------------- because they use packet technology.

_ Ethernet

_ Switch networks

_ Packet networks (Search by Internet) Click Here to see
_ None of the given

Question No: 6 ( Marks: 1) - Please choose one
-------------- have advantages arisen from the size and ease of computation.

_CRC (p-20)
_ Parity

_ Checksums

_ None of given

Question No: 7 ( Marks: 1) - Please choose one
Most LANs that employ ring topology use an access mechanism known as-----—--

_ CSMA/CD

_ CSMA/CA

_ TOKEN PASSING (p-30)
_ None of the given

Question No: 8 ( Marks: 1) - Please choose one

IEEE LLC/SNAP header is -------- , which is used to specify the type of data.
_8octets (p-37)

_ 8 bytes

_ 8 bits

_ None of the given

Question No: 9 ( Marks: 1) - Please choose one
Formally named informally known as the twisted pair Ethernet or TP
Ethernet.

_ 10 Base 2

_ 10 Base 5
_10Base T (p-46)
_ None of the given
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Question No: 10 ( Marks: 1) - Please choose one
An interface for twisted pair Ethernet must have an connector , and
must generate signals according to the specification.

_RJ-45,10 Base T (p-47)
__RJ-45, 10 Base 5
~ BNC, 10 Base 2
_ BNC, 10Base T

Question No: 11 ( Marks: 1) - Please choose one
A bridges function in the layers(s).

_ Physical (MAC)
_ Data link

_ Network (not sure)
_ Physical (MAC) and Data link

Question No: 12 ( Marks: 1) - Please choose one
A Bridge can

_ Filter a frame

_ Forward a frame

_ Extend a LAN

_ Do all the above (p-50)

Question No: 13 ( Marks: 1) - Please choose one
A Bridge forwards or filters a frame by comparing the information in its address
table to the frame’s

_ Layer 2 source address

_ Source node’s physical address

_ Layer 2 destination address (not sure)
_ Layer 3 destination address

Question No: 14 ( Marks: 1) - Please choose one
computes shortest paths in a graph by using weights on edges as a
measure of distance.

_ Greedy algorithm

_ Distance vector algorithm

_ Dijksta’s algorithm (p-62)
_ Non of the given
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Question No: 15 ( Marks: 1) - Please choose one
is used for audio and video, since these have predefined maximum
data rates

_ Constant Bit Rate (CBR) service (p-71)
_ Variable Bit Rate (VBR) service
_Available Bit Rate (ABR) service

_ None of the given

Question No: 16 ( Marks: 1) - Please choose one
Unlike Frame Relay and ATM, SMDS (Switched multi-megabit Data service)
offers

_ Connectionless service paradigm (p-152)

_ Connection oriented service paradigm

_ Both Connectionless and Connection-oriented service paradigm
_ None of the given

Question No: 17 ( Marks: 1) - Please choose one
A network with throughput T and delay D has a total of bit in transit at
any time.

~T/D

_TxD (p-80)
_T+D

_ None of the given

Question No: 18 ( Marks: 1) - Please choose one
ATM is designed to work on

_ Twisted Pair

_ Coaxial

_ Radio Frequency
_ Fiber (p-32)

Question No: 19 ( Marks: 1) - Please choose one
Computers attached to an Ethernet use ------ in which a computer waits for the
ether to be idle before transmitting a frame.

_ CSMA/CD (p-43)
_ CSMA/CA

_ TOKEN PASSING
_ None of the given
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Question No: 20 ( Marks: 1) - Please choose one
FDDI can transmits data at a rate of ------—-—-

_ 100 million bits per second (p-31)
_ 10 million bits per second

_ 1000 million bits per second

_ None of the given

Question No: 1 (Marks:1)

In Point-to-Point topology there are two topologies.
» Tree and Ring

» Star and Ring

» Star and Tree (Reference is given below)

» None of the given

In Point-to-Point topology there are two topologies.

1) STAR topology 2) TREE topology

Question No: 2 (M arks: 1)
------ Program sends a message to a remote computer and reports whether the
computer responds.

» Ping  (Reference is given below)
» Traceroute

» ICMP

» Non of the given

Ping program tests reach ability. It sends datagram from B to A, that echoes back to B. it
uses ICMP echo request and echo reply messages.

Question No:3(Marks:1)
----- has no way to determine the cause of the problem.

» ICMP
» Ping (Reference is given below)

» Trace route

» Non of the given
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Ping has no way to determine the cause of the problem. Tracing A Route Network
administrators use another tool, trace route.

Question No:4 (M arks: 1)
The term----- ------- refers to the general concept of a small block of data

» Packet (Reference is given below)
» Frame

» Data

» None of the given

Packet is a generic term that refers to small block of data. Packet have different format.
Each hardware uses different packet format.

Question No: S(Marks:1)
---------- scheme, which is designed to help detect transmissions errors, send one
extra bit of information with each character

» Parity (Reference is given below)
» Checksums

» CRC

» None of given

A parity scheme, which is designed to help detect transmission errors, sends one extra hit
of information with each character. Although it allows receiver to determine if a single
bit has been changed parity can not detect transmission errors that change an even
number of bits.

Question No: 6 (M arks: 1)
Local Talk is a LAN technology that employs -------------

» Bus topology (Reference is given below)
» Ring topology
» Star topology

» None of the given
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LOCAL TALK:

Apple invented the LAN technology that uses bus topology. Its interface is included with
all Macintosh computers.

Question No: 7(Marks:1)
Most LANs that employ ring topology use an access mechanism known as-------

» CSMA/CD

» CSMA/CA

» TOKEN PASSING (Reference is given below)
» None of the given

Most LANSs that employ ring technology use an access mechanism known as token
passing. A token ring operates as a single, shared medium. When a computer wants to
send data, it must wait until it obtains the token, when it is in control of the ring

Question No: 8 (M arks: 1)
Ethernet uses a --—-—-- bit static addressing scheme in which each device is assigned a
unique address by the manufacturer.

> 64

» 48 (Reference is given below)
> 32

> 8

Ethernet uses a 48-bit static addressing scheme

Question No: 9 (M arks:1)

Formally named informally known as the thick wire Ethernet or Thick
net.

» 10 Base 2

» 10 Base 5 (Reference is given below)

» 10Base T

» None of the given
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Thick Ethernet, officially known as 10 Base 5, is the oldest form of Ethernet. It was
originally developed in the late 1970's by Digital Equipment Corporation, IBM,
and Xerox, and became an international standard (IEEE 802.3) in 1983.

Taken from http://www.maznets.com/tech/10base-5.htm

Question No: 10 (M arks: 1)
Formally named informally known as the twisted pair Ethernet or TP
Ethernet.

» 10 Base 2

» 10 Base 5

» 10 Base T (Reference is given below)
» None of the given

twisted pair ethernet
Formally called 10 Base —-T

e Also twisted pair Ethernet or simply TP Ethernet

Question No: 11 (M arks: 1)
The maximum size of an Ethernet segment is

» 250 meters

» 500 meters (Reference is given below)
» 700 meters

» None of the given

One Ethernet cable is sometimes called a segment. This segment is limited to 500 meters
in length. The minimum separation between connections is 3 meters. (P# 27)

Question No: 12 (M arks: 1)
A Bridge can

» Filter a frame

» Forward a frame

» Extend a LAN

» Do all the above (Reference is given below)
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A bridge is a hardware device also used to connect two LAN segments to extend a LAN. It
listens to all traffic and recognizes frame format. It also forwards only correct complete
frames and discards the collided and error frames.

The most important task a bridge performs is frame filtering.

Question No: 13 (M arks: 1)
computes shortest paths in a graph by using weights on edges as a measure
of distance.

» Greedy algorithm

» Distance vector algorithm

» Dijksta’s algorithm (Reference is given below)
» Non of the given

Dijkstras algorithm computes shortest paths in a graph by using weights on edg as a
measure of distance. A path with the fewest number of edges may not be the path with
least weight. (P# 173 e-books)

Question No: 14 (M arks: 1)
is used for compressed audio and video where the data rate depends on
the level of compression that can be achieved.

» Constant Bit Rate (CBR) service

» Variable Bit Rate (VBR) service (Reference is given below)
» Available Bit Rate (ABR) service

» None of the given

VARIABLE BIT RATE (VBR):

It is used for compressed audio and video where the data rate depends on the level of
compression that can be achieved.

Question No: 15 (M arks: 1)
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Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a .

» Connectionless service paradigm (Reference is given below)
» Connection-oriented service paradigm

» Both Connectionless and Connection-oriented service paradigm
» None of the given

Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a connectionless
service paradigm. Although a computer needs to wait for access to a shared medium
before sending a packet

(zh,vuzs,nov10)

Question No: 16 (M arks: 1)
The product of delay and throughput measures the of data that can be
present on the network.

» Area

» Volume

» Length

» None of the given (Reference is given below)

DELAY THROUPUT PRODUCT:

It is computed as delay time multiplied by effective throughput. It measures amount of
data that can be present in the network (P# 80)

Question No: 17 (M arks: 1)
A network with throughput T and delay D has a total of bit in transit at
any time.

> T/D

» T x D (Reference is given below)
»T+D

» None of the given

A network with throughput T and delay D has a total of T x D bits in transit at
any time. (e-books)



Delivered By: Waseem Jeetumoni Logic Khan

Question No: 18 (M arks: 1)
One repeater , two repeaters the maximum cable length
limitation.

» doubles, triple (Reference is given below)
» square roots, cude roots

» and, triple

» doubles, cancel

One repeater doubles, two repeaters triple the maximum cable length limitation. (P# 49)

Question No: 19 (M arks: 1)
A network uses a -——-—-- if all computers attach to a central point

» Star Topology (Reference is given below)
» Ring Topology

» Bus Topology

» None of the given

STAR TOPOLOGY:

In this topology, all computers are attached to a central point, which is sometimes called
the “Hub” (P# 25)

Question No: 20 (M arks: 1)
Computers attached to an Ethernet use ---—-- in which a computer waits for the
other to be idle before transmitting a frame.

» CSMA/CD (Reference is given below)
» CSMA/CA

» TOKEN PASSING

» None of the given

All computers attached to the Ethernet use CSMA/CD to co-ordinate their activities. A
computer wishing to transmit checks for electrical activity on the cable, informally called
a carrier. If there is no carrier, the computer can transmit. If a carrier is present, the
computer waits for the sender to finish before proceeding.

MIDTERM EXAMINATION
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Question No: 1 ( Marks: 1) - Please choose one
A typical port on an ATM switch operates at

_ OC-2 speed (155Mbps)
_ OC-3 speed (100Mbps)
_ OC-3 speed (155Mbps) (p-72)
_ OC-3 speed (155Gbps)

Question No: 2 ( Marks: 1) - Please choose one

The product of delay and throughput measures the

present on the network.

_ Area

_ Volume

_ Length

_ None of the given (p-80)

Question No: 3 ( Marks: 1) - Please choose one

or higher.

of data that can be

is used for compressed audio and video where the data rate depends on

the level of compression that can be achieved.

___ Constant Bit Rate (CBR) service
___Variable Bit Rate (VBR) service (p-71)
____Available Bit Rate (ABR) service
___None of the given

Question No: 4 ( Marks: 1) - Please choose one
Which of the following is a connecting device?

___Bridge
__Repeater

___Hub
____All the given  (p-54)

Question No: 5 ( Marks: 1) - Please choose one
A bridges function in the layers(s).

___Physical (MAC)
___ Data link
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____Network (not sure)
__Physical (MAC) and Data link

Question No: 6 ( Marks: 1) - Please choose one
IEEE LLC/SNAP header is -------- , which is used to specify the type of data.

____8octets (p-37)
8 bytes

___ 8bits

___None of the given

Question No: 7 ( Marks: 1) - Please choose one
The third field of the header consists of ------ bit Ethernet frame type.

48

32

___16 (p-36)

8

Question No: 8 ( Marks: 1) - Please choose one

An —--—--————- method, the network hardware designers specify how type information
is included in the frame and the value use to identify various frame types.

___Explicit frame type (not sure)
__Ideal frame type

___Implicit frame type

___None of the given

Question No: 9 ( Marks: 1) - Please choose one
Local Talk is a LAN technology that employs -------------

_Star topology
____Bus topology (p-30)
___Ring topology
___None of the given

Question No: 10 ( Marks: 1) - Please choose one
The Fast Ethernet hardware operates at a rate of --—-—---—-

10 Mbps

___100 Mbps (p-27)
___ 1000 Mbps
___None of the given
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Question No: 11 ( Marks: 1) - Please choose one
---------- scheme, which is designed to help detect transmissions errors, send one
extra bit of information with each character

___ Parity
___Checksums (p-19)
___CRC

___None of given

Question No: 12 ( Marks: 1) - Please choose one
Computer networks are often called -------------- because they use packet technology.

___ Ethernet

___Switch networks

___Packet networks (repeated)
___None of the given

Question No: 13 ( Marks: 1) - Please choose one
------ Program sends a message to a remote computer and reports whether the
computer responds.

___Ping (p-11)

_ Traceroute
__ICMP

__Non of the given

Question No: 14 ( Marks: 1) - Please choose one
In - , network occupies larger areas like cities & countries.

_ LAN

___WAN (p-55)

~_ MAN

___None of the given

Question No: 15 ( Marks: 1) - Please choose one

In - , network occupies the smaller area like a room a floor or a building
___LAN (p-55)

~_WAN

___MAN

___None of the given
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Question No: 16 ( Marks: 1) - Please choose one
In Point-to-Point topology there are two topologies.

___ Tree and Ring

_ Star and Ring
___Star and Tree (p-2)
___None of the given

MIDTERM EXAMINATION
Fall 2008
CS610- Computer Network (Session - 2)
Ref No: 109816
Time: 60 min
Marks: 38

Question No: 1 ( Marks: 1) - Please choose one
has a jitter zero

_ None of the given

_ Virtual Private Network

_ Isochronous Network

_ Asynchronous Network (p-65)

Question No: 2 ( Marks: 1) - Please choose one
_Unlike Frame Relay and ATM, SMDS (Switched multi-megabit Data service)
offers

____Connectionless service paradigm  (p-77)

___ Connection oriented service paradigm

__Both Connectionless and Connection-oriented service paradigm
___None of the given

Question No: 3 ( Marks: 1) - Please choose one
_ATM assigns each VC a identifier that is divided two parts to
produce a hierarchy.

_ 21-bit
~ 22-bit
— 23-bit
_ 24-bit (p-67)
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Question No: 4 ( Marks: 1) - Please choose one
_Most WAN systems include a mechanism that can be used to eliminate the
common case of duplication routing is called

___Hierarchal address
___Default route (p-60)
___Shortest path

___None of the given

Question No: 5 ( Marks: 1) - Please choose one
_The next hop to which a packet is sent depends only on

___Packet’s destination (p-102)
__Packet’s original source
___Path the packet has taken
__Non of the given

Question No: 6 ( Marks: 1) - Please choose one
_An interface for twisted pair Ethernet must have an connector , and
must generate signals according to the specification.

___RJ-45,10 Base T (p-46)
___RJ-45,10 Base 5
~ BNC, 10 Base 2
~__BNC, 10Base T

Question No: 7 ( Marks: 1) - Please choose one
_When an application--------------- data, it makes a copy of the data available to all
other computers on the network.

____Broadcasting (p-53)
___ Multicasting
__Unicasting

___None of the given

Question No: 8 ( Marks: 1) - Please choose one
A - provide a mechanism that a customer can use to set a physical address.

___ Static addressing scheme
___Configurable addressing scheme (p-34)
___Dynamic addressing scheme

___None of the given

Question No: 9 ( Marks: 1) - Please choose one
_FDDI can transmits data at a rate of -----
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___100 million bits per second ----- (p-31)
___100 million bits per second

100 million bits per second

____100 million bits per second

___None of the given

Question No: 10 ( Marks: 1) - Please choose one
_Computers attached to an ether use ------ in which a computer waits for the ether
to be idle before transmitting a frame.

___CSMA/CD
___CSMA/CA
____TOKEN PASSING
___None of the given

Question No: 11 ( Marks: 1) - Please choose one
-------------- have advantages arisen from the size and ease of computation.

~_CRC

__ Parity
___Checksums (p-19)
___None of given

Question No: 12 ( Marks: 1) - Please choose one
_The term -------- is used to denote the definition of a packet used with a specific
type of network.

__Packet
___Frame (p-16)
___Data

___None of the given

Question No: 13 ( Marks: 1) - Please choose one
_m————- has no way to determine the cause of the problem.

___Ping (p-11)
___Trace route
___ICMP

___Non of the given

Question No: 14 ( Marks: 1) - Please choose one
_m——— Program sends a message to a remote computer and reports whether the
computer responds.
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___Ping (p-11)
__Traceroute
___ICMP

___Non of the given

Question No: 15 ( Marks: 1) - Please choose one

_In - , network occupies the smaller area like a room a floor or a building
___LAN (p-55)
__WAN

MAN

:None of the given

MIDTERM EXAMINATION
Spring 2010
CS610- Computer Network

Question No: 1  ( Marks: 1) - Please choose one

In Point-to-Point topology there are two topologies.

» Star and Tree (P-5)
» Star and Ring
» Star and Bus

» None of the given

Question No: 2  ( Marks: 1) - Please choose one

------ Program sends a message to a remote computer and reports whether the computer
responds.

» Ping (p-11)
» Traceroute

» ICMP
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» Non of the given

Question No: 3  ( Marks: 1) - Please choose one

------ has no way to determine the cause of the problem.

» ICMP
» Non of the given
» Ping (p-11)

» Trace route

Question No: 4  ( Marks: 1) - Please choose one

The term------------ refers to the general concept of a small block of data

» Packet (p-16)

» Frame
» Data

» None of the given

Question No: 5  ( Marks: 1) - Please choose one

---------- scheme, which is designed to help detect transmissions errors, send one extra
bit of information with each character

» Parity (p-18)

» Checksums
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» CRC
» None of given

Question No: 6  ( Marks: 1) - Please choose one

Local Talk is a LAN technology that employs -------------

» Bus topology (p-30)

» Ring topology
» None of the given
» Star topology

Question No: 7 ( Marks: 1) - Please choose one

Most LANs that employ ring topology use an access mechanism known as-------

» CSMA/CD
» CSMA/CA
» TOKEN PASSING (p-30)

» None of the given

Question No: 8 ( Marks: 1) - Please choose one

Ethernet uses a ------ bit static addressing scheme in which each device is assigned a
unique address by the manufacturer.

> 64
> 48 (p-98)

» 32
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> 8

Question No: 9  ( Marks: 1) - Please choose one

Formally named informally known as the thick wire Ethernet or Thick net.

» 10 Base 2
» 10 Base 5
> 10 Base T (p-40)

» None of the given

Question No: 10  ( Marks: 1) - Please choose one

Formally named informally known as the twisted pair Ethernet or TP
Ethernet.

> 10 Base 2 (p-46)
» 10 Base 5
» 10Base T

» None of the given

Question No: 11  ( Marks: 1) - Please choose one

The maximum size of an Ethernet segment is
» 250 meters
» 500 meters (p-27)
» 700 meters
» None of the given

Question No: 12 ( Marks: 1) - Please choose one

A Bridge can
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» Filter a frame
» Forward a frame
» Extend a LAN

» Do all the above (p-50)

Question No: 13 ( Marks: 1) - Please choose one

computes shortest paths in a graph by using weights on edges as a measure of
distance.

» Greedy algorithm
» Distance vector algorithm
» Dijksta’s algorithm (p-62)

» Non of the given

Question No: 14  ( Marks: 1) - Please choose one

is used for compressed audio and video where the data rate depends on the
level of compression that can be achieved.

» Constant Bit Rate (CBR) service
» Variable Bit Rate (VBR) service (p-71)
> Available Bit Rate (ABR) service

» None of the given
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Question No: 15 (Marks: 1) - Please choose one

Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a .

» Connectionless service paradigm (p-77)
» Connection-oriented service paradigm
» Both Connectionless and Connection-oriented service paradigm

» None of the given

Question No: 16  ( Marks: 1) - Please choose one

The product of delay and throughput measures the of data that can be present on
the network.

» Area
» Volume
» Length

» None of the given (p-80)

Question No: 17  ( Marks: 1) - Please choose one

A network with throughput T and delay D has a total of bit in transit at any
time.

> T/D
> TxD (p-80)
» T+D

» None of the given

Question No: 18  ( Marks: 1) - Please choose one
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One repeater , two repeaters the maximum cable length limitation.
» doubles, triple (p-49)
P square roots, cude roots
» and, triple

» doubles, cancel

Question No: 19  (Marks: 1) - Please choose one

A network uses a ------ if all computers attach to a central point
» Star Topology (p-25)
» Ring Topology
» Bus Topology

» None of the given

Question No: 20  ( Marks: 1) - Please choose one

Computers attached to an Ethernet use ------ in which a computer waits for the ether to be
idle before transmitting a frame.

» CSMA/CD (p-28)
» CSMA/CA
» TOKEN PASSING
» None of the given
MIDTERM EXAMINATION

Fall 2008
CS610- Computer Network (Session - 2)
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Question No: 1 (Marks: 1) - Please choose one

has a jitter zero

» None of the given

» Virtual Private Network

» Isochronous Network

» Asynchronous Network (p-65)

Question No: 2 (Marks: 1) - Please choose one

Unlike Frame Relay and ATM, SMDS (Switched multi-megabit Data service)
offers

» Connectionless service paradigm (p-77)

» Connection oriented service paradigm

» Both Connectionless and Connection-oriented service paradigm
» None of the given

Question No: 3 (Marks: 1) - Please choose one

ATM assigns each VC a identifier that is divided two parts to produce a
hierarchy.

»21-bit
> 22-bit
» 23-bit
»24-bit  (p-67)

Question No: 4 (Marks: 1) - Please choose one

Most WAN systems include a mechanism that can be used to eliminate the common case
of duplication routing is called

» Hierarchal address

» Default route (p-60)
» Shortest path

» None of the given

Question No: 5 (Marks: 1) - Please choose one

The next hop to which a packet is sent depends only on

P Packet’s destination (p-102)
» Packet’s original source

» Path the packet has taken

» Non of the given
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Question No: 6 (Marks: 1) - Please choose one

An interface for twisted pair Ethernet must have an connector , and must
generate signals according to the specification.

» RJ-45,10 Base T (p-46)
»RJ-45, 10 Base 5

» BNC, 10 Base 2

»BNC, 10 Base T

Question No: 7 (Marks: 1) - Please choose one

When an application--------------- data, it makes a copy of the data available to all other
computers on the network.

» Broadcasting (p-53)
» Multicasting

» Unicasting

» None of the given

Question No: 8 (Marks: 1) - Please choose one

A - provide a mechanism that a customer can use to set a physical address.

P Static addressing scheme

» Configurable addressing scheme (p-34)
» Dynamic addressing scheme

» None of the given

Question No: 9 (Marks: 1) - Please choose one

FDDI can transmits data at a rate of ----- -----

» 100 million bits per second (p-31)
» 100 million bits per second

» 100 million bits per second

» None of the given

Question No: 10 ( Marks: 1) - Please choose one

Computers attached to an ether use ------ in which a computer waits for the ether to be
idle before transmitting a frame.

» CSMA/CD (not sure)
» CSMA/CA

» TOKEN PASSING

» None of the given

Question No: 11 (Marks: 1) - Please choose one

-------------- have advantages arisen from the size and ease of computation.
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» CRC

» Parity

» Checksums (p-19)
» None of given

Question No: 12 (Marks: 1) - Please choose one

The term -------- is used to denote the definition of a packet used with a specific type of
network.

» Packet

» Frame (p-16)
» Data

» None of the given

Question No: 13 ( Marks: 1) - Please choose one

------ has no way to determine the cause of the problem.

»Ping (p-11)
» Trace route

» ICMP

» Non of the given

Question No: 14 ( Marks: 1) - Please choose one

------ Program sends a message to a remote computer and reports whether the computer
responds.

» Ping (p-11)

» Traceroute
»ICMP

» Non of the given

Question No: 15 (Marks: 1) - Please choose one

In --—----m - , network occupies the smaller area like a room a floor or a building

»LAN (p-55)

» WAN

» MAN

» None of the given
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Question No: 21 ( Marks: 2)
What is the difference between the physical and logical topologies?

Every LAN has a topology, or the way that the devices on a network are arranged
and how they communicate with each other.
PHYSICL TOPOLOGY:

The way that the workstations are connected to the network through the actual
cables that transmit data -- the physical structure of the network -- is called the physical
topology. It depends on the wiring scheme.

LOGICAL TOPOLOGY:

The logical topology, in contrast, is the way that the signals act on the network
media, or the way that the data passes through the network from one device to the next
without regard to the physical interconnection of the devices. We can say that it is
defined by the specific network technology.

Question No: 22 ( Marks: 2)
Define Vector-Distance Algorithm.

Packet switches wait for next update message and they iterate through entries in
message. If entry has shortest path to destination, insert source as next hop to destination
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and record distance as distance from next hop to destination plus distance from this
switch to next hop.

Question No: 23 ( Marks: 3)
What is the concept of store and forward technology?
STORE AND FORWARD:

Data delivery from one computer to another is accomplished through store and
forward technology. In this technology packet switch stores incoming packet and also
forwards that packet to another switch or computer. For this purpose packet switch has
internal memory into which it can hold packet if outgoing connection is busy. Packets for
each connection held on queue.

Question No: 24 ( Marks: 3)
How can Switched Virtual Network be established?
SWITCHED VIRTUAL CIRCUITS:

Most networks offer dynamic connections, which last for a relatively short time.
To handle this, ATM can dynamically establish a switched virtual circuit (SVC), allow it
last as long as necessary and then terminate it.
The terminology comes from the Telco’s where switching system normally refers to all
switching.
ESTABLISHING AN SVC:
The computer sends a connection request to the switch to which it is attached.
Software in the switch finds a network path to the destination and sends along the
connection request.
Each pair of switches in the path communicates to choose a VPI/VCI for their tables.
Once the connection is established by the destination, a message is sent back to the
originating computer to indicate the SVC is ready.
If any switch or the destination computer does not agree to setting up the VC, an error
message is sent back and the SVC is not established

Question No: 25 ( Marks: 5)
How can a bridge know whether to forward frames?

The bridge builds a list of MAC addresses on either side of the bridge. Therefore,
it knows which packets should be forwarded to the other side and which should not. Most
bridges are self-learning bridges. As soon as a frame arrives to a bridge, it extracts a
source address from its header and automatically adds it in the list for that segment. In
this way a bridge builds up address lists.

In the example of a packet that uses a MAC address not in its table it can err on the side
of caution by forwarding the packet.

Question No: 26 ( Marks: 5)
Compare connection oriented and connectionless Service.
Connection-Oriented vs. Connectionless Service

This characteristic specifies whether conversations take place in a more or less
structured manner. When using a connection-oriented protocol, you incur the overhead of
setting up a virtual circuit (a defined communications path) between the sender and
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receiver, which is maintained until the sender and receiver have completed their entire
conversation.

When the conversation is completed, you incur the overhead of tearing down the virtual
circuit. Connection-oriented protocols provide guaranteed delivery of messages in the
order in which they were sent.

Contrast this with Connectionless service, which does not require establishing a session
and a virtual circuit. This can be found in the network layer or transport layer, depending
on the protocol. You can think of a connectionless protocol as being akin to mailing a
post card. You send it and hope that the receiver gets it. Common features of a
connectionless service are:

* Packets do not need to arrive in a specific order

* Reassembly of any packet broken into fragments during transmission must be in proper
order

* No time is used in creating a session

* No Acknowledgement is required.

* The largest connectionless network in use today is the Internet

Question No: 21 ( Marks: 2)
What is the difference between LAN and WAN?
Local area network (LAN)
LAN is small in size covers the area within a room, building or cities.
Wide area network (WAN)
WAN is large in size and covers the area cities, countries and continents.

Question No: 22 ( Marks: 2)
Define the term Jitter.

The term Jitter is used for variance in transmission delays. Jitter is significance for
voice, video and data. Jitter can occur when a packet is delayed because the network is
busy.

Question No: 23 ( Marks: 3)
Give a comparison of wiring Schemes.
Thick Ethernet wiring scheme.

This uses thick coax cable. AUI cable or transceiver or drop cable connects from
NIC to transceiver. AUI cable carries digital signal from NIC to transceiver. The
transceiver generates analog signal on coax cable. The wires in AUI carry digital signals
power and other control signals. Thick Ethernet also requires terminators to avoid signal
reflectance.
Thin Ethernet wiring scheme.

Thin Ethernet uses thin coax cable that is cheaper and easier to install than thick
Ethernet coax. In thin ethernet wiring scheme transceiver electronics are built into
NIC and NIC connect directly to network medium. Coax cable use connector on
NIC. Coax runs directly to back of each connected computer by T-connector. The
T-connector directly attaches to NIC.

Question No: 24 ( Marks: 3)
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How can Switched Virtual Network be established?

Most networks offer dynamic connections that last for a relatively short time.
ATM can dynamically establish a switched virtual circuit SVC that allows it as long as
necessary and then terminate it. The computer sends a connection request to the switch to
which it is attached. Software in the switch finds a path to the destination and sends with
the connection request. Each pair of switches in the path communicates to choose a
VPI/VCI for their tables. Once the connection is established by the destination than a
message is given back to the originating computer to indicate the SVC is ready.

Question No: 25 ( Marks: 5)
Describe permanent virtual circuits (PVC).

ATM can provide the virtual circuits that look like traditional leased digital
circuits. The permanent virtual circuits PVC works as long as the customer pays the
periodic fee for its use. The forwarding table enter configured the terms used by Telco
Provisioning requires two steps. To determine a complete path.

To choose appropriate VPI/VCI for each step in the path and configures each adjacent
pair of switches.

Question No: 26 ( Marks: 5)
What are default routes, draw the table.

Routing table entries can collapse with a default route. If destination doesn’t have
in explicit routing table entry and then it use a default route. It is shown in the below
table.

Destination Next
hop

Destination Next
hop

Destination Next
hop

Destination Next
hop
1-2-13,1242
*1,34242324-
*233-%43
434

Node 1 Node 2 Node 3 Node 4

Question No: 19 ( Marks: 3)

Why 10-base T wiring scheme is called star shaped bus wiring scheme.

The main feature of twisted pair Ethernet is that it forms a classic star topology
however functions like a bus. 10Base-T Ethernet is often called a star shaped bus.

Question No: 20 ( Marks: 5)

What are the main factors due to which mechanism of error detections schemes differ?
Question No: 21 ( Marks: 10)

How much data can be present on an original Ethernet segment at one time? To find out,
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compute the delay-throughput product. The original Ethernet operate at 10 mega bits per
second, and a segment was limited to 500 meters. Assume the signals propagate down the
cable at 66 percent of the speed of light.\

One Ethernet cable is sometimes called a segment. This segment is limited to 500

meters in length. The minimum separation between connections is 3 meters.

Question No: 20 ( Marks: 5)

_Which type of information is obtained from network sniffer and in which mode
Network sniffer operates?

Solution:

A network analyzer also called network monitor or a network sniffer is used to
examine the performance of or debug a network. It can report statistics such as capacity
utilization, distribution of frame size, collision rate or token circulation time
Most installations still use DIX Ethernet encoding in which there is no LLC/SNAP
header in the frame. A network analyzer can tell from the values in the type field (small
values are lengths, which mean an LLC/SNAP header is located in the first octets of the
data area; large values are types, which mean no LLC/SNAP header is included).

The operation of network analyzer is a computer with a network interface that
receives all frames, which is called promiscuous mode. So many desktop computers have
interface that can be configured for promiscuous mode. When combined with software
computer can examine any frame on LAN. In this way the communication across LAN is
guaranteed to be private. Computer receives and displays frames on the LAN. Network
analyzer can be configured to filter and process frames. It can count frames of specific
type of size. It displays only frames from or to specific computers.

Question No: 21 ( Marks: 10)

Thick Ethernet, Thin Ethernet and Twisted pair Ethernet.
Solution:-
Thick Ethernet:

Thick Ethernet, officially known as 10 Base-5, is the oldest form of Ethernet.
One form of cabling supported by Ethernet is low-loss 50 Ohm coaxial cable as shown in
the figure below. This type of cable is 0.5" diameter (usually supplied with a yellow outer
PVC coating) and rather inflexible. It has become known in the communications industry
as "Thick Ethernet". The official name for this cable is 10 Baseband5 (10B5), indicating
that it is specified for baseband communications at 10 Mbps over distances up to 500m.
Thin Ethernet:

Thin Ethernet, officially called 10 Base-2, is a less expensive version of 10 Base-
5 (Thick Ethernet) technologies. It uses a lighter and thinner coaxial cable and dispenses
with the external transceivers used with 10 Base-5.
10 Base-2 uses an RG-58A/U coaxial cable and is wired in a bus topology. Each device
on the network is connected to the bus through a BNC "T" adapter, and each end of the
bus must have a 50 Ohm terminator attached. Each node on the bus must be a minimum
of 0.5 meters (1.5 feet) apart, and the overall length of the bus must be less than 185
meters (606 feet).

Twisted Pair Ethernet:
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Twisted Pair Ethernet (10baseT), sometime also called "UTP" from "Unshielded
Twisted Pair", is based on using a cable similar to phone-wiring. The cable is connected
via RJ-45 connectors to the network card installed in the PC.

Question No: 21  ( Marks: 2)

What is the difference between LAN and WAN?

Local area network (LAN)

LAN is small in size covers the area within a room, building or cities.
Wide area network (WAN)

WAN is large in size and covers the area cities, countries and continents.

Question No: 22  ( Marks: 2)

Define the term Jitter.

The term Jitter is used for variance in transmission delays. Jitter is significance for voice,
video and data. Jitter can occur when a packet is delayed because the network is busy.

Question No: 23  ( Marks: 3)

Glve a comparision of wiring Schemes.

Thick Ethernet wiring scheme.

This uses thick coax cable. AUI cable or transceiver or drop cable connects from NIC to
transceiver. AUI cable carries digital signal from NIC to transceiver. The transceiver
generates analog signal on coax cable. The wires in AUI carry digital signals power and
other control signals. Thick Ethernet also requires terminators to avoid signal reflectance.

Thin Ethernet wiring scheme.

Thin Ethernet uses thin coax cable that is cheaper and easier to install than thick Ethernet
coax. In thin ethernet wiring scheme transceiver electronics are built into NIC and NIC
connect directly to network medium. Coax cable use connector on NIC. Coax runs
directly to back of each connected computer by T-connector. The T-connector directly
attaches to NIC.

Question No: 24  ( Marks: 3)
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How can Switched Virtual Network be established?

Most networks offer dynamic connections that last for a relatively short time. ATM can
dynamically establish a switched virtual circuit SVC that allows it as long as necessary
and then terminate it. The computer sends a connection request to the switch to which it
is attached. Software in the switch finds a path to the destination and sends with the
connection request. Each pair of switches in the path communicates to choose a VPI/VCI
for their tables. Once the connection is established by the destination than a message is
given back to the originating computer to indicate the SVC is ready.

Question No: 25 (Marks: 5)

Describe permanent virtual circuits (PVC).

ATM can provide the virtual circuits that look like traditional leased digital circuits. The
permanent virtual circuits PVC works as long as the customer pays the periodic fee for its
use. The forwarding table enter configured the terms used by Telco Provisioning requires
two steps.

To determine a complete path.

To choose appropriate VPI/VCI for each step in the path and configures each adjacent
pair of switches.

Question No: 26  ( Marks: 5)

What are default routes, draw the table.

Routing table entries can collapse with a default route. If destination doesn’t have in
explicit routing table entry and then it use a default route. It is shown in the below table.

Destination | Next Destination | Next | Destination | Next | Destination | Next
hop hop hop hop
1 - 2 - 1 3,1 2 4.2
* 1,3 4 2,4 2 3,2 4 -
* 2,3 3 - * 4,3
4 3,4
Node 1 Node 2 Node 3 Node 4

Question No: 20 ( Marks: 5)

. Which type of information is obtained from network sniffer and in which mode Network
sniffer operates?
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Solution:

A network analyzer also called network monitor or a network sniffer is used to examine
the performance of or debug a network. It can report statistics such as capacity utilization,
distribution of frame size, collision rate or token circulation time

Most installations still use DIX Ethernet encoding in which there is no LLC/SNAP
header in the frame. A network analyzer can tell from the values in the type field (small
values are lengths, which mean an LLC/SNAP header is located in the first octets of the
data area; large values are types, which mean no LLC/SNAP header is included).

The operation of network analyzer is a computer with a network interface that receives all
frames, which is called promiscuous mode. So many desktop computers have interface
that can be configured for promiscuous mode. When combined with software computer
can examine any frame on LAN. In this way the communication across LAN is
guaranteed to be private. Computer receives and displays frames on the LAN.

Network analyzer can be configured to filter and process frames. It can count frames of
specific type of size. It displays only frames from or to specific computers.

Question No: 21 ( Marks: 10)

0D0000000000000000000000000000000000000OThick Ethernet,
Thin Ethernet and Twisted pair Ethernet.

Solution:-

Thick Ethernet:

Thick Ethernet, officially known as 10 Base-5, is the oldest form of Ethernet.

One form of cabling supported by Ethernet is low-loss 50 Ohm coaxial cable as shown in
the figure below. This type of cable is 0.5" diameter (usually supplied with a yellow outer
PVC coating) and rather inflexible. It has become known in the communications industry
as "Thick Ethernet". The official name for this cable is 10 Baseband5 (10B5), indicating
that it is specified for baseband communications at 10 Mbps over distances up to 500m.

Thin Ethernet:

Thin Ethernet, officially called 10 Base-2, is a less expensive version of 10 Base-5 (Thick
Ethernet) technologies. It uses a lighter and thinner coaxial cable and dispenses with the
external transceivers used with 10 Base-5.

10 Base-2 uses an RG-58A/U coaxial cable and is wired in a bus topology. Each device
on the network is connected to the bus through a BNC "T" adapter, and each end of the
bus must have a 50 Ohm terminator attached. Each node on the bus must be a minimum
of 0.5 meters (1.5 feet) apart, and the overall length of the bus must be less than 185
meters (606 feet).
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Twisted Pair Ethernet:

Twisted Pair Ethernet (10baseT), sometime also called "UTP" from "Unshielded Twisted
Pair", is based on using a cable similar to phone-wiring. The cable is connected via RJ-45
connectors to the network card installed in the PC.
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The protocol address of the next hop must be
packet can be sent.

Encrypted
Decrypted
Translated
Non of these

A address-binding table is used for each physical

network.

New
Similar
Separate
old

UDP provides connection-oriented service.

True
False

The UDP stands for

Universal Datagram Protocol
User Datagram Protocol
United Datagram Protocol
None of the given

In 3-way handshake TCP requires to generate a random

30 bit
32 bit
34 bit
none of the given

TCP stands for
Transport control protocol

Transmission control protocol
Terminal control protocol

to an equivalent hardware address before a

Best Project
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None of the given

As the Internet grew, the original Classful addressing scheme became a limitation. The IP address space was
being exhausted because all networks had to choose one of three possible sizes.

Select correct option:

True
False

Twice NAT allows a site to run servers.
Select correct option:

True
False

Preliminary version of IP was called
Select correct option:

IP - New Generation (IPng)
IP - Next Generation (IPng)
IP - Net Generation (IPng)
None of the given

uses window mechanism to control the flow of data.
Select correct option:

IP

UDP

IcpP

none of the given

The Internet service providers coordinate with the Internet assigned
number authority to obtain their network numbers.
Select correct option:

True
False

Which protocol is used to test different tools.
Select correct option:

ICMP

IGMP

TCP/IP

none of the given

identifies the application program that sent the data.
Select correct option:

Destination Port
Source port
Logical address
None of the given

The Source can configure outgoing datagram’s to avoid
Select correct option:

Best Project

VU MOBILE

Powered by SONO Group team
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Segmentation
Defragmentation

Fragmentation
None of the given

The time for acknowledgement to arrive depends on
Select correct option:

Distance to destination
Current traffic conditions
Both aand b

None of the given

Which is not the type of error messages defined by ICMP?
Select correct option:

Source quench

Time exceeded
Destination unreachable
None of the given

is used to attach two autonomous systems.
Select correct option

BGP Best Project
IGP

EGP
none of the given

Due to revolutionalization of IP-V6 the speed has increased from
Select correct option:

VU MOBILE

56kbps to 512kbps Powered by SONO Group team
512kbps to 1gbps
56kbps to 1gbps
none of the given

Whenever it handles a packet, IP software needs to separate the destination address into a prefix.
Select correct option:

True
False

TTL stands for
Select correct option:

Time to Learn
Time to Leave
Time to Live
none of the given

IGPs stand for
Select correct option:

Internal Gateway Protocols
Interior Gateway Protocols

VU Mobile | Powered by S®NO Group ™
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Intermediate Gateway Protocols
None of the given

identifies which application program on receiving computer should receive the data
Select correct option:

Logical address
Source port
Destination Port
None of the given

encapsulates IP datagram as data area in hardware frame.

Select correct option:

Network Interface Layer
Datalink Layer

Network Layer

None of the given

Class A mask is 255.0.0.0 which is used for
Select correct option:

Unicasting
Multicasting

Subnetting Best PrOjeCt

All of the given

NAT is not useful at a residence with Cable Modem or DSL connectivity.
Select correct option:

B VU MOBILE

Powered by SONO Group team
Autonomous System chooses a routing protocol to exchange routing

information which is passed before being summarized to another group.
Select correct option:

True
False

layer Provides reliable delivery of datagram.
Select correct option:

Network
Transport
Datalink

none of the given

The process of using a routing table to select a next hop for a given datagram is called
Select correct option:

Encapsulation
Reassembling

Routing or forwarding
None of the given
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The process of learning the path MTU is known as path MTU discovery.
Select correct option:

True
False

As the Internet grew, the original Classful addressing scheme became a limitation. The IP address space was
being exhausted because all networks had to choose one of possible sizes.
Select correct option:

three
two
four
five

End to End delivery Service of IP datagram is
Select correct option:

Connection oriented
Connectionless
both a and b

none of the given

EGP stands for .
Select correct option: Best PrOjeCt

Extension Gateway Protocol
Exterior Gateway Protocol
Explicit Gateway Protocol
none of the given

VU MOBILE

Powered by SONO Group team

Hashing is the transformation of a string of characters into a usually
shorter fixed-length value or a key that represents the original string.
Select correct option:

True
False

Although the ARP message format is sufficiently general to allow arbitrary protocol and hardware addresses.
ARP is almost always used to bind a 32-bit IP address to a Ethernet address.
Select correct option:

16-bit
48-bit
64-bit
128-bit

Reliability is not the responsibility of the Transport layer.
Select correct option:

True
False

IPV6 address with leading zeros is interpreted to hold an IPV4 address.
Select correct option:
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96

100

120

none of the given

NAT software does not allow a PCto connect with the Internet and act as a NAT device at the same time.
Select correct option:

True
False

TCP uses the term segment to refer to a
Select correct option:

packet

message
both (a) and (b)
None of the given

The Universal Datagram Protocol is a message-oriented protocol.
Select correct option:

True
False

Best Project

field tells the receiver how to order fragments within a
given datagram.
Select correct option:

FLAGS
FLAGMENT OFFSET

IDENTIFICATION VU MOBILE

None of the given Powered by SONO Group team

IP datagram can contains octets.
Select correct option:

0-65,535
1-65,535
1-65,536
none of the given

The amount of buffer space available at any time is called the window.
Select correct option:

True
False

Source is responsible for fragmentation.
Select correct option:

IPV4
IPV6
IPV3
IPV5
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Routers use to forward datagrams along prearranged path.
Select correct option:

Traffic class

Flow label
Destination address
none of the given

protocol uses three way handshake to begin a connection.
Select correct option:

UDP

Icp

P

none of the given

Typical internet routing uses uses a combination of two metrics
Select correct option:

routing metrics

administrative cost and routing metrics
hop cost

administrative cost and hop count

Network Address and Port Translation (NAPT) is by far the most popular BeSt PrOjeCt
form of
Select correct option:

Network Address Transmission
Network Address Translation
Network Address Transformation

None of the given VU MOB'LE

Powered by SONO Group team

The routers within an autonomous system use a to
exchange routing information.
Select correct option:

Interior Gateway protocols(IGPs)

Exterior Gateway protocol (EGPs)

Both Interior Gateway protocols (IGPs) and Exterior Gateway protocol (EGPSs)
None of the given

Interior Gateway Protocols (IGPs) and Exterior Gateway Protocols (EGPs) two broad classes of Internet
Routing Protocol.
Select correct option:

True
False

The Network Layer Protocol ICMP stands for
Select correct option:

Instant Control Message Protocol
Internet Control Message Protocol
Initial Control Message Protocol
None of the given
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The Current version of IP-Version 4 is old
Select correct option:

18 years

20 years
22 years

none of given

TCP is a connectionless and reliable transport protocol.
Select correct option:

True
False

ATM header is about the of the cell.
Select correct option:

15%

10%
20%
5%

Jitter is significance for
Select correct option:

Best Project

\oice
Video
Data
All of above

How many methods exist for building routing table?
Select correct option VU MOB' LE

Powered by SONO Group team

~rwlh e

The process of forwarding the packets of information is called routing. The routing table contains
information about the immediately around it
Select correct option:

Topology of the network
Destination

Both of the above

None of the above

Which of the following statement is true regarding ATM?
Select correct option:

Itis a single technology for voice, video and data

It has low jitter and high capacity

Ituses fixed sized small cells. 48 octet's data

All of the above

A can forward or block messages based on the information in the message itself
Select correct option
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Message digest
Proxy firewall
Packet filter firewall
Private Key

Transmission media are usually categorized as
Select correct option:

Guided or unguided

Fixed or unfixed

Determinate or indetemminate

Metallic or nonmetallic

Which of the following is not a guided medium?
Select correct option:

Twisted-pair cable
Fiber-optic cable

Atmosphere
Coaxial Cable

Which multiplexing technique transmits digital signals?
Select correct option:

WDM

FDM Best Project
DM

None of the above

All destinations on same switch have same
Select correct option:

Router VU MOBILE

Information Powered by SONO Group team

Next Hop
None of the above

Which of the following statement is true regarding Distance-Vector Routing?
Select correct option:

Itis very simple to implement.

Packet switch updates its own routing table first
Itis used in RIP.

All of the above

An exterior switch is one with which
Select correct option:

Computers are attached
No computer is attachede

Hubs are attached externally
None of the above

Frame relay is
Select correct option:

Connection oriented service
Connectionless service
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Itis typicallyranges from 5Mbps to 1000Mbps.
None of the above

An interior switch is one with which
Select correct option:

Computers are attached

No computer is attached
Computers are attached internally
None of the above

Which of the following is not a benefit of source independence?
Select correct option:

Itallows fast and efficient routing.

Packet switch do not need to have complete information about all destinations
Network functions even if topology changes

None of the above

Which of the following statement regarding ATM is true?
Select correct option:

Connections in ATM are called virtual channels
The VC is identified by a 24-bit value formed from the VPI

Both (a) and (b) Best PrOjeCt

None of the above

How many methods exist for computing routing table ?
Select correct option:

VU MOBILE

Powered by SONO Group team

N w s o

Which of the following statement is true regarding Distance-vector routing?
Select correct option:

Itis very simple to implement.

Packet switch updates its own routing table first.
Itis used in RIP.

All of the above

Which one of the following is a property of static routing?
Select correct option:

Itis inflexible

Itis done at boottime

It has low network overload
All of the above

Asynchronous Transfer Mode uses the concept of -------------------- .
Select correct option:

Connection-less networking
Connection-oriented networking
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Which multiplexing technique shifts each signal to a different carrier frequency?
Select correct option:

TDM

_BbM

Both aand b
None of the above

LAN networks can not be extended to very large networks because of the limitations of ...........
Select correct option:

Area
Distance
Routers
Technology

Which of the following statement is wrong regarding ATM?
Select correct option:

Itis a single technology for voice, video and data
It has low jitter and high capacity.

It uses fixed size, small cells, and 48 octet’s data
None of the above

Which one of the following is the responsibility of Djikstra’ algorithm? Best project

Select correct option:

To compute the shortest path between two nodes
To extract next hop information from path information
To insert next hop information into routing table

All of the above

VU MOBILE

Which one of the following is a property of dynamic routing? Powered by SONO Group team
Select correct option:

Itis inflexible

It has low network overload

It can work around network failure
All of the above

Which of the following statement is true regarding ATM?
Select correct option:

ATM is a single technology that is designed to meet the goals of both LANs and WANSs.
ATM uses the concept of connection-oriented networking.

Both (a) and (b)

None of the above

Source independence is a phenomena in which next hop to destination does not depend on the

Select correct option:

Source of packet
Destination of packet
No of hops

Source of protocol
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If a computer on the network shares resources for others to use, it is called

a. Server

b. Client

¢. Mainframe
Answer: a

2. Terminators are used in topology.

a.Bus
b. Star
Answer: a

3.In_____ topology, if a computer’s network cable is broken, whole network goes down.

a.Bus
b. Star
Answer: a

4. For large networks, topology is used.

a.Bus
b. Star
c. Ring

Answer: b Best Pl'OjeCt

5.1SO stands for

a. International Standard Organization
b. International Student Organization
c. Integrated Services Organization

Answer: a VU MOB'LE

Powered by SONO Group team

6.1SO OSImodelis usedin

a. Stand alone PC
b. Network environment
Answer: b

7. Network cable lies on layer

a. Application
b. Network

c. Physical

Answer: c

8. Layer decides which physical pathway the data should take.
a. Application

b. Network

c. Physical

Answer: c

9.ISDN is an example of network

VU Mobile | Powered by S®NO Group ™
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a. Circuit switched
b. Packet switched
Answer: a

10. X.25 is an example of network

a. Circuit switched
b. Packet switched
Answer:b

11. allows LAN users to share computer programs and data.

a. Communication server
b. Print server

c. Hle server

Answer: c

12. Print server uses which is a buffer that holds data before it is send to the printer.

a. Queue

b. Spool
c. Node

Answer: b

13. A standalone program that has been modified to work on a LAN by Best Project
including concurrency controls such as file and record locking is an
example of

a LANintrinsic software
b. LAN aware software
c. Groupware

d. LAN ignorant software VU MOBILE

Answer: a Powered by SONO Group team
14. The portion of LAN management software restricts access, records user activities and audit data
etc.

a. Configuration management
b. Security management

c. Performance management
Answer : b

15. What is the max cable length of STP?

a. 100 ft
b. 200 ft
c.100 m
d.200m
Answer :d

16. What is the max data capacity of STP?

a. 10 mbps

b.100 mbps
c. 1000 mbps

d. 10000 mbps
Answer: b

VU Mobile | Powered by S®NO Group ™
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17. Which connector STP uses?

a.BNC
b.RJ-11
c.RJ-45
d. RJ-69
Answer : C

18. What is the central device in star topology?

a. STP server
b. Hub/switch
c.PDC

d. Router
Answer : b

19. What is max data capacity for optical fiber cable?

a. 10 mbps

b. 100 mbps
€. 1000 mbps
d. 10000 mbps
Answer : c

In Direct point to point communication adding the Nth computer
requires----------- new connections.

» None of the given
» N2

> N-1

» (N2 —N)/2

In Point-to-Point topology there are two topologies.

» Tree and Ring
» Star and Ring
» Star and Tree
» None of the given

IN ----mmmmmeeem , hetwork occupies the smaller area like aroom a floor or a building

» WAN
> MAN
» None of the given

Hardware that calculates a CRC uses two simple components.

» AND unitand XOR unit

» Shift register and XOR unit
» Shift register and AND unit
» none of the given

The Gigabit Ethernet hardware operates at a rate of --------

» 10 Mbps

Best Project

VU MOBILE

Powered by SONO Group team
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» 100 Mbps

» 1000 Mbps
» None of the given

formally named informally known as the twisted pair Ethernet or TP Ethernet.

» 10 Base 2
» 10 Base 5
» 10 Base T
» none of the given

An interface for thin Ethernet must have an connector , and must generate signals according
to the specification.

» RJ-45,10Base T
» RJ-45,10 Base 5
» BNC, 10 Base 2
» BNC,10Base T

A system with redundant bridges might have a problem with in the system.

» Loop
» Filters

» Spanning Trees
» Al given choices Best Pl'OjeCt

computes shortest paths in a graph by using weights on edges
as a measure of distance.

» Greedy algorithm
» Distance vector algorithm

> Dijksta’s algorithm VU MOBILE
» none of the given Powered by SONO Group team

Basic LANtechnologies such as Ethernet, Token Ring, and FDDI use a

» Connectionless service paradigm

» Connection-oriented service paradigm

» Both Connectionless and Connection-oriented service paradigm
» None of the given

protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer

» Network Interface Layer
» Internet Layer

» Transport Layer

An Internet Address (IP address) is a unique binary number assigned to a host and used for all
communication with host

» 48-bit
» 32-bit
» 24-bit
» None of the given

the address identifies the physical network to which the computer is attached, while the

VU Mobile | Powered by S®NO Group ™
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identifies an individual computer on that network.

» Prefix, suffix

» suffix, prefix

» suffix, suffix

» none of the given

places the boundary between the first and second octets

» Class A
» Class B
» Class C
» Class D

places the boundary between the third and fourth octets.

» Class A
» Class B
» Class C
» Class D

field of header indicates whether a datagram is a fragment or a complete datagram.

> FLAGS Best Project
> FLAGMENT OFFSET

» IDENTIFICATION
» None of the given

provides connectionless service.

> TCP VU MOBILE

» UDP Powered by SONO Group team
» IP

» none of the given

UDP and TCP are both layer protocols

» Physical
» Data link
» Network

» Transport

Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection start-up and Graceful connection shutdown are the services provided

by

» IP

» None of the given
» TCP

» UDP

protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer

» Network Interface Layer
» Internet Layer

VU Mobile | Powered by S®NO Group ™

© All Rights Reserved S@GNO Group ™ 2012



CS610 SOLVED FINAL TERM MCQs - Compiled by _SONO_(* *) @

www.vukamoke.blogspot.com / www.vumobile.blogspot.com
File Version 2.0.1

» Transport Layer

identifies which application program on receiving computer should receive the data

» Logical address
» Source port

» Destination Port
» None of the given

identifies the application program that sent the data.

» Destination Port

» Source port
» Logical address

» None of the given

The Border Gateway Protocol (BGP) uses for all communication
» UDP

» TCP

» Both UDP and TCP

» none of the given

uses distance vector approach to define routing

Best Project

» BGP

» OSPF

» RIP

» None of the given

ICMP message transport is acted upon by getting ICMP encrypted in IP.

VU MOBILE

» True Powered by SONO Group team
» False

Protocol addresses are abstractions provided by

» hardware

» software

» operating system
» internet

These packets serve same purpose on as frames on

» Intranet, LAN
» Internet, WAN
» Intranet, WAN
» Internet, LAN

Address mask defines how many bits of address are in suffix?

» True
» False

a single networking technology is best for all needs.

» True
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» False

A computer attached to a given network can only communicate with other computers attached to the same
network. Is this a problem with multiple networks?

» True
» False

The term self-identifying is used for Classful IP addresses because the class of the address can be
computed from the address

» ltself
» prefix
» suffix
» mask

Find the class of the address.
10100111 11011011 10001011 01101111

> A
>B
> E
»C

Find the class of the address: Best PrOjeCt
11110011 10011011 11111011 00001111

> A

» C

> E

a VU MOBILE

In which method of Address Resolution Protocol the protocol address is Powered by SONO Group team

determined by hardware address? Were "T" stands for Table lookup, "C"
for Closed-form Computation and " D" for Data Exchange?

>T
» D
>C
»T,C

Which method of Address Resolution Protocol requires hardware broadcast?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

»>D
> T
»C
> T,D

Which method of Address Resolution Protocol resolution with minimum delay?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

» T,D
> c
> T
»T.C
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In which method of Address Resolution Protocol the implimentation is more difficult?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T,C
> T
> C
>D

On of the design goals for unicast route propagation is

» Consistency
» inconsistency

» stability
» dynamic addressing

Propagation multicast routing information differs dramatically from unicast route propagation?

» True
» False

To save traffic, an EGP does not summarize routing information from the autonomous system before
passing it to another autonomous system.

» True
L Best Project

In IPv6 the type of address used for collection of computers with same
prefix. Are known as

» Anycast

» Unicast

» Multicast VU MOB'LE

» Non of the given Powered by SONO Group team

Special types of addresses in IPv6 used for multiple destinations; possibly not same site. Are known
as

» Unicast

» Anycast

» Multicast

» none of the given

UDP offers application programs a Message-Oriented Interface, applications can depend on protocol to
preserve data boundaries.

» True
» False

Reliability is the responsibility of the layer

» Network
» Data link
» Transport
» Application

TCP uses mechanism to control the flow of data.
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» door

» window

» acknowledgment
» retransmission

In Direct point to point communication adding the Nth computer requires ------------ new connections.

» None of the given
> N2

> N-1

» (N2 —-N)/2

In Point-to-Point topology there are two topologies.

» Tree and Ring
» Star and Ring
» Star and Tree
» None of the given

In ----m-mmmee- , hetwork occupies the smaller area like aroom a floor or a building

> LAN

> WAN

» MAN

» None of the given Best Pl'OjeCt

Hardware that calculates a CRC uses two simple components.

» AND unit and XOR unit
» Shift register and XOR unit
» Shift register and ANDunit

» none of the given VU MOB'LE

Powered by SONO Group team

The Gigabit Ethernet hardware operates at a rate of --------

» 10 Mbps
» 100 Mbps

» 1000 Mbps
» None of the given

formally named informally known as the twisted pair Ethernet or TP Ethernet.

» 10 Base 2
» 10 Base 5
» 10 Base T
» none of the given

An interface for thin Ethernet must have an connector , and must generate signals according
to the specification.

» RJ-45,10Base T
» RJ-45,10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T

A system with redundant bridges might have a problem with in the system.
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» Loop
» Filters

» Spanning Trees
» All given choices

computes shortest paths in a graph by using weights on edges as a measure of distance.

» Greedy algorithm
» Distance vector algorithm

» Dijksta’s algorithm
» none of the given

Basic LANtechnologies such as Ethernet, Token Ring, and FDDI use a

» Connectionless service paradigm

» Connection-oriented service paradigm

» Both Connectionless and Connection-oriented service paradigm
» none of the given

protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer
» Network Interface Layer
» Internet Layer

» Transport Layer Best Pl'OjeCt

An Internet Address (IP address) is a unique _ binary number
assigned to a host and used for all communication with host

» 48-bit

» 32-bit

> 24-bit VU MOBILE

» None of the given Powered by SONO Group team
The address identifies the physical network to which the computer is attached, while the

identifies an individual computer on that network.

» prefix, suffix

» suffix , prefix

» suffix, suffix

» None of the given

places the boundary between the first and second octets

» Class A
» Class B
» Class C
» Class D

places the boundary between the third and fourth octets.

» Class A
» Class B
» Class C
» Class D
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field of header indicates whether a datagram is a fragment or a complete datagram.

» FLAGS

» FLAGMENT OFFSET
» IDENTIFICATION

» None of the given

provides connectionless service.

» TCP

» UDP

» IP

» none of the given

UDP and TCP are both layer protocols

» Physical
» Data link
» Network

» Transport

Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided

by,

Best Project

> IP

» None of the given
» TCP

» UDP

protocols of TCP/IP layering model specify how to ensure
reliable transfer. VU MOB'LE

Powered by SONO Group team
» Physical Layer
» Network Interface Layer
» Internet Layer
» Transport Layer

identifies which application program on receiving computer should receive the data

» Logical address
» Source port

» Destination Port
» None of the given

identifies the application program that sent the data.

» Destination Port

» Source port
» Logical address
» None of the given

The Border Gateway Protocol (BGP) uses for all communication

» UDP
» TCP
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» Both UDP and TCP
» None of the given

uses distance vector approach to define routing

» BGP

» OSPF

» RIP

» None of the given

ICMP message transport is acted upon by getting ICMP encrypted in IP.

» True
» False

Protocol addresses are abstractions provided by

» hardware

» software

» operating system
» internet

These packets serve same purpose on as frames on

» Intranet, LAN Best PrOjeCt
» Internet, WAN

» Intranet, WAN
» Internet, LAN

Address mask defines how many bits of address are in suffix?

» True VU MOB'LE

» False Powered by SONO Group team

A single networking technology is best for all needs.

» True
» False

A computer attached to a given network can only communicate with other computers attached to the same
network. Is this a problem with multiple networks?

» True
» False

The term self-identifying is used for Classful IP addresses because the class of the address can be
computed from the address

» ltself
» prefix
» suffix
» mask

Find the class of the address.
10100111 11011011 10001011 01101111
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> B
> E
»C

Find the class of the address:
11110011 10011011 11111011 00001111

> A
»C
> E
> B

In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T
» D
»>C
> T,C

Which method of Address Resolution Protocol requires hardware broadcast?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

» D
> T Best Project
» C

» T,D

Which method of Address Resolution Protocol resolution with minimum
delay? Were "T" stands for Table lookup, " C" for Closed-form
Computation and "D" for Data Exchange?

VU MOBILE

> T,D Powered by SONO Group team

> c
> T
>T.C

In which method of Address Resolution Protocol the implementation is more difficult?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T,C
> T
»C
»>D

On of the design goals for unicast route propagation is

» Consistency
» inconsistency

» stability
» dynamic addressing

Propagation multicast routing information differs dramatically from unicast route propagation?

» True
» False
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to save traffic an EGP does not summarize routing information from the autonomous system before passing
it to another autonomous system.

» True
» False

In IPv6 the type of address used for collection of computers with same prefix. Are known as

» Anycast

» Unicast

» Multicast

» none of the given

Special types of addresses in IPv6 used for multiple destinations; possibly not at same site.

» Unicast

» Anycast

» Multicast

» none of the given

UDP offers application programs a Message-Oriented Interface, applications can depend on protocol to
preserve data boundaries.

» True

> False Best PrOjeCt

Reliability is the responsibility of the layer

» Network
» Data link

Transpor
:Applicatiotn VU MOB'LE

Powered by SONO Group team

TCP uses mechanism to control the flow of data.

» Door

» window

» acknowledgment
» retransmission

the time for acknowledgement to arrival of packet depends on.

» Distance to destination and Current traffic conditions
» Current traffic conditions

» Distance to destination

» non of these

FDDI can transmits data at a rate of ----------

» 100 million bits per second
» 10 million bits persecond

» 1000 million bits persecond
» None of the given

the time for acknowledgement to arrival of packet depends on.

» Distance to destination and Current traffic conditions
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» Current traffic conditions
» Distance to destination
» non of these

Question # 1 of 10 ( Starttime: 11:14:05 PM) Total Marks: 1
---------- is also called self healing network
www.vukamoke.blogspot.com

Select correct option:

ATM

FDDI (Correct)
Token Ring
None of the given

Question # 2 of 10 ( Starttime: 11:15:34 PM) Total Marks: 1
Most LANs that employ ring topology use an access mechanism known as -------
Select correct option:

CSMA/CD

CSMAICA

CSMA

TOKEN PASSING (Correct)

Question # 3 of 10 ( Starttime: 11:16:55 PM) Total Marks: 1
Y method, the network hardware designers specify how type BeSt PrOjeCt
information is included in the frame and the value use to identify various
frame types. www.vumobile.blogs pot.com

Select correct option:

Explicit frame type (Correct)
Ideal frame type

Implicit frame type VU MOB'LE

None of the given Powered by SONO Group team

Question # 4 of 10 ( Starttime: 11:17:47 PM) Total Marks: 1
Hardware that calculates a CRC uses two simple components.
Select correct option:

AND unit and XOR unit

Shift register and XOR unit (Correct)
Shift register & AND unit

Shift register and shift XOR unit

Question # 5 of 10 ( Starttime: 11:18:59 PM) Total Marks: 1
The Ethernet standard specifies that frames are sent using the --------
Select correct option:

Differential Manchester

Not Return to Zero (NRZ)
Manchester Encoding (Correct)
Return to Zero (RZ)

Question # 6 of 10 ( Starttime: 11:20:08 PM) Total Marks: 1
When an application ------------ data, it makes a copy of the data available to all other computers on the

network.
Select correct option:
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Broadcasting (Correct)
Multicasting

Unicasting

None of the given

Question # 7 of 10 ( Starttime: 11:21:26 PM) Total Marks: 1
LANinterface may use ---------- to copy frame data directly from main memory.
Select correct option:

DMA (Correct)
FDDI

CSMA/CD
None of the given

Question # 8 of 10 ( Starttime: 11:22:19 PM) Total Marks: 1
LAN and WAN are classified according to their.........
Select correct option:

Size (Correct)
Connectivity
Medium

Mobility

Question # 9 of 10 ( Starttime: 11:23:43 PM) Total Marks: 1
For how much time would other computers be in wait while one BeSt PrOjeCt
computer was transferring 56MB file with transmission speed of 56Kbps
Select correct option:

10 Sec
11 Sec
12 Sec

13 Sec VU MOBILE

Powered by SONO Group team

Question # 10 of 10 ( Starttime: 11:25:05 PM) Total Marks: 1
A network uses to arrange computers to be connected in a single closed loop.
Select correct option:

Star Topology

Dual Ring Topology

Ring Topology (Correct)
Bus Topology

Question # 1 of 10 ( Starttime: 05:19:30 PM) Total Marks: 1
Which one of the following is a method for computing routing table information?
Select correct option:

Manual entry

Static routing (Correct)
Boottime routing

None of the above

Question # 2 of 10 ( Starttime: 05:20:20 PM) Total Marks: 1
Thin Ethernet is known as-------------
Select correct option:

10Base?2 (Correct)
10Base5

10BaseT

All of above
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Question # 3 of 10 ( Starttime: 05:21:03 PM) Total Marks: 1
Which multiplexing technique shifts each signal to a different carrier frequency?

Select correct option:

TDM

FDM (Correct)
Bothaandb

None of the above

Question # 4 of 10 ( Starttime: 05:22:03 PM) Total Marks: 1
The basic responsibility of NIC is ----------------
Select correct option:

To access medium/network
To resource allocation

To access memory

All of above (Correct)

Question # 5 of 10 ( Starttime: 05:23:23 PM) Total Marks: 1
How many methods exist for building routing table?
Select correct option:

N -

(Correct)

Hw

Question # 6 of 10 ( Starttime: 05:24:07 PM) Total Marks: 1 v
Best Project

The process of forwarding the packets of information is called..........
Select correct option:

Routing (Correct)
Switching
Communication
None of the above

VU MOBILE

Powered by SONO Group team

Question # 7 of 10 ( Starttime: 05:24:48 PM) Total Marks: 1
The term signaling is used to describe------------ Select correct option:

Communication about the internet (Correct)
Communication about the extranet
Communication about the network

None of above

Question # 8 of 10 ( Starttime: 05:26:17 PM) Total Marks: 1
Which of the following statement is true regarding ATM?
Select correct option:

Itis a single technology for voice, video and data
It has low jitter and high capacity.

It uses fixed size, small cells, 48 octet’'s data

All of the above (Correct)

Question # 9 of 10 ( Starttime: 05:27:02 PM) Total Marks: 1
An interior switch is one with which ......................
Select correct option:

Computers are attached
No computer is attached (Correct)

Computers are attached internally
None of the above

Question # 10 of 10 ( Starttime: 05:28:12 PM) Total Marks: 1
Network interface card acts like a (an) -----------
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Select correct option:

Input/output device
Input device

Output device

All of above (Correct)

Question # 1 of 10 ( Starttime: 03:47:55 PM) Total Marks: 1
The Network Layer Protocol ICMP stands for
Select correct option:

Instant Control Message Protocol (Correct)
Internet Control Message Protocol

Initial Control Message Protocol

None of the given

Question # 2 of 10 ( Starttime: 03:48:51 PM) Total Marks: 1
Due to revolutionalization of IP-V6 the speed has increased from
Select correct option:

56kbps to 512kbps
512kbps to 1gbps

56kbps to 1gbps (Correct)
none of the given

Question # 3 of 10 ( Starttime: 03:50:18 PM) Total Marks: 1
An Internet Address (IP address) is a unique _ binary number
assigned to a host and used for all communication with host

Select correct option: Best PrOjeCt

48-bit

32-bit (Correct)
24-bit

None of the given

Question # 4 of 10 ( Starttime: 03:51:50 PM) Total Marks: 1
Protocol provides error reporting mechanism. VU MOB“—E
Select correct option: Powered by SONO Group team

IGMP
SNMP
ICMP (Correct)

none of the given

IPV6 addresses are bits.
Select correct option:

32
64

128 (Correct)
256

Question # 6 of 10 ( Starttime: 03:53:54 PM) Total Marks: 1
A address-binding table is used for each physical network.
Select correct option:

new
similar

separate (Correct)
old

Question # 7 of 10 ( Starttime: 03:54:21 PM) Total Marks: 1
identifies the application program that sent the data.
Select correct option:
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Destination Port
Source port (Correct)
Logical address

None of the given

Question # 8 of 10 ( Starttime: 03:55:00 PM) Total Marks: 1
TCP/IP defines the term to refer any computer system that connects to an internet and runs
applications Select correct option:

Router

Host computer (Correct)
Bridge

None of the given

Question # 9 of 10 ( Starttime: 03:56:31 PM) Total Marks: 1
The Universal Datagram Protocol is not an end-to-end protocol.
Select correct option:

True (Correct)

False

Question # 10 of 10 ( Starttime: 03:57:48 PM) Total Marks: 1
In routing, the table is initialized when system boots and there is no further changes.
Select correct option:

Dynamic
Static ’
Both (a) and (b) (Correct) Best PrOjeCt

None of the given

VU MOBILE

Powered by SONO Group team
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CS610- Computer Network
\le[ Solve(E)MCQS June 23,2012
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MC100401285 Moaaz.pk@gmail.com Mc100401285@vu.edu.pk, PSMDO1

CS610- Computer Network
FINALTERM EXAMINATION - Spring 2010

Question No: 1(Marks:1)
A e Relies on the hardware manufacturer to assign a unique physical address to each network interface.

» Static addressing scheme  (Page 34)
» Configurable addressing scheme

» Dynamic addressing scheme

» None of the given

QuestionNo:2 (Marks:1)
An interface for thin Ethernet must have an connector, and must enerate signals according to
the specification.

» RJ-45, 10 Base T
» RJ-45, 10 Base 5
» BNC, 10 Base 2 (CS610 Reference Book , Page 21)
» BNC, 10 Base T

Question No: 3(Marks:1)

A system with redundant bridges might have a problem with in the system.
» Loop Click here for detail
» Filters

» Spanning Trees
» All given choices

Question No: 4(Marks: 1)

A Bridge can

» Filter a frame

» Forward a frame

» Extend a LAN

» Do all the Click here for detail

Muhammad Moaaz Siddiq MCS (3rd)
nic100401285@Gmail.com

Campus:- Institute of E-Learning & Modern Studies
(IEMS) Samundari
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Question No: 5(Marks: 1)
is used for typical data applications (where the data rate may be unknown and bursty) and allows use
of whatever bandwidth is available at a given time.
» Constant Bit Rate (CBR) service
» Variable Bit Rate (VBR) service
> Available Bit Rate (ABR) service (Page 71)
» None of the given

Question No: 6(Marks:1)

ATM assigns each VC a identifier that is divided two parts to produce a hierarchy.
» 21-bit

» 22-bit

» 23-bit

» 24-bit  (Page 67)

Question No: 7(Marks: 1)
of TCP/IP layering model, corresponds to basic network hardware.

» Physical Layer (Page 84)
» Network Interface Layer

» Internet Layer

» Transport Layer

Question No: 8(Marks: 1)
places the boundary between the second and third octets

» Class A
» Class B (Computer Networks and Internets, page235)
» Class C
» Class D

Question No: 9(Marks:1)
UDP and TCP are both layer protocols

» Physical
» Data link
» Network
» Transport (Page 101)

Question No: 10(Marks: 1)
Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided

by

Muhammad Moaaz Siddiq MCS (3rd)
401285@Gmail.com

Campus:- Institute of E-Learning & Modern Studies
(IEMS) Samundari
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> IP

» None of the given
» TCP (Page 123)
» UDP

Question No: 11(Marks: 1)
protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer (Page 84)

Question No: 12(Marks: 1)
identifies which application program on receiving computer should receive the data

» Logical address

» Source port

» Destination Port (Computer Networks and Internets, page313)
» None of the given

Question No: 13(Marks:1)
identifies the application program that sent the data.

» Destination Port

» Source port  (Computer Networks and Internets, page313)
» Logical address

» None of the given

Question No: 14(Marks: 1)
Which of the following are interior routing protocols?

» RIP

» OSPF

» BGP

» RIP and OSPF Click here for detail

Question No: 15(Marks: 1)
The Border Gateway Protocol (BGP) uses for all communication

» UDP

» TCP Click here for detail
» Both UDP and TCP

» None of the given

Muhammad Moaaz Siddiq MCS (3rd)
401285@Gmail.com

Campus:- Institute of E-Learning & Modern Studies
(IEMS) Samundari



http://www.freesoft.org/CIE/Topics/119.htm
http://patents.corporationwiki.com/patents/system-for-highly-available-border-gateway-protoco/07499394/

Question No: 16(Marks: 1)
measures distance in network hops, where each network between the source and destination counts
as single hop.

» BGP

» OSPF

» RIP  (Page 138)
» None of the given

Question No: 17(Marks: 1)
OSPF is based on

» Distance vector routing

» Link state routing  (Page 140)

» Path vector routing

» Distance vector routing and Link state routing

Question No: 18(Marks: 1)
performs local multicast and uses IP-in-IP encapsulation to send multicast datagrams from one site
on the Internet to another.

» Distance Vector Multicast Routing Protocol (DVMRP) (Page 144)
» Core Based Trees (CBT)

» Protocol Independent Multicast_ Sparse Mode (PIM-SM)

» Protocol Independent Multicast _ Dense Mode (PIM-DM)

Question No: 19(Marks: 1)
The length of time required to send a variable length packet is variable and does not require a complicated
interrupt scheme to detect completion of transmission.

» True
> False (Page 72)

Question No: 20(Marks: 1)
NEXT HEADER field in the base header defines type of header and it appears at end of fixed-size base header.

» True (Page 112)
» False

Question No: 21(Marks: 1)
Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly
inefficient.

» True (Page99)
> False
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Question No: 22(Marks: 1)
Address mask defines how many bits of address are in suffix.

» True
> False (Page 103)

Question No: 23(Marks: 1)

A computer attached to a given network can only communicate with other computers attached to the same
network. Is this a problem with multiple networks?

» True (Page 81)

» False

Question No: 24(Marks: 1)

In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed
island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens,
keyboards and computers.

» False
» True (Page8l)

Question No: 25(Marks: 1)

The term self-identifying is used for Classful IP addresses because the class of the address can be computed
from the address :

» itself (Page 87)

» prefix

» suffix

» mask

Question No: 26(Marks: 1)
In which method of Address Resolution Protocol the protocol address independent of hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T,C

» D

» C

» T,D (Page97)

Question No: 27(Marks: 1)

In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T

» D

» C (Page 97)

> T,C
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Question No: 28( Marks: 1)
Reconstruction of original datagram is called reassembly.

» True (Page 28)
» False

Question No: 29(Marks: 1)

A computer needs a complete stack of protocols to run either a client or a server.

» True (Computer Networks and Internets, page 344)
» False

Question No: 30(Marks: 1)
TCP uses mechanism to control the flow of data.

» door

» window (Page 126)
» acknowledgment

P retransmission

FINALTERM EXAMINATION
Spring 2010
CS610- Data Communication

Question No: 1 ( Marks: 1) - Please choose one

In Direct point to point communication adding the Nth computer requires----------

> Ngne of the given
>N

»N-1 (Page 23)
> (N2 -N)/2

Question No: 2 ( Marks: 1) - Please choose one

In ---=----—---- , hetwork occupies the smaller area like a room a floor or a building

»LAN (Page4)
> WAN
» MAN
» None of the given

new connections.
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Question No: 3 ( Marks: 1) - Please choose one
The third field of the header consists of ------ bit Ethernet frame type.

» 48

» 32

» 16 Click here for detall
»8

Question No: 4 ( Marks: 1) - Please choose one
The maximum size of an Ethernet segment is

» 250 meters
» 500 meters Click here for detail
» 700 meters

» None of the given
Question No: 5 ( Marks: 1) - Please choose one
The network with Throughput T and Delay D has a total --------------- bits in transit at a time.
»D+T
»D-T
» DXT (Computer Networks and Internets, page203)
»D/T

Question No: 6 ( Marks: 1) - Please choose one
places the boundary between the first and second octets

» Class A (Computer Networks and Internets, page235)
» Class B
» Class C
» Class D

Question No: 7 ( Marks: 1) - Please choose one

Router detects datagram --------- than network MTU and then it splits into pieces and each piece is --------

outbound network MTU.

» Larger, smaller (Page 108)
» Larger, larger

» Smaller, larger

» Smaller, smaller

Question No: 9 ( Marks: 1) - Please choose one
Connectionless service, Message-Oriented protocol, best-effort delivery service, arbitrary interaction &
operating system independent are the characteristics of
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»TCP

»UDP (Page 120)
> IP

» None of the given

Question No: 10 ( Marks: 1) - Please choose one
----------- provide Application to application communication it also called end to end communication

> IP

»TP (Page 119)
> RIP

» None of the given

Question No: 11 ( Marks: 1) - Please choose one
A routing table contains

» The destination network 1D

» The hop count to reach the network

» The router ID of the next hop (Page 102)
» All of the given

Question No: 12 ( Marks: 1) - Please choose one
Which of the following protocols allows the sender and receiver to enforce polices.

»RIP

» OSPF

»BGP (Reference Book 347)
» RIP and OSPF

Question No: 13 ( Marks: 1) - Please choose one
measures distance in network hops, where each network between the source and destination counts
as single hop.

» BGP

» OSPF

»RIP  (Page 138)
» Non of these

Question No: 14 ( Marks: 1) - Please choose one
includes a 32-bits address mask with each address, which allows the address to be classful, classless,
or subnetted.
» RIP
» OSPF (Page 140)
» BGP
» None of the given
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Question No: 15 ( Marks: 1) - Please choose one
One repeater --------------- , two repeaters --------------- the maximum cable length limitation.

» Double, triple (Page 49)
» Double, 4 time

» half, triple

» Double, half

Question No: 16 ( Marks: 1) - Please choose one
ICMP message transport is acted upon by getting ICMP encrypted in IP.

»True (Page 117)
» False

Question No: 17 ( Marks: 1) - Please choose one

Like most application programs, a client and server use a transport protocol to communicate.
> True (Page 146)
» False

Question No: 18 ( Marks: 1) - Please choose one
Mapping between a protocol address and a hardware address is called Address Resolution.

»True (Page 93)
» False

Question No: 19 ( Marks: 1) - Please choose one
Address mask defines how many bits of address are in suffix?

» True
» False (Page 103)

Question No: 20 ( Marks: 1) - Please choose one
A single networking technology is best for all needs.
» True
> False (Page 81)

Question No: 21 ( Marks: 1) - Please choose one

In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed
island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens,
keyboards and computers.

» False
»True (Page8l) rep
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Question No: 22 ( Marks: 1) - Please choose one

Router detects datagram--------- than network MTU
» Larger  (Page 108) rep
» Smaller
» None of given
» Equal

Question No: 23 ( Marks: 1) - Please choose one
Information can flow in either or both direction between
» Clients
» Clients and servers (Computer Networks and Internets, page 344)
» Servers
» None of given

Question No: 24 ( Marks: 1) - Please choose one
On of the design goals for unicast route propagation is

P consistency

P inconsistency

» stability (Computer Networks and Internets, page 344)
» dynamic addressing

Question No: 25 ( Marks: 1) - Please choose one
IPV6 address consists of

» 32 Bits

» 64 Bits

» 128 Bits (Page 128)
» none of the given

Question No: 26 ( Marks: 1) - Please choose one
UDP offers application programs a Message-Oriented Interface, applications can depend on protocol to
preserve data boundaries.

» True (Page 120)
» False

Question No: 27 ( Marks: 1) - Please choose one
In case TCP, retransmission, acknowledgment from a computer on LAN are expected to arrive within

» Seconds

» Micro seconds

» Milliseconds Click here for detail
» Nanoseconds
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Question No: 28 ( Marks: 1) - Please choose one

Twice NAT is another variant of NAT. it is used with site that runs server. In this process NAT box is

connected to Domain Name.

» True (Page 131)
» False

Question No: 29 ( Marks: 1) - Please choose one

A network uses a ------ arranges for computers to be connected in a closed loop.

» Star Topology

» Ring Topology (Page 25)
» Bus Topology

» None of the given

Question No: 30 ( Marks: 1) - Please choose one
Protocol addresses are abstractions provided by

» hardware
»software (Page 93)
P operating system

» internet

FINALTERM EXAMINATION
Fall 2008
CS610- Computer Network

Question No: 1 ( Marks: 1) - Please choose one

In Direct point to point communication adding the Nth computer requires----------

» None of the given

» N2
» N-1 (Page 23)
» (N2 -N)/2

new connections.
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Question No: 2 ( Marks: 1) - Please choose one
In Point-to-Point topology there are two topologies.
» Tree and Ring

» Star and Ring

» Star and Tree (Page 5)

» None of the given

Question No: 3 ( Marks: 1) - Please choose one
In ---mmmmmeeeem , network occupies the smaller area like a room a floor or a building

» LAN (Page 4)
> WAN

> MAN

» None of the given

Question No: 4 (Marks: 1) - Please choose one

Hardware that calculates a CRC uses two simple components.
» AND unit and XOR unit

» Shift register and XOR unit (Page 20)

» Shift register and AND unit

» None of the given

Question No: 5 ( Marks: 1) - Please choose one

CRC can detect more errors than a simple checksum.

» true (Computer Networks and Internets, page 80)
» false

Question No: 6 ( Marks: 1) - Please choose one
The Gigabit Ethernet hardware operates at a rate of --------

» 10 Mbps

» 100 Mbps

» 1000 Mbps  Click here for detail
» None of the given

Question No: 7 ( Marks: 1) - Please choose one

Formally named informally known as the twisted pair Ethernet or TP Ethernet.

» 10 Base 2

» 10 Base 5

» 10 Base T (Page 43)
» None of the given
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Question No: 8 ( Marks: 1) - Please choose one
An interface for thin Ethernet must have an connector , and must generate signals according to
the specification.

» RJ-45,10 Base T

» RJ-45, 10 Base 5

» BNC, 10 Base 2  ( cs610 reference book Page 201)
» BNC, 10 Base T

Question No: 9 ( Marks: 1) - Please choose one

A system with redundant bridges might have a problem with in the system.
» Loop Click here for detail rep
» Filters

» Spanning Trees
» All given choices

Question No: 10 ( Marks: 1) - Please choose one
computes shortest paths in a graph by using weights on edges as a measure of distance.

» Greedy algorithm

» Distance vector algorithm

» Dijksta’s algorithm  (Computer Networks and Internets, page 112)
» Non of the given

Question No: 11 ( Marks: 1) - Please choose one
Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a 3

» Connectionless service paradigm  (Computer Networks and Internets, page 112)
» Connection-oriented service paradigm

» Both Connectionless and Connection-oriented service paradigm

» None of the given

Question No: 12 ( Marks: 1) - Please choose one
protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer (Page 84) rep
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Question No: 13 ( Marks: 1) - Please choose one

An Internet Address (IP address) is a unique binary number assigned to a host and used for all
communication with host

» 48-bit

» 32-bit (Page 85)

» 24-bit

» None of the given

Question No: 14 ( Marks: 1) - Please choose one
The address identifies the physical network to which the computer is attached, while the
identifies an individual computer on that network.

» prefix , suffix (Page 85)
P suffix , prefix

» suffix , suffix

» None of the given

Question No: 15 ( Marks: 1) - Please choose one
places the boundary between the first and second octets

» Class A (Computer Networks and Internets, page 235)
» Class B
» Class C
» Class D

Question No: 16 ( Marks: 1) - Please choose one
places the boundary between the third and fourth octets.
» Class A
» Class B
» Class C  (Computer Networks and Internets, page 235)
» Class D

Question No: 17 ( Marks: 1) - Please choose one
field of header indicates whether a datagram is a fragment or a complete datagram.

» FLAGS Click here for detail
» FLAGMENT OFFSET

» IDENTIFICATION

» None of the given
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Question No: 18 ( Marks: 1) - Please choose one
provides connectionless service.

» TCP

» UDP (Page 120)
> 1P

» None of the given

Question No: 19 ( Marks: 1) - Please choose one
UDP and TCP are both layer protocols

» Physical
» Data link
» Network
» Transport (Page 101) rep

Question No: 20 ( Marks: 1) - Please choose one
Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided

by

> 1P

» None of the given

» TCP (Page 123) rep
» UDP

Question No: 21 ( Marks: 1) - Please choose one
protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer (Page 84) rep

Question No: 22 ( Marks: 1) - Please choose one
identifies which application program on receiving computer should receive the data

» Logical address

» Source port

» Destination Port (Computer Networks and Internets, page313) rep
» None of the given
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Question No: 23 ( Marks: 1) - Please choose one
identifies the application program that sent the data.
» DestinationPort
» Source port (Computer Networks and Internets, page313) rep
» Logical address
» None of the given

Question No: 24 ( Marks: 1) - Please choose one
The Border Gateway Protocol (BGP) uses for all communication

» UDP
» TCP Click here for detail  rep

» Both UDP and TCP
» None of the given

Question No: 25 ( Marks: 1) - Please choose one
Which of the following protocols allows the sender and receiver to enforce polices.

» RIP

» OSPF

» BGP  (Reference Book 347) rep
» RIP and OSPF

Question No: 26 ( Marks: 1) - Please choose one
uses distance vector approach to define routing

» BGP

» OSPF

» RIP (Computer Networks and Internets, page332)
» None of the given

Question No: 27 (Marks: 1) - Please choose one
ICMP message transport is acted upon by getting ICMP encrypted in IP.

» True (Page 117)
» False
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Question No: 28 ( Marks: 1) - Please choose one
Protocol addresses are abstractions provided by

» hardware

» software (Page 93) rep

P operating system

» internet

Question No: 29 ( Marks: 1) - Please choose one
These packets serve same purpose on as frames on

» Intranet, LAN
» Internet, WAN
» Intranct, WAN
» Internet, LAN (Page 101)

Question No: 30 ( Marks: 1) - Please choose one

Address mask defines how many bits of address are in suffix?
» True

» False (Page 103) rep

Question No: 31 ( Marks: 1) - Please choose one
A single networking technology is best for all needs.
» True

» False (Page 81) rep

Question No: 32 ( Marks: 1) - Please choose one
A computer attached to a given network can only communicate with other computers attached to the same
network. Is this a problem with multiple networks?

» True (Page81) rep
» False

Question No: 33 ( Marks: 1) - Please choose one
The term self-identifying is used for Classful IP addresses because the class of the address can be computed
from the address

» itself (Page 87)
» prefix
» suffix
» mask
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Question No: 34 ( Marks: 1) - Please choose one
Find the class of the address.
10100111 11011011 10001011 01101111

> A
» B (Computer Networks and Internets, page 122)
> E
> C

Question No: 35 ( Marks: 1) - Please choose one
Find the class of the address:
11110011 10011011 11111011 00001111

> A
> C
> E (Computer Networks and Internets, page 122)
> B

Question No: 36 ( Marks: 1) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T

» D

» C (Page97) rep
> T,C

Question No: 37 ( Marks: 1) - Please choose one
Which method of Address Resolution Protocol requires hardware broadcast?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

» D (Page97)
> T

» C

» T.D

- : 1
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Question No: 38 ( Marks: 1) - Please choose one
Which method of Address Resolution Protocol resolution with minimum delay?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

» T,D

> c

> T

» T,C (Page97)

Question No: 39 ( Marks: 1) - Please choose one
In which method of Address Resolution Protocol the implimentation is more difficult?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T,C

> T

» C

» D (Page 97)

Question No: 40 ( Marks: 1) - Please choose one
On of the design goals for unicast route propagation is

» Consistency

P inconsistency

P stability (Computer Networks and Internets, page 344) rep
» dynamic addressing

Question No: 41 ( Marks: 1) - Please choose one
Propagation multicast routing information differs dramatically from unicast route propagation?

» True (Computer Networks and Internets, page 335)
» False

Question No: 42 ( Marks: 1) - Please choose one

The IP multicast abstraction allows an application running on an arbitrary computer to leave a multicast group
at any time. While application on a computer remain a member of a group.

» One or more

» only one

» no

» many

- : 1
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Question No: 43 ( Marks: 1) - Please choose one
To save traffic, an EGP does not summerize routing information from the autonomous system before passing it
to another autonomous system.

» True
» False (Computer Networks and Internets, page 329)

Question No: 44 (Marks: 1) - Please choose one
In IPVv6 the type of address used for collection of computers with same prefix. Are known as

» Anycast

» Unicast

» Multicast

» Non of the given (Page 114)

Question No: 45 ( Marks: 1) - Please choose one
Special types of addresses in IPv6 used for multiple destinations; possibly not at same site. Are known
as .

» Unicast

» Anycast

» Multicast (Page 114)
» Non of the given

Question No: 46 ( Marks: 1) - Please choose one
UDP offers application programs a Message-Oriented Interface, applications can depend on protocol to
preserve data boundaries.

» True (Page 120) rep
» False

Question No: 47 ( Marks: 1) - Please choose one
Reliability is the responsibility of the layer

» Network
» Datalink
» Transport (Page 123)

» Application
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Question No: 48 ( Marks: 1) - Please choose one
TCP uses mechanism to control the flow of data.

» door

» window (Page 126) rep

» acknowledgment

» retransmission

TCP uses window mechanism to control the flow of data.

Question No: 49 ( Marks: 1) - Please choose one
The time for acknowledgement to arrival of packet depends on.

» Distance to destination and Current traffic conditions (Page 125)
» Current traffic conditions

» Distance to destination

» non of these

Question No: 50 ( Marks: 1) - Please choose one
FDDI can transmits data at a rate of ----------

» 100 million bits per second (Page 31)

» 10 million bits per second

» 1000 million bits per second

» None of the given

FINALTERM EXAMINATION Fall 2008
CS610- Computer Network

QuestionNo:1 (Marks:1)
Computer networks are often called -------------- because they use packet technology.

» Ethernet

» Switch networks

» Packet networks  (Computer Networks and Internets, page 73)
» None of the given

QuestionNo:2 (Marks:1)
A network uses a ------ arranges for computers to be connected in a closed loop.

» Star Topology
» Ring Topology (Page 25) rep
» Bus Topology
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» None of the given

QuestionNo:3 (Marks:1)
AN --m-eeeeeee method, the network hardware designers specify how type information is included in the frame
and the value use to identify various frame types.

» Explicit frame type (Computer Networks and Internets, page 108)
» Ideal frame type

» Implicit frame type

» None of the given

QuestionNo:4 (Marks:1)
An interface for thin Ethernet must have an connector , and must generate signals according to
the specification.

» RJ-45,10 Base T
» RJ-45, 10 Base 5
» BNC, 10 Base 2  (cs610 reference book Page 201) rep
» BNC, 10 Base T

QuestionNo:5 (Marks:1)
A Bridge forwards or filters a frame by comparing the information in its address table to the frame’s

» Layer 2 source address

» Source node’s physical address

» Layer 2 destination address Click here for detail
» Layer 3 destination address

QuestionNo: 6 (Marks:1)
Most WAN systems include a mechanism that can be used to eliminate the common case of duplication routing
is called

» Hierarchal address

» Default route  (Computer Networks and Internets, page 172)
» Shortest path

» None of the given

QuestionNo: 7 (Marks:1)
of TCP/IP layering model, corresponds to basic network hardware.

» Physical Layer (Page 84) rep
» Network Interface Layer

» Internet Layer

» Transport Layer
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QuestionNo:8 (Marks:1)
protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer (Page 84) rep

QuestionNo:9 (Marks:1)
is called an end-to-end protocol because it provide a connection directly from an application on one
computer to an application on a remote computer.

> IP

» UDP

» TCP (Computer Networks and Internets, page 306)
» None of the given

Question No: 10 (Marks:1)
uses distance vector approach to define routing

» BGP

» OSPF

> RIP (Computer Networks and Internets, page332) rep
» None of the given

QuestionNo: 11  (Marks:1)
is ideal in a situation where the group is small and all members are attached to contiguous Local
Area Networks.

» Flood-and —-Prune  (Page 143)
» Configuration-and -Tunneling

» Core-Based Discovery

» None of the given

Question No: 12 (Marks:1)
Router that decrements TTL to __ sends ICMP time exceeded message, with router’s address as source address

> 3
> 2
> 1
» 0 (Page 118)
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Question No: 13  (Marks: 1)
Protocol addresses are abstractions provided by

» hardware

» software (Page 93) rep
» operating system

» internet

Question No: 14 (Marks:1)
Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly
inefficient.

» True (Page 99) rep

» False

Question No: 15 (Marks: 1)
ARP is almost always used to bind a ___ -bit IP addressto a ___-bit Ethernet address.
> 32,48 (Page 98)
» 24,32
» 32, 64
» 32,128

Question No: 16 (Marks: 1)

In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed
island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens,
keyboards and computers.

» False
» True (Page 81) rep

Question No: 17 (Marks:1)
In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

Types of
Features Resolution

Use full with any hardware T
Address change affects all hosts | T
Protocol address is determined | C
by hardware address

> T

» D

» C (Page97) rep
> T,C
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Question No: 18 (Marks:1)
The general form of an IP datagram is with a header followed by data. The header contains information that
controls where and how the datagram is to be sent.

» True (Computer Networks and Internets, page 332)

» False

Question No: 19 (Marks:1)
To save traffic, an EGP does not summarize routing information from the autonomous system before passing it
to another autonomous system.

» True

» False  (Computer Networks and Internets, page 329)

Question N0o: 20 (Marks:1)
Which of the following is a correct representation of the IPv6?
» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255  (Page 114)
» 105.220.136.100.255.255.255.256.0.0.18.128.140.10.255.255
» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255.256
» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255

FINALTERM EXAMINATION
Fall 2008
CS610- Computer Network

Question No: 1 ( Marks: 1) - Please choose one
The number of connections needed for N computer in direct point to point communication is equal to:

» (N2 -N)/2 (Page 23)
» N(N-1)

> N°

» None of the given

Question No: 2 (Marks: 1) - Please choose one

When an application--------------- data, it makes a copy of the data available to all other computers on the
network.

» Broadcasting Click here for detail

» Multicasting

» Unicasting

» None of the given

- : 2
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Question No: 3 ( Marks: 1) - Please choose one

Ethernet uses a ------ bit static addressing scheme in which each device is assigned a unique address by the
manufacturer.
> 64
> 48 (Computer Networks and Internets, page 109)
> 32
> 8
Question No: 4  ( Marks: 1) - Please choose one
A system with redundant bridges might have a problem with in the system.
» Loop Click here for detail rep
» Filters

» Spanning Trees
» All given choices

Question No: 5  (Marks: 1) - Please choose one

The product of delay and throughput measures the of data that can be present on the network.
> Area
» Volume (Page 80) rep
» Length

» None of the given

Question No: 6  ( Marks: 1) - Please choose one
Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction and
operating system independent are the characteristics of

» TCP

» UDP (Page 110)
> IP

» None of the given

Question No: 7 ( Marks: 1) - Please choose one
Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided

by

» None of the given

» TCP ( Page 123) rep
» UDP

> IP

- : 2
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Question No: 8  ( Marks: 1) - Please choose one
The process of using a routing table to select a next hop for a given datagram is called

» Encapsulation

» Reassembling

» Routing or forwarding (Computer Networks and Internets, page 265)
» None of the given

Question No: 9  (Marks: 1) - Please choose one
uses distance vector approach to define routing

» BGP

» OSPF

» RIP (Computer Networks and Internets, page332) rep
» None of the given

Question No: 10  ( Marks: 1) - Please choose one

A multicast routing scheme in which the protocol software builds a delivery tree from a central point is

called

» Distance Vector Multicast Routing Protocol (DVMRP)

» Core Based Trees (CBT) (Page 114)

» Protocol Independent Multicast_ Sparse Mode (PIM-SM)
» Protocol Independent Multicast _ Dense Mode (PIM-DM)

Question No: 11 ( Marks: 1) - Please choose one
One repeater , two repeaters the maximum cable length limitation.

» doubles, cancel

» doubles, triple (Page 49) rep
» square roots, cude roots
» and, triple

Question No: 12 ( Marks: 1) - Please choose one
Whenever it handles a packet, IP software needs to separate the destination address into a

» postfix, Infix
» non of these
» Infix, prefix
» prefix, suffix (Page 87)

Muhammad Moaaz Siddiq MCS (3rd)
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Question No: 13 ( Marks: 1) - Please choose one
Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly
inefficient.

» True (Page 99) rep
> False

Question No: 14  ( Marks: 1) - Please choose one
ARP is almost always used to bind a ___ -bit IP addressto a ___ -bit Ethernet address.

> 32,48 (Page 98)
» 24, 32

» 32,64

» 32,128

Question No: 15  ( Marks: 1) - Please choose one
End-to-end delivery service is connection oriented.

» True
» False (Page 101)

Question No: 16  ( Marks: 1) - Please choose one
A single networking technology is best for all needs.

» True
» False (Page 81) rep

Question No: 17 ( Marks: 1) - Please choose one

In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed
island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens,
keyboards and computers.

» False
» True (Page 81)

Question No: 18  ( Marks: 1) - Please choose one
Which method of Address Resolution Protocol is useful with any hardware?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

(Page 97)
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Question No: 19  ( Marks: 1) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T

» D

> C (Page 97) rep
» T,C

Question No: 20  ( Marks: 1) - Please choose one
We use the term to refer to a measure of the path that routing software use when choosing a route.

» routing path

» routing metric

» routing (Computer Networks and Internets, page330)
» switching
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FINALTERM EXAMINATION
Spring 2010
CS610- Computer Network
Ref No: 1578657
Time: 90 min
Marks: 60
Question No:1  ( Marks: 1) - Please choose one

A - relies on the hardware manufacturer to assign a unique
physical address to each network interface.

» Static addressing scheme

» Configurable addressing scheme
» Dynamic addressing scheme

» None of the given
Question No:2 ( Marks: 1) - Please choose one

An interface for thin Ethernet must have an
connector , and must generate signals according to
the specification.

» RJ-45.10 Base T
» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10Base T

Question No: 3  ( Marks: 1) - Please choose one

A system with redundant bridges might have a problem
with in the system.

» Loop




» Filters

» Spanning Trees

» All given choices
Question No: 4 ( Marks: 1) - Please choose one
A Bridge can

» Filter a frame

» Forward a frame

» Extend a LAN

» Do all the above

Question No: 5 ( Marks: 1) - Please choose one

is used for typical data applications (where the data rate
may be unknown and bursty) and allows use of whatever
bandwidth is available at a given time.

» Constant Bit Rate (CBR) service
» Variable Bit Rate (VBR) service
» Available Bit Rate (ABR) service

» None of the given
Question No: 6 ( Marks: 1) - Please choose one

ATM assigns each VC a identifier that is divided
two parts to produce a hierarchy.

» 21-bit
» 22-bit
» 23-bit
> 24-bit




Question No: 7 ( Marks: 1) - Please choose one

of TCP/IP layering model, corresponds to basic network
hardware.

» Physical Layer

» Network Interface Layer
» Internet Layer
» Transport Layer

Question No: 8 ( Marks: 1) - Please choose one

places the boundary between the second and third
octets

» Class A
» Class B
» Class C
» Class D
Question No: 9  ( Marks: 1) - Please choose one

UDP and TCP are both layer protocols

» Physical
» Data link
» Network

» Transport

Question No: 10  ( Marks: 1) - Please choose one

Connection-oriented service, Point-to-point, Complete reliability,
Full-duplex communication, Stream interface, Reliable connection
startup and Graceful connection shutdown are the services
provided by




» IP

» None of the given
» TCP

» UDP

Question No: 11 ( Marks: 1) - Please choose one

protocols of TCP/IP layering model specify how to ensure
reliable transfer.

» Physical Layer
» Network Interface Layer
» Internet Layer

» Transport Layer

Question No: 12  ( Marks: 1) - Please choose one

identifies which application program on receiving
computer should receive the data

» Logical address
Source port
Logical address

None of the give

» Source port

» Destination Port

» None of the given
Question No: 13  ( Marks: 1) - Please choose one

identifies the application program that sent the data.




» Destination Port

» Source port

» Logical address

» None of the given
Question No: 14  ( Marks: 1) - Please choose one
Which of the following are interior routing protocols?

» RIP

» OSPF

» BGP

» RIP and OSPF

Question No: 15 (Marks: 1) —
www.vustudents.ning.com Please choose one

The Border Gateway Protocol (BGP) uses for all
communication

» UDP
» TCP
» Both UDP and TCP

» None of the given

Question No: 16  ( Marks: 1) - Please choose one

measures distance in network hops, where each
network between the source and destination counts as single hop.

» BGP
» OSPF
» RIP



http://www.vustudents.ning.com/

» None of the given
Question No: 17  ( Marks: 1) - Please choose one
OSPF is based on--------

» Distance vector routing

» Link state routing

» Path vector routing

» Distance vector routing and Link state routing
Question No: 18 ( Marks: 1) - Please choose one

performs local multicast and uses IP-in-IP
encapsulation to send multicast datagrams from one site on the
Internet to another.

» Distance Vector Multicast Routing Protocol (DVMRP)
» Core Based Trees (CBT)

» Protocol Independent Multicast_ Sparse Mode (PIM-SM)
» Protocol Independent Multicast _ Dense Mode (PIM-DM)

Question No: 19  ( Marks: 1) - Please choose one

The length of time required to send a variable length packet is
variable and does not require a complicated interrupt scheme to
detect completion of transmission.

» True

» False
Question No: 20 ( Marks: 1) - Please choose one

NEXT HEADER field in the base header defines type of header
and it appears at end of fixed-size base header.

» True




» False
Question No: 21  ( Marks: 1) - Please choose one

Although message exchange can be used to bind addresses,
sending a request for each binding is hopelessly inefficient.

» True

» False
Question No: 22 ( Marks: 1) - Please choose one
Address mask defines how many bits of address are in suffix?
» True

» False

Question No: 23  ( Marks: 1) - Please choose one

A computer attached to a given network can only communicate
with other computers attached to the same network. Is this a
problem with multiple networks?

» True

» False
Question No: 24  ( Marks: 1) - Please choose one

In the 1970s large organizations began to acquire multiple
networks. Each network in the organization formed island.
Employees needed to choose a computer appropriate for each
task. So they needed multiple screens, keyboards and computers.

» False

» True

Question No: 25 ( Marks: 1) - Please choose one



The term self-identifying is used for Classful IP addresses because
the class of the address can be computed from the
address

» itself

» prefix
» suffix
» mask
Question No: 26 ( Marks: 1) - Please choose one

In which method of Address Resolution Protocol the protocol
address independent of hardware address?

Were "T" stands for Table lookup, "C" for Closed-form
Computation and "D" for Data Exchange?

» T,C
» D
» C
» T.D

Question No: 27 ( Marks: 1) - Please choose one

In which method of Address Resolution Protocol the protocol
address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form
Computation and "D" for Data Exchange?

> T
» D
» C
» T,C




Question No: 28 ( Marks: 1) - Please choose one
Reconstruction of original datagram is called reassembly.

» True

» False
Question No: 29 ( Marks: 1) - Please choose one

A computer needs a complete stack of protocols to run either a
client or a server.

» True
» False
Question No: 30  ( Marks: 1) - Please choose one
TCP uses mechanism to control the flow of data.
» door

» window

» acknowledgment

» retransmission

Reply by M.Tarig Malik on December 31, 2011 at 9:57pm

Time: 120 min
Marks: 70

Question No: 1  ( Marks: 1) - Please choose one

Computer networks are often called -------------- because they use
packet technology.


http://vustudents.ning.com/group/cs610computernetwork/forum/topic/listForContributor?user=0lrhnllrdvalv

» Ethernet
» Switch networks

» Packet networks

» None of the given
Question No:2 ( Marks: 1) - Please choose one

A network uses a ------ arranges for computers to be connected in a
closed loop.

» Star Topology
» Ring Topology

» Bus Topology

» None of the given
In a ring topology each computer is connected to other thorough a
ring
Question No: 3 ( Marks: 1) - Please choose one

An -------eee- method, the network hardware designers specify how
type information is included in the frame and the value use to
identify various frame types.

» Explicit frame type

» |deal frame type

» Implicit frame type

» None of the given
EXPLICIT FRAME TYPE:

In this type the identifying value is included with frame describes
types of

included data.



Question No: 4 ( Marks: 1) - Please choose one

An interface for thin Ethernet must have an
connector , and must generate signals according to
the specification.

» RJ-45, 10 Base T (reference not available)
» RJ-45, 10 Base 5

» BNC, 10 Base 2

» BNC, 10 Base T

Question No: 5 ( Marks: 1) - Please choose one

A Bridge forwards or filters a frame by comparing the information in
its address table to the frame’s

» Layer 2 source address
» Source node’s physical address

» Laver 2 destination address (not confirm)

» Layer 3 destination address
Question No: 6  ( Marks: 1) - Please choose one

Most WAN systems include a mechanism that can be used to
eliminate the common case of duplication routing is
called

» Hierarchal address

» Default route

» Shortest path
» None of the given

Most WAN systems include a mechanism that can be used to
eliminate the common case of duplication routing is called Default



route. The mechanism allows a single entry in a forwarding table to
replace a long list of entries that have the same next hope value

Question No: 7 ( Marks: 1) - Please choose one

of TCP/IP layering model, corresponds to basic network
hardware.

» Physical Layer

» Network Interface Layer
» Internet Layer
» Transport Layer
LAYER 1:
Corresponds to basic network hardware layer in OSI
Question No: 9 ( Marks: 1) - Please choose one

is called an end-to-end protocol because it provide a
connection directly from an application on one computer to an
application on a remote computer.

» P
» UDP
» TCP

» None of the given

UDP has the following characteristics.

It is an end-to-end protocol. It provides application-to-application
communication.

Question No: 10  ( Marks: 1) - Please choose one

uses distance vector approach to define routing

» BGP




» OSPF
» RIP

» None of the given
DISTANCE-VECTOR ROUTING:
* It is very simple to implement.
 Packet switch updates its own routing table first.
* It is used in RIP.
Question No: 11 ( Marks: 1) - Please choose one

is ideal in a situation where the group is small and all
members are attached to contiguous Local Area Networks.

» Flood-and -Prune

» Configuration-and -Tunneling
» Core-Based Discovery

» None of the give006E
FLOOD-AND-PRUNE:

Flood-and-prune is ideal in a situation where the group is small and
all members

Are attached to contiguous Local Area Networks.
Question No: 12  ( Marks: 1) - Please choose one

Router that decrements TTL to _ sends ICMP time exceeded
message, with router’s address as source address

» 3
> 2

> 1



» 0

Router that decrements TTL to 0 sends ICMP time exceeded
message, with router’s

address as source address
Question No: 13  ( Marks: 1) - Please choose one

Protocol addresses are abstractions provided by

» hardware

» software

» operating system

» internet
PROTOCOL ADDRESSES AND PACKET DELIVERY:
Protocol addresses are abstractions provided by software
Question No: 14  ( Marks: 1) - Please choose one

Although message exchange can be used to bind addresses,
sending a request for each binding is hopelessly inefficient.

» True

» False
CASHING ARP RESPONSES:

Although message exchange can be used to bind addresses,
sending a request for

each binding is hopelessly inefficient
Question No: 15 ( Marks: 1) - Please choose one

ARP is almost always used to binda ___ -bit IP addresstoa -
bit Ethernet address.

> 32,48




> 24, 32
> 32, 64
» 32,128

ARP is almost always used to bind a 32-bit IP address to a 48-bit
Ethernet address

Question No: 16  ( Marks: 1) - Please choose one

In the 1970s large organizations began to acquire multiple
networks. Each network in the organization formed island.
Employees needed to choose a computer appropriate for each
task. So they needed multiple screens, keyboards and computers.

» False

» True

In the 1970s large organizations began to acquire multiple
networks. Each

network in the organization formed island. Employees needed

to choose a

computer appropriate for each task. So they needed multiple
screens, keyboards

and computers.

Question No: 17 ( Marks: 1 ) www.vustudents.ning.com _-_
Please choose one

In which method of Address Resolution Protocol the protocol
address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form



http://www.vustudents.ning.com/
http://www.vuzs.net/
http://www.vuzs.net/
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http://www.vuzs.net/

Header contains all information needed to deliver datagram to
the destination

computer. It contains:

» Destination address

» Source address

« |dentifier
» Other delivery information
CS610- Computer Network

Ref No: 325624
Time: 120 min
Marks: 70
Question No:1  ( Marks: 1) - Please choose one

The number of connections needed for N computer in direct point
to point communication is equal to:

» (N*-N)/2
» N(N- 1)

» N°

» None of the given

For ‘n’ computers connections in direct point to point
communication = (n"2 —n)/2.

Question No: 2 ( Marks: 1) - Please choose one

When an application--------------- data, it makes a copy of the data
available to all other computers on the network.



» Broadcasting
» Multicasting
» Unicasting

» None of the given (not sure)

Question No: 3 ( Marks: 1) - Please choose one

Ethernet uses a ------ bit static addressing scheme in which each
device is assigned a unique address by the manufacturer.

> 64

» 48

» 32

» 8
Ethernet uses a 48-bit static addressing scheme
Question No: 4 ( Marks: 1) - Please choose one

A system with redundant bridges might have a problem
with in the system.

» Loop

» Filters
» Spanning Trees
» All given choices
Reference not available
Question No: 5 ( Marks: 1) - Please choose one

The product of delay and throughput measures the of data
that can be present on the network.

» Area



» Volume
» Length
» None of the given

It is computed as delay time multiplied by effective throughput. It
measures amount of data that can be present in the network

Question No: 6  ( Marks: 1) - Please choose one

Connectionless service, Message-Oriented protocol, best effort
delivery service, arbitrary interaction and operating system
independent are the characteristics of

» TCP
» UDP
» P

» None of the given
UDP has the following characteristics.

e It is an end-to-end protocol. It provides application-to-application
communication.

e It provides connectionless service.
e It is a Message-Oriented protocol.
» It uses best-effort delivery service.
e It follows arbitrary interaction.

« It is operating system independent
Question No: 7  ( Marks: 1) - Please choose one

Connection-oriented service, Point-to-point, Complete reliability,
Full-duplex communication, Stream interface, Reliable connection



startup and Graceful connection shutdown are the services
provided by

» None of the given
» TCP
» UDP
» IP
SERVICE PROVIDED BY TCP:

Following are the services provided by TCP:

 Connection-oriented service

e Point-to-point

e Complete reliability

e Full-duplex communication

» Stream interface

* Reliable connection startup

» Graceful connection shutdown

Question No: 8 ( Marks: 1) - Please choose one

The process of using a routing table to select a next hop for a
given datagram is called

» Encapsulation
» Reassembling

» Routing or forwarding

» None of the given

Reference not available



Question No: 9  ( Marks: 1 ) www.vustudents.ning.com -
Please choose one

uses distance vector approach to define routing

» BGP

» OSPF

» RIP

» None of the given
DISTANCE-VECTOR ROUTING:

e It is very simple to implement.

» Packet switch updates its own routing table first.
e It is used in RIP.
Question No: 10  ( Marks: 1) - Please choose one

A multicast routing scheme in which the protocol software builds a
delivery tree from a central point is called

» Distance Vector Multicast Routing Protocol (DVMRP)

» Core Based Trees (CBT)

» Protocol Independent Multicast_ Sparse Mode (PIM-SM)
» Protocol Independent Multicast _ Dense Mode (PIM-DM)

CORE BASED TREES (CBT):
A multicast routing scheme in which the protocol software builds a
delivery tree

from a central point.
Question No: 11 ( Marks: 1) - Please choose one

One repeater , two repeaters the maximum
cable length limitation.


http://www.vustudents.ning.com/

» doubles, cancel

» doubles, triple

» square roots, cude roots
» and, triple

One repeater doubles, two repeaters triple the maximum cable
length limitation.

Question No: 12  ( Marks: 1) - Please choose one

Whenever it handles a packet, IP software needs to separate the
destination address into a and

» postfix, Infix
» non of these
» Infix, prefix

» prefix, suffix

Whenever it handles a packet, IP software needs to separate the
destination address into a prefix and suffix

Question No: 13  ( Marks: 1) - Please choose one

Although message exchange can be used to bind addresses,
sending a request for each binding is hopelessly inefficient.

» True

» False
CASHING ARP RESPONSES:

Although message exchange can be used to bind addresses,
sending a request for

each binding is hopelessly inefficient.

Question No: 14  ( Marks: 1) - Please choose one



ARP is almost always used to binda ___ -bit IP addresstoa -
bit Ethernet address.

> 32,48

» 24, 32

» 32, 64

» 32, 128
ARP is almost always used to bind a 32-bit IP address
to a 48-bit Ethernet address

Question No: 15 ( Marks: 1) - Please choose one
End-to-end delivery service is connection oriented.
» True

» False

End-to-end delivery service is connection less
Question No: 16  ( Marks: 1) - Please choose one
A single networking technology is best for all needs.

» True

» False

There is no single networking technology that is best for all needs
Question No: 17  ( Marks: 1) - Please choose one

In the 1970s large organizations began to acquire multiple
networks. Each network in the organization formed island.



Employees needed to choose a computer appropriate for each
task. So they needed multiple screens, keyboards and computers.

» False

» True
In the 1970s large organizations began to acquire multiple
networks. Each network in the organization formed island.
Employees needed to choose a computer appropriate for each
task. So they needed multiple screens, keyboards and computers.

Question No: 18 ( Marks: 1) - Please choose one

Which method of Address Resolution Protocol is useful with any
hardware?

Were "T" stands for Table lookup, "C" for Closed-form
Computation and "D" for Data Exchange?

Features Types of » T
Resolution
» C
Use full with any hardware T
Address change affects all hosts T » D
Protocol address is determined C > C, D
by hardware address

Question No: 19  ( Marks: 1) - Please choose one

In which method of Address Resolution Protocol the protocol
address is determined by hardware address?



Were "T" stands for Table lookup, "C" for Closed-form
Computation and "D" for Data Exchange?

Features Types of » T
Resolution
» D
Use full with any hardware T
Address change affects all hosts T —_»C

Protocol address is determined C | 2 T, C
by hardware address

Question No: 20 ( Marks: 1) - Please choose one

We use the term to refer to a measure of the path that
routing software use when choosing a route.

» routing path

» routing metric

» routing

switching

» Reply

Message

F B
£ —
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FINALTERM EXAMINATION
Fall 2008
CS610- Computer Network

Question No: 1 ( Marks: 1) - Please choose one
In Direct point to point communication adding the Nth computer

requires------------ new connections.
» None of the given

» N2

»> N-1

» (N2 —N)/2

disadvantage In Direct point to point communication is that adding
a new computer to the network requires N-1 new connections .(P#
23)

Question No: 2 ( Marks: 1) - Please choose one

In Point-to-Point topology there are two topologies.

» Tree and Ring

» Star and Ring

» Star and Tree

» None of the given
POINT-TO-POINT:

In Point-to-Point topology there are two topologies.
1) STAR topology

2) TREE topology

Question No: 3 ( Marks: 1) - Please choose one

IN ===emmemmmmee , hetwork occupies the smaller area like a room a floor
or a building

» LAN




» WAN

» MAN

» None of the given

In LAN network occupies the smaller area like a room a floor or a

building.(P# 4)

It identifies an individual computer on the network.
Question No: 15 ( Marks: 1) - Please choose one
places the boundary between the first and second

octets

» Class A

» Class B

» Class C

» Class D

Class A places the boundary between the first and second octets.
Class B places the boundary between the second and third octets,
and class C places the boundary between the third and fourth

octets.

Question No: 16 ( Marks: 1) - Please choose one
places the boundary between the third and fourth

octets.

» Class A
» Class B
» Class C

» Class D
Class A places the boundary between the first and second octets.

Class B places the boundary between the second and third octets,
and class C places the boundary between the third and fourth
octets.



Question No: 17 ( Marks: 1 ) - Please choose one
field of header indicates whether a datagram is a

fragment or a complete datagram.
» FLAGS
» FLAGMENT OFFSET
» IDENTIFICATION
» None of the given
FRAGMENTATION:
IP uses fragmentation i.e. datagrams can be split into pieces to fit
in network with small MTU. Each fragment is an independent
datagram. It includes all header fields. Bit in header indicates that
the datagram is a fragment
Question No: 18 ( Marks: 1) - Please choose one

provides connectionless service.
» TCP
» UDP
» IP
» None of the given

UDP has the following characteristics.

* It is an end-to-end protocol. It provides application-to-application
communication.

* It provides connectionless service.
« It is a Message-Oriented protocol.
* It uses best-effort delivery service.
« It follows arbitrary interaction.

« It is operating system independent
Question No: 19 ( Marks: 1) - Please choose one



UDP and TCP are both layer protocols

» Physical

» Data link

» Network

» Transport

Question No: 20 ( Marks: 1) - Please choose one
Connection-oriented service, Point-to-point, Complete reliability,
Full-duplex communication, Stream interface, Reliable connection
startup and Graceful connection shutdown are the services
provided by
» IP

» None of the given

» TCP

» UDP

SERVICE PROVIDED BY TCP:

Following are the services provided by TCP:

« Connection-oriented service
* Point-to-point

» Complete reliability

* Full-duplex communication
» Stream interface

* Reliable connection startup

 Graceful connection shutdown
Question No: 21 ( Marks: 1) - Please choose one
protocols of TCP/IP layering model specify how to ensure
reliable transfer.
» Physical Layer



» Network Interface Layer
» Internet Layer
» Transport Layer
LAYER 4: ensure reliable transfer layer 4 in TCP layering model is
transport layer
Question No: 22 ( Marks: 1) - Please choose one

identifies which application program on receiving
computer should receive the data
» Logical address
» Source port
» Destination Port
» None of the given
FieldDestinationPort identifies which application program on
receiving computer should receive the data. While field source port
identifies the application programs that sent the data. (reference
from E-books)
Question No: 23 ( Marks: 1) - Please choose one

identifies the application program that sent the data.

» DestinationPort
» Source port
» Logical address
» None of the given
FieldDestinationPort identifies which application program on
receiving computer should receive the data. While field source port
identifies the application programs that sent the data. (reference
from E-books)
Question No: 24 ( Marks: 1) - Please choose one
The Border Gateway Protocol (BGP) uses for all
communication




» UDP

» TCP

» Both UDP and TCP
» None of the given

BORDER GATEWAY PROTOCOL.:

It is most popular Exterior Gateway Protocol in Internet. It has
following characteristics:

"It provides routing among autonomous systems (EGP).
"It provides policies to control routes advertised.

"It uses reliable transport (TCP).

Question No: 25 ( Marks: 1) - Please choose one

Which of the following protocols allows the sender and receiver to
enforce polices.

» RIP

» OSPF

» BGP

» RIP and OSPF

Question No: 26 ( Marks: 1) - Please choose one

uses distance vector approach to define routing

» BGP

» OSPF

» RIP

» None of the given

ROUTING INFORMATION PROTOCOL (RIP):

It has the following characteristics:

"It is used for routing within an autonomous system (IGP).



"Hop Count Metric: RIP measures distance in network hops, where
each network

between the source and destination counts as a single hop.
"It uses UDP for all message transmissions.

"RIP is used over LAN. Version 1 of RIP uses hardware broadcast
and version 2 allows

delivery via multicast.

"It can be used to advertise default route propagation. An
organization can use RIP to

install a default route in each router.

"It uses distance vector algorithm.

Question No: 27 ( Marks: 1) - Please choose one

ICMP message transport is acted upon by getting ICMP encrypted
in IP.

» True

» False

ICMP message transport is acted upon by getting ICMP
encapsulated in IP (P# 117)

Question No: 28 ( Marks: 1) - Please choose one

Protocol addresses are abstractions provided by
» hardware

» software

» operating system

» internet

Protocol addresses are abstractions provided by software
Question No: 29 ( Marks: 1) - Please choose one

These packets serve same purpose on as frames on




» Intranet, LAN
» Internet, WAN
» Intranet, WAN
» Internet, LAN
VIRTUAL PACKETS:

These packets serve same purpose in Internet as frames on LAN
Question No: 30 ( Marks: 1) - Please choose one

Address mask defines how many bits of address are in suffix?

» True

» False

Address mask defines how many bits of address are in prefix.
Prefix defines how much of address used to identify network.
Question No: 31 ( Marks: 1) - Please choose one

A single networking technology is best for all needs.

» True

» False

There is no single networking technology that is best for all needs
Question No: 32 ( Marks: 1) - Please choose one

A computer attached to a given network can only communicate
with other computers attached to the same network. Is this a
problem with multiple networks?

» True
» False
The chief problems with multiple networks are as follows:

» A computer attached to a given network can only communicate
with other



computers attached to the same network.

Question No: 33 ( Marks: 1) - Please choose one

The term self-identifying is used for Classful IP addresses because
the class of the address can be computed from the

address

> itself

» prefix

» suffix

» mask

Classful IP addresses are self-identifying because the class of the
address can be computed from the address itself

Question No: 34 ( Marks: 1) - Please choose one

Find the class of the address.

10100111 11011011 10001011 01101111

> A

» B

» E

» C

Reference table handouts P # 87

Question No: 35 ( Marks: 1) - Please choose one

Find the class of the address:

11110011 10011011 11111011 00001111

> A

» C

» E

» B

Reference table handouts P # 87

Question No: 36 ( Marks: 1) - Please choose one

In which method of Address Resolution Protocol the protocol



address is determined by hardware

address? www.vustudents.ning.com _

Were "T" stands for Table lookup, "C" for Closed-form Computation
and "D" for Data Exchange?

» T

» D

» C

» T,C

Reference table handouts P # 97

Question No: 37 ( Marks: 1) - Please choose one

Which method of Address Resolution Protocol requires hardware
broadcast?

Were "T" stands for Table lookup, "C" for Closed-form Computation
and "D" for Data Exchange?

» D

» T

» C

» T,D

Reference table handouts P # 97

Question No: 38 ( Marks: 1) - Please choose one

Which method of Address Resolution Protocol resolution with
minimum delay?

Were "T" stands for Table lookup, "C" for Closed-form Computation
and "D" for Data Exchange?

» T,D

> C

» T

» T,C

Reference table handouts P # 97



http://www.vustudents.ning.com/

Question No: 39 ( Marks: 1) - Please choose one

In which method of Address Resolution Protocol the implimentation
is more difficult?

Were "T" stands for Table lookup, "C" for Closed-form Computation
and "D" for Data Exchange?

» T,C

> T

» C

» D

Reference table handouts P # 97

Question No: 40 ( Marks: 1) - Please choose one

On of the design goals for unicast route propagation is

» Consistency

» inconsistency

» stability

» dynamic addressing

On of the design goals for unicast route propagation is stability—
continual changes in route are undesirable because they lead to
higher jitter and datagram arriving out of order. Thus, once a
unicast routing protocol finds a shortest path, it usually retains the
route until a failure makes the path unusable. (Reference from E-
book)

Question No: 41 ( Marks: 1) - Please choose one

Propagation multicast routing information differs dramatically from
unicast route propagation?

» True

» False

Propagating multicast routing information differs dramatically from



unicast route propagation. The difference arises because internet
multicast allows dynamic group membership and autonomous
senders

Question No: 42 ( Marks: 1) - Please choose one

The IP multicast abstraction allows an application running on an
arbitrary computer to leave a multicast group at any time. While
application on a computer remain a member of a

group.
» One or more
» only one

» Nno

» many

Question No: 43 ( Marks: 1) - Please choose one

To save traffic, an EGP does not summerize routing information
from the autonomous system before passing it to another
autonomous system.

» True

» False

To save traffic, an EGP summerize routing information from the
autonomous system before passing it to another autonomous
system. More important an EGP implements policy constraints that
allow a system manager to determine exactly what information is
released outside the organization. (Reference from E-book)
Question No: 44 ( Marks: 1) - Please choose one

In IPv6 the type of address used for collection of computers with
same prefix. Are known as
» Anycast

» Unicast

» Multicast




» Non of the given
Following are special types of addresses, |IPv6 uses:

Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same
site.

Cluster: This type of address is used for collection of computers
with same prefix,

datagram is delivered to one out of cluster.

Question No: 45 ( Marks: 1) - Please choose one

Special types of addresses in IPv6 used for multiple destinations;
possibly not at same site. Are known as
» Unicast

» Anycast

» Multicast

» Non of the given

Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same
site.

Cluster: This type of address is used for collection of computers
with same prefix,

datagram is delivered to one out of cluster.

Question No: 46 ( Marks: 1) - Please choose one

UDP offers application programs a Message-Oriented Interface,
applications can depend on protocol to preserve data boundaries.
» True

» False



UDP offers application programs a Message-Oriented Interface. It
does not divide messages into packets for transmission and does
not combine messages for delivery.

ADVANTAGES:

* Applications can depend on protocol to preserve data boundaries.
Question No: 47 ( Marks: 1) - Please choose one
Reliability is the responsibility of the layer

» Network

» Datalink

» Transport

» Application

Reliability is the responsibility of the Transport layer
Question No: 48 ( Marks: 1) - Please choose one

TCP uses mechanism to control the flow of data.
» door

» window

» acknowledgment

» retransmission

TCP uses window mechanism to control the flow of data.
Question No: 49 ( Marks: 1) - Please choose one

The time for acknowledgement to arrival of packet depends on.
» Distance to destination and Current traffic conditions
» Current traffic conditions

» Distance to destination

» non of these

The time for acknowledgement to arrive depends on:

» Distance to destination



« Current traffic conditions

Question No: 50 ( Marks: 1) - Please choose one

FDDI can transmits data at a rate of ----------

» 100 million bits per second

» 10 million bits per second

» 1000 million bits per second

» None of the given

FDDI: Fiber distributed data interconnect (FDDI) is another ring
technology. lts most

important features are:

Total Question 40

30 MCQs
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some mcqs given below

1) When an application--------------- data, it makes a copy of the
data available to all other computers on the network.

» Broadcasting
» Multicasting
» Unicasting

» None of the given

2) Ethernet uses a ------ bit static addressing scheme in which each
device is assigned a unique address by the manufacturer.

» 64

> 48

» 32

» 8



3) The product of delay and throughput measures the of
data that can be present on the network.

» Area

» Volume (supposition)

» Length
» None of the given

4) Connectionless service, Message-Oriented protocol, best effort
delivery service, arbitrary interaction and operating system
independent are the characteristics of

» TCP
» UDP
» IP

» None of the given
5) uses distance vector approach to define routing
» BGP
» OSPF
» RIP

» None of the given

6) Whenever it handles a packet, |P software needs to separate
the destination address into a and

» postfix, Infix
» non of these
» Infix, prefix

» prefix, suffix




7) ARP is almost always used to bind a ___ -bit IP address to a
____-bit Ethernet address.

> 32,48
> 24, 32
> 32, 64
» 32, 128

8) Which method of Address Resolution Protocol is useful with any
hardware?

Were "T" stands for Table lookup, "C" for Closed-form
Computation and "D" for Data Exchange?

> T

» C (Supposition)
» D

» C,D

9) In which method of Address Resolution Protocol the protocol
address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form
Computation and "D" for Data Exchange?

> T
» D
» C
» T,C

10 )We use the term to refer to a measure of the path that
routing software use when choosing a route.

» routing path



» routing metric

» routing
» switching

11) A network uses a ------ arranges for computers to be connected
in a closed loop.

» Star Topology
» Ring Topology

» Bus Topology
» None of the given

12) An interface for thin Ethernet must have an
connector , and must generate signals according to
the specification.

» RJ-45.10 Base T
» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T

13) protocols of TCP/IP layering model specify how to
ensure reliable transfer.

» Physical Layer
» Network Interface Layer
» Internet Layer

» Transport Layer

14) uses distance vector approach to define routing
» BGP




» OSPF
» RIP

» None of the given
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Question No: 1 ( Marks: 1) — Please choose one

Computer networks are often called ———- because they usepacket technology.
» Ethernet

» Switch networks

» Packet networks

» None of the given

Question No: 2 ( Marks: 1 ) — Please choose one

A network uses a ——arranges for computers to be connected in a closed loop.
» Star Topology

» Ring Topology

» Bus Topology

» None of the given

In a ring topology each computer is connected to other thorough a ring
Question No: 3 ( Marks: 1 ) — Please choose one

An ————method, the network hardware designers specify how type information is included in the frame and the value
use to identify variousframe types.

» Explicit frame type

» Ideal frame type

» Implicit frame type

» None of the given

EXPLICIT FRAME TYPE:

In this type the identifying value is included with frame describes types of
included data.

Question No: 4 ( Marks: 1 ) — Please choose one

An interface for thin Ethernet must havean connector , and must generate signals according to
the specification.

» RJ-45, 10 Base T
» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T

Question No: 5 ( Marks: 1 ) — Please choose one


http://vuhelp.com/blog/author/vuhelp/

A Bridge forwards or filters a frame by comparing the information in its address table to the frame’s
» Layer 2 source address

» Source node’s physical address

» Layer 2 destination address

» Layer 3 destination address

Question No: 6 ( Marks: 1 ) — Please choose one

Most WAN systems include a mechanism that can be used to eliminate the common case of duplication routing is
called

» Hierarchal address

» Default route

» Shortest path

» None of the given

Question No: 7 ( Marks: 1 ) — Please choose one
________ of TCP/IP layering model, corresponds to basic network hardware.
» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer

LAYER 1:

Corresponds to basic network hardware layer in OSI

Question No: 8 ( Marks: 1 ) — Please choose one

_______ protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer

Fourth layer which is transport layer will take care of reliable transfer

Question No: 9 ( Marks: 1) — Please choose one

________ is called an end-to-end protocol because it provide a connection directly from an application on one computer
to an application on a remote computer.

» IP

» UDP

» TCP

» None of the given

UDP has the following characteristics.

It is an end-to-end protocol. It provides application-to-application communication.
http://vuzs.net/

Question No: 10 ( Marks: 1 ) — Please choose one http://www.vuzs.net/

uses distance vector approach to define routing


http://vuzs.net/

» None of the given

DISTANCE-VECTOR ROUTING:

e It is very simple to implement.

* Packet switch updates its own routing table first.
e It is used in RIP

Question No: 11 ( Marks: 1 ) — Please choose one

_______ is ideal in a situation where the group is small and all members are attached to contiguous Local Area
Networks.

» Flood-and -Prune

» Configuration-and -Tunneling

» Core-Based Discovery

» None of the given

FLOOD-AND-PRUNE:

Flood-and-prune is ideal in a situation where the group is small and all members

are attached to contiguous Local Area Networks.
Question No: 12 ( Marks: 1 ) — Please choose one

Router that decrements TTL to __ sends ICMP time exceeded message, with router’s address as source address

» 0

outer that decrements TTL to O sends ICMP time exceeded message, with router’s
address as source address

Question No: 13 ( Marks: 1 ) — Please choose one

Protocol addresses are abstractions provided by . http://www.vuzs.net/

» hardware

» software

» operating system

» internet

PROTOCOL ADDRESSES AND PACKET DELIVERY:
Protocol addresses are abstractions provided by software
Question No: 14 ( Marks: 1 ) — Please choose one
Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.
» True

» False

CASHING ARP RESPONSES:

Although message exchange can be used to bind addresses, sending a request for

each binding is hopelessly inefficient

Question No: 15 ( Marks: 1 ) — Please choose one

ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.

> 32,48

» 24, 32



» 32, 64

» 32,128

ARP is almost always used to bind a 32-bit IP address to a 48-bit Ethernet address
Question No: 16 ( Marks: 1 ) — Please choose one

In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island.
Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and
computers.

» False

» True

Question No: 17 ( Marks: 1 ) — Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were “T” stands for Table lookup, “C” for Closed-form Computation and “D” for Data Exchange?

Features Types of > T
) )
Resolution

» C
Use full with any hardware T

» T, C
Address change affects all hosts T Question No: 18 ( Marks: 1) — Please choose one

- - The general form of an IP datagram is with a header

Protocol address is determined by C followed by data. The header contains information that
hardware address controls where and how the datagram is to be sent.

» True
» False

Header contains all information needed to deliver datagram to the destination
computer. It contains:

e Destination address

e Source address

e Identifier

e Other delivery information

Question No: 19 ( Marks: 1 ) — Please choose one

To save traffic, an EGP does not summarize routing information from the autonomous system before passing it to
another autonomous system.

» True

» False

Question No: 20 ( Marks: 1 ) — Please choose one

Which of the following is a correct representation of the IPv6?

» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255
» 105.220.136.100.255.255.255.256.0.0.18.128.140.10.255.255

» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255.256


http://www.vuzs.net/

A - relies on the hardware manufacturer to assign a unique physical address to each network
interface.

» Static addressing scheme

» Configurable addressing scheme

» Dynamic addressing scheme

» None of the given

Question No: 2 (Marks: 1) - Please choose one

An interface for thin Ethernet must have an connector , and must generate signals
according to the specification.

» RJ-45,10 Base T

» RJ-45, 10 Base 5



» BNC, 10 Base 2

» BNC, 10 Base T

Question No: 3  ( Marks: 1) - Please choose one

A system with redundant bridges might have a problem with

» Loop

» Filters

» Spanning Trees

» All given choices

Question No: 4  ( Marks: 1) - Please choose one

in the system.

A Bridge can



» Filter a frame

» Forward a frame

» Extend a LAN

» Do all the above

Question No: 5  ( Marks: 1) - Please choose one

is used for typical data applications (where the data rate may be unknown and bursty)
and allows use of whatever bandwidth is available at a given time.

» Constant Bit Rate (CBR) service

» Variable Bit Rate (VBR) service

» Available Bit Rate (ABR) service

» None of the given

Question No: 6  ( Marks: 1) - Please choose one




ATM assigns each VC a identifier that is divided two parts to produce a hierarchy.

» 21-bit

» 22-bit

» 23-bit

> 24-bit

Question No: 7  (Marks: 1) - Please choose one

of TCP/IP layering model, corresponds to basic network hardware.

» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer



Question No: 8 ( Marks: 1) - Please choose one

places the boundary between the second and third octets

» Class A

» Class B

» Class C

» Class D

Question No: 9  (Marks: 1) - Please choose one

UDP and TCP are both layer protocols

» Physical

» Data link



» Network

» Transport

Question No: 10  ( Marks: 1) - Please choose one

Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided
by

» IP

» None of the given

» TCP

» UDP

Question No: 11  ( Marks: 1) - Please choose one

protocols of TCP/IP layering model specify how to ensure reliable transfer.



» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer

Question No: 12  ( Marks: 1) - Please choose one

identifies which application program on receiving computer should receive the data

» Logical address

Source port

Logical address

None of the given

» Source port

» Destination Port

» None of the given



Question No: 13  ( Marks: 1) - Please choose one

identifies the application program that sent the data.

» Destination Port

» Source port

» Logical address

» None of the given

Question No: 14  ( Marks: 1) - Please choose one

Which of the following are interior routing protocols?

» RIP

» OSPF



» BGP

» RIP and OSPF

Question No: 15  ( Marks: 1) - Please choose one

The Border Gateway Protocol (BGP) uses for all communication

» UDP

» TCP

» Both UDP and TCP

» None of the given

Question No: 16  ( Marks: 1) - Please choose one




measures distance in network hops, where each network between the source and destination
counts as single hop.

» BGP

» OSPF

> RIP

» None of the given

Question No: 17  ( Marks: 1) - Please choose one

OSPF is based on--------

» Distance vector routing

» Link state routing

» Path vector routing

» Distance vector routing and Link state routing



Question No: 18 ( Marks: 1) - Please choose one

performs local multicast and uses IP-in-IP encapsulation to send multicast datagrams from
one site on the Internet to another.

» Distance Vector Multicast Routing Protocol (DVMRP)

» Core Based Trees (CBT)

» Protocol Independent Multicast_ Sparse Mode (PIM-SM)

» Protocol Independent Multicast _ Dense Mode (PIM-DM)

Question No: 19  ( Marks: 1) - Please choose one

The length of time required to send a variable length packet is variable and does not require a complicated
interrupt scheme to detect completion of transmission.



» True

» False

Question No: 20  ( Marks: 1) - Please choose one

NEXT HEADER field in the base header defines type of header and it appears at end of fixed-size base
header.

» True

» False

Question No: 21  ( Marks: 1) - Please choose one

Although message exchange can be used to bind addresses, sending a request for each binding is
hopelessly inefficient.

» True

» False



Question No: 22  ( Marks: 1) - Please choose one

Address mask defines how many bits of address are in suffix?

» True

» False

Question No: 23  ( Marks: 1) - Please choose one

A computer attached to a given network can only communicate with other computers attached to
the same network. Is this a problem with multiple networks?

» True

» False

Question No: 24  ( Marks: 1) - Please choose one




In the 1970s large organizations began to acquire multiple networks. Each network in the
organization formed island. Employees needed to choose a computer appropriate for each task.
So they needed multiple screens, keyboards and computers.

» False

» True

Question No: 25 ( Marks: 1) - Please choose one

The term self-identifying is used for Classful IP addresses because the class of the address can be
computed from the address

» itself

» prefix

» suffix

» mask



Question No: 26  ( Marks: 1) - Please choose one

In which method of Address Resolution Protocol the protocol address independent of hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

»T,C

» D

» C

»T,D

Question No: 27  ( Marks: 1) - Please choose one

In which method of Address Resolution Protocol the protocol address is determined by hardware address?
vuattach.ning.com

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T

» D



» C

»T,C

Question No: 28  ( Marks: 1) - Please choose one

Reconstruction of original datagram is called reassembly.

» True

» False

Question No: 29  ( Marks: 1) - Please choose one

A computer needs a complete stack of protocols to run either a client or a server.

» True

» False



Question No: 30  ( Marks: 1) - Please choose one

TCP uses mechanism to control the flow of data.

» door

» window

» acknowledgment

» retransmission

FINALTERM EXAMINATION
CS610- Computer Network
Time: 120 min

Marks: 70

Question No: 1  ( Marks: 1) - Please choose one

The number of connections needed for N computer in direct point to point communication is equal to:



> (N*-N)/2

» N(N- 1)

> N°

» None of the given

Question No: 2 (Marks: 1) - Please choose one

When an application--------------- data, it makes a copy of the data available to all other computers on the
network.

» Broadcasting

» Multicasting

» Unicasting

» None of the given



One repeater , two repeaters the maximum cable length limitation.

» doubles, cancel

» doubles, triple

» square roots, cude roots

» and, triple

Question No: 12  ( Marks: 1) - Please choose one

Whenever it handles a packet, IP software needs to separate the destination address into a and

» postfix, Infix

» non of these

» Infix, prefix

» prefix, suffix



Ref No: 1578657
Time: 90 min
Marks: 60

Question No: 1  (Marks: 1) - Please choose one

A

---------- relies on the hardware manufacturer to assign a unique physical address to each network
interface.

» Static addressing scheme
» Configurable addressing scheme
» Dynamic addressing scheme

» None of the given
Question No: 2  ( Marks: 1) - Please choose one

An
interface for thin Ethernet must have an connector , and must generate signals according
to the specification.

» RJ-45,10 Base T

» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T

Question No: 3  ( Marks: 1) - Please choose one

system with redundant bridges might have a problem with in the system.
» I.oop
» Filters
» Spanning Trees
» All given choices
Question No: 4  (Marks: 1) - Please choose one

A Bridge can



» Filter a frame

» Forward a frame

» Extend a LAN

» Do all the above

Question No: 5  ( Marks: 1) - Please choose one

is used for typical data applications (where the data rate may be unknown and bursty)
and allows use of whatever bandwidth is available at a given time.
» Constant Bit Rate (CBR) service

» Variable Bit Rate (VBR) service
» Available Bit Rate (ABR) service
» None of the given

Question No: 6  ( Marks: 1) - Please choose one

ATM
assigns each VC a identifier that is divided two parts to produce a hierarchy.

» 21-bit
» 22-bit
» 23-bit
» 24-bit

Question No: 7  ( Marks: 1) - Please choose one

of TCP/IP layering model, corresponds to basic network hardware.

» Physical Layer

» Network Interface Layer
» Internet Layer
» Transport Layer
Question No: 8 ( Marks: 1) - Please choose one
places the boundary between the second and third octets

» Class A



» Class B
» Class C
» Class D

Question No: 9  ( Marks: 1) - Please choose one

UDP and TCP are both layer protocols
» Physical
» Data link
» Network
» Transport
Question No: 10  ( Marks: 1) - Please choose one

Conn

ection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided
by

» 1P
» None of the given
__» TCP
» UDP
Question No: 11  ( Marks: 1) - Please choose one
protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
» Internet Layer

» Transport Layer

Question No: 12  ( Marks: 1) - Please choose one

identifies which application program on receiving computer should receive the data

» Logical address



Source port
Logical address

None of the give

» Source port

» Destination Port

» None of the given

Question No: 13  ( Marks: 1) - Please choose one

identifies the application program that sent the data.

» Destination Port

» Source port

» Logical address
» None of the given

Question No: 14  ( Marks: 1) - Please choose one

h of the following are interior routing protocols?
> RIP
» OSPF
» BGP

» RIP and OSPF

Question No: 15  ( Marks: 1 ) -www.vustudents.ning.com Please choose one

Border Gateway Protocol (BGP) uses for all communication

» UDP
» TCP
» Both UDP and TCP

» None of the given

Whic

The



Question No: 16  ( Marks: 1) - Please choose one

measures distance in network hops, where each network between the source and destination
counts as single hop.

» BGP

» OSPF

> RIP

» None of the given

Question No: 17  ( Marks: 1) - Please choose one

OSPF
is based on--------

» Distance vector routing

» Link state routing

» Path vector routing

» Distance vector routing and Link state routing

Question No: 18 ( Marks: 1) - Please choose one

performs local multicast and uses IP-in-IP encapsulation to send multicast datagrams from one site
on the Internet to another.

» Distance Vector Multicast Routing Protocol (DVMRP)

» Core Based Trees (CBT)

» Protocol Independent Multicast_ Sparse Mode (PIM-SM)

» Protocol Independent Multicast _ Dense Mode (PIM-DM)
Question No: 19  ( Marks: 1) - Please choose one

The length of time required to send a variable length packet is variable and does not require a complicated
interrupt scheme to detect completion of transmission.

» True

» False
Question No: 20  ( Marks: 1) - Please choose one



NEX
T HEADER field in the base header defines type of header and it appears at end of fixed-size base header.

» True
» False
Question No: 21  ( Marks: 1) - Please choose one

Altho
ugh message exchange can be used to bind addresses, sending a request for each binding is hopelessly
inefficient.

» True
» False
Question No: 22  ( Marks: 1) - Please choose one
Address mask defines how many bits of address are in suffix?
» True
» False
Question No: 23  ( Marks: 1) - Please choose one

A computer attached to a given network can only communicate with other computers attached to
the same network. Is this a problem with multiple networks?
> True

» False

Question No: 24  ( Marks: 1) - Please choose one

In

the 1970s large organizations began to acquire multiple networks. Each network in the
organization formed island. Employees needed to choose a computer appropriate for each

task. Sothey needed multiple screens, keyboards and computers.
» False
» True

Question No: 25  ( Marks: 1) - Please choose one

The
term self-identifying is used for Classful IP addresses because the class of the address can be computed
from the address




> itself
» prefix
» suffix
» mask
Question No: 26  ( Marks: 1) - Please choose one

In
which method of Address Resolution Protocol the protocol address independent of hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T,C
» D
» C

» T.D

Question No: 27  ( Marks: 1) - Please choose one

In
which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

» T
» D
» C
» T,C
Question No: 28  ( Marks: 1) - Please choose one

Reco

nstruction of original datagram is called reassembly.
» True
» False

Question No: 29  ( Marks: 1) - Please choose one



computer needs a complete stack of protocols to run either a client or a server.
» True
» False

Question No: 30  ( Marks: 1) - Please choose one

uses mechanism to control the flow of data.
» door
» window
» acknowledgment
» retransmission

FINALTERM EXAMINATION

Question No: 1  ( Marks: 1) - Please choose one

Computer networks are often called -------------- because they use packet technology.

» Ethernet
» Switch networks
» Packet networks

» None of the given

Question No: 2  (Marks: 1) - Please choose one
A network uses a ------ arranges for computers to be connected in a closed loop.
» Star Topology
> Ring Topology
» Bus Topology
» None of the given
In a ring topology each computer is connected to other thorough a ring

Question No: 3  ( Marks: 1) - Please choose one

TCP



An - method, the network hardware designers specify how type information is included in the
frame and the value use to identify various frame types.

» Explicit frame type

» Ideal frame type
» Implicit frame type
» None of the given
EXPLICIT FRAME TYPE:
In this type the identifying value is included with frame describes types of
included data.
Question No: 4  ( Marks: 1) - Please choose one

An interface for thin Ethernet must have an connector , and must generate signals
according to the specification.

> RJ-45, 10 Base T (reference not available)
» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T
Question No: 5  ( Marks: 1) - Please choose one

A Bridge forwards or filters a frame by comparing the information in its address table to the
frame’s

» Layer 2 source address
» Source node’s physical address
> Layer 2 destination address _ (not confirm)
» Layer 3 destination address
Question No: 6  ( Marks: 1) - Please choose one

Most WAN systems include a mechanism that can be used to eliminate the common case of duplication
routing is called

» Hierarchal address
» Default route

» Shortest path



» None of the given

Most WAN systems include a mechanism that can be used to eliminate the common case of duplication
routing is called Default route. The mechanism allows a single entry in a forwarding table to replace a
long list of entries that have the same next hope value

Question No: 7  ( Marks: 1) - Please choose one
of TCP/IP layering model, corresponds to basic network hardware.

» Physical Laver

» Network Interface Layer
» Internet Layer
» Transport Layer
LAYER 1:
Corresponds to basic network hardware layer in OSI
Question No: 8  ( Marks: 1) - Please choose one
protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
» Internet Layer
» Transport Layer

The Internet layer in the TCP/IP reference model is responsible for transferring data between the source
and destination computers

Question No: 9  ( Marks: 1) - Please choose one

is called an end-to-end protocol because it provide a connection directly from an application on
one computer to an application on a remote computer.

> [P
» UDP
» TCP
» None of the given
UDP has the following characteristics.

It is an end-to-end protocol. It provides application-to-application communication.



Question No: 10  ( Marks: 1) - Please choose one
uses distance vector approach to define routing
» BGP
» OSPF
» RIP
» None of the given
DISTANCE-VECTOR ROUTING:
* It is very simple to implement.
* Packet switch updates its own routing table first.
* It is used in RIP.
Question No: 11  ( Marks: 1) - Please choose one

is ideal in a situation where the group is small and all members are attached to contiguous
Local Area Networks.

» Flood-and -Prune
» Configuration-and -Tunneling
» Core-Based Discovery

» None of the giveOO6E
FLOOD-AND-PRUNE:

Flood-and-prune is ideal in a situation where the group is small and all members
Are attached to contiguous Local Area Networks.
Question No: 12 ( Marks: 1) - Please choose one

Router that decrements TTL to __ sends ICMP time exceeded message, with router’s address as source
address

>3
> 2
> 1
> 0
Router that decrements TTL to 0 sends ICMP time exceeded message, with router’s

address as source address



Question No: 13  ( Marks: 1) - Please choose one
Protocol addresses are abstractions provided by
» hardware

» software

» operating system

» internet
PROTOCOL ADDRESSES AND PACKET DELIVERY:
Protocol addresses are abstractions provided by software
Question No: 14  ( Marks: 1) - Please choose one

Although message exchange can be used to bind addresses, sending a request for each binding is
hopelessly inefficient.

> True
» False
CASHING ARP RESPONSES:
Although message exchange can be used to bind addresses, sending a request for

each binding is hopelessly inefficient
Question No: 15  ( Marks: 1) - Please choose one

ARP is almost always used to bind a ___ -bit IP address to a ___-bit Ethernet address.

> 32,48

> 24,32

> 32,64

» 32,128
ARP is almost always used to bind a 32-bit IP address to a 48-bit Ethernet address
Question No: 16  ( Marks: 1) - Please choose one

In the 1970s large organizations began to acquire multiple networks. Each network in the organization
formed island. Employees needed to choose a computer appropriate for each task. So they needed
multiple screens, keyboards and computers.

» False

» True



In the 1970s large organizations began to acquire multiple networks. Each

network in the organization formed island. Employees needed to choose a

computer appropriate for each task. So they needed multiple screens, keyboards

and computers.

Question No: 17  ( Marks: 1 ) www.vustudents.ning.com - Please choose one

In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T

ypes of

Features

>D esolution

» C

» T, C Use full with any hardware T
Address change affects all hosts T
Protocol address is determined by C
hardware address

Question No: 18  ( Marks: 1) - Please choose one

The general form of an IP datagram is with a header followed by data. The header contains information
that controls where and how the datagram is to be sent.

» True
» False

. Header contains all information needed to deliver datagram to the destination
computer. It contains:

* Destination address
* Source address
* Identifier

* Other delivery information



Question No: 19  ( Marks: 1) - Please choose one

To save traffic, an EGP does not summerize routing information from the autonomous system before
passing it to another autonomous system.

» True

» False
"It provides routing among autonomous systems (EGP).
Question No: 20  ( Marks: 1) - Please choose one
Which of the following is a correct representation of the [Pv6?

» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255

» 105.220.136.100.255.255.255.256.0.0.18.128.140.10.255.255
» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255.256

» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255
128-bit addresses unwidely in dotted decimal; requires 16 numbers:

105.220.136.100.255.255.255.255.0.0.18
FINALTERM EXAMINATION
Fall 2008
CS610- Computer Network

Ref No: 325624
Time: 120 min
Marks: 70

Question No: 1  ( Marks: 1) - Please choose one

The number of connections needed for N computer in direct point to point communication is equal to:

> (N°-N)/2

> N(N-1)
> N’
» None of the given

For ‘n’ computers connections in direct point to point communication = (n’2 —n)/2.



Question No: 2 (Marks: 1) - Please choose one

When an application--------------- data, it makes a copy of the data available to all other computers on the
network.

» Broadcasting
» Multicasting
» Unicasting

» None of the given (not sure)

Question No: 3  (Marks: 1) - Please choose one

Ethernet uses a ------ bit static addressing scheme in which each device is assigned a unique address by
the manufacturer.

> 64
> 48
> 32
> 38
Ethernet uses a 48-bit static addressing scheme
Question No: 4  ( Marks: 1) - Please choose one
A system with redundant bridges might have a problem with in the system.
» I.oop
» Filters
» Spanning Trees
» All given choices
Reference not available
Question No: 5  ( Marks: 1) - Please choose one
The product of delay and throughput measures the ______ of data that can be present on the network.
> Area
» Volume
» Length

» None of the given



It is computed as delay time multiplied by effective throughput. It measures amount of data that can be
present in the network

Question No: 6  ( Marks: 1) - Please choose one

Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction and
operating system independent are the characteristics of

» TCP
—__» UDP
» 1P
» None of the given
UDP has the following characteristics.
« It is an end-to-end protocol. It provides application-to-application communication.
« It provides connectionless service.
« It is a Message-Oriented protocol.
* It uses best-effort delivery service.
« It follows arbitrary interaction.

« It is operating system independent
Question No: 7  (Marks: 1) - Please choose one

Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided
by

» None of the given
> TCP
» UDP
» IP
SERVICE PROVIDED BY TCP:
Following are the services provided by TCP:
* Connection-oriented service
* Point-to-point
» Complete reliability

* Full-duplex communication



* Stream interface
* Reliable connection startup
* Graceful connection shutdown
Question No: 8  ( Marks: 1) - Please choose one
The process of using a routing table to select a next hop for a given datagram is called
» Encapsulation
» Reassembling
» Routing or forwarding
» None of the given
Reference not available
Question No: 9  ( Marks: 1) www.vustudents.ning.com - Please choose one
uses distance vector approach to define routing
» BGP
» OSPF
> RIP
» None of the given
DISTANCE-VECTOR ROUTING:
« It is very simple to implement.
* Packet switch updates its own routing table first.
o It is used in RIP.
Question No: 10  ( Marks: 1) - Please choose one

A multicast routing scheme in which the protocol software builds a delivery tree from a central point is
called

» Distance Vector Multicast Routing Protocol (DVMRP)
» Core Based Trees (CBT)
» Protocol Independent Multicast_ Sparse Mode (PIM-SM)

» Protocol Independent Multicast _ Dense Mode (PIM-DM)



CORE BASED TREES (CBIT):
A multicast routing scheme in which the protocol software builds a delivery tree

from a central point.

Question No: 11  ( Marks: 1) - Please choose one

One repeater , two repeaters the maximum cable length limitation.
» doubles, cancel

» doubles, triple

» square roots, cude roots

» and, triple
One repeater doubles, two repeaters triple the maximum cable length limitation.
Question No: 12  ( Marks: 1) - Please choose one

Whenever it handles a packet, IP software needs to separate the destination address into a and

» postfix, Infix
» non of these
» Infix, prefix

» prefix, suffix

Whenever it handles a packet, IP software needs to separate the destination address into a prefix and

suffix
Question No: 13  ( Marks: 1) - Please choose one

Although message exchange can be used to bind addresses, sending a request for each binding is
hopelessly inefficient.

» True
» False
CASHING ARP RESPONSES:
Although message exchange can be used to bind addresses, sending a request for
each binding is hopelessly inefficient.
Question No: 14  ( Marks: 1) - Please choose one

ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.



> 32,48

> 24, 32

> 32,64

> 32,128
ARP is almost always used to bind a 32-bit IP address
to a 48-bit Ethernet address
Question No: 15  ( Marks: 1) - Please choose one
End-to-end delivery service is connection oriented.

» True

» False

End-to-end delivery service is connection less
Question No: 16  ( Marks: 1) - Please choose one

A single networking technology is best for all needs.

» True

» False

There is no single networking technology that is best for all needs
Question No: 17  ( Marks: 1) - Please choose one

In the 1970s large organizations began to acquire multiple networks. Each network in the organization
formed island. Employees needed to choose a computer appropriate for each task. So they needed
multiple screens, keyboards and computers.

» False

> True
In the 1970s large organizations began to acquire multiple networks. Each network in the organization
formed island. Employees needed to choose a computer appropriate for each task. So they needed
multiple screens, keyboards and computers.

Question No: 18  ( Marks: 1) - Please choose one

Which method of Address Resolution Protocol is useful with any hardware?



Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

e Features ypes of
» C .
esolution
» D
Use full with any hardware T
» C,D
Address change affects all hosts T
Protocol address is determined by C
hardware address

Question No: 19  ( Marks: 1) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T Features ypes of
» D esolution
__»C Use full with any hardware T
> T, C Address change affects all hosts T
Protocol address is determined by C
hardware address

Question No: 20  ( Marks: 1) - Please choose one

We use the term to refer to a measure of the path that routing software use when choosing a
route.

» routing path

» routing metric

» routing

switching



We use the termrouting metric to refer to a measure of the path that routing software use when choosing
a route

CS610- Computer Network

Question No: 1 ( Marks: 1) - Please choose one

In Direct point to point communication adding the Nth computer requires------------ new connections.

» None of the given

> N2

> N-1

> (N2 -N)/2

disadvantage In Direct point to point communication is that adding a new computer to the network requires N-
1 new connections .(P# 23)

Question No: 2 ( Marks: 1) - Please choose one

In Point-to-Point topology there are two topologies.

» Tree and Ring

» Star and Ring

> Star and Tree

» None of the given
POINT-TO-POINT:

In Point-to-Point topology there are two topologies.
1) STAR topology

2) TREE topology
Question No: 3 ( Marks: 1) - Please choose one

BORDER GATEWAY PROTOCOL:

It is most popular Exterior Gateway Protocol in Internet. It has following characteristics:
"It provides routing among autonomous systems (EGP).

"It provides policies to control routes advertised.

"It uses reliable transport (TCP).

Unicast: It is used for single destination computer.
Multicast: It is used for multiple destinations; possibly not at same site.
Cluster: This type of address is used for collection of computers with same prefix,

datagram is delivered to one out of cluster.

Question No: 45 ( Marks: 1) - Please choose one

Special types of addresses in IPv6 used for multiple destinations; possibly not at same site. Are known
as



» Unicast

» Anycast

» Multicast

» Non of the given

Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.
Multicast: It is used for multiple destinations; possibly not at same site.
Cluster: This type of address is used for collection of computers with same prefix,

datagram is delivered to one out of cluster.

Question No: 46 ( Marks: 1) - Please choose one

UDP offers application programs a Message-Oriented Interface, applications can depend on protocol to
preserve data boundaries.

» True

» False

UDP offers application programs a Message-Oriented Interface. It does not divide messages into packets for
transmission and does not combine messages for delivery.

ADVANTAGES:

* Applications can depend on protocol to preserve data boundaries.
Question No: 47 ( Marks: 1) - Please choose one
Reliability is the responsibility of the layer

» Network

» Datalink

» Transport

» Application

Reliability is the responsibility of the Transport layer
Question No: 48 ( Marks: 1) - Please choose one

TCP uses mechanism to control the flow of data.

» door

> window

» acknowledgment

P retransmission

TCP uses window mechanism to control the flow of data.
Question No: 49 ( Marks: 1) - Please choose one

The time for acknowledgement to arrival of packet depends on.
> Distance to destination and Current traffic conditions
» Current traffic conditions

» Distance to destination

» non of these

The time for acknowledgement to arrive depends on:

* Distance to destination

* Current traffic conditions
Question No: 50 ( Marks: 1) - Please choose one



FDDI can transmits data at a rate of ----------

» 100 million bits per second
» 10 million bits per second

» 1000 million bits per second
» None of the given
FDDI: Fiber distributed data interconnect (FDDI) is another ring technology. Its most

important features are:

It uses fiber optics between stations and transmits data at 100Mbps.

___» C (Suppeosition)

» D
» C,D

9) In which method of Address Resolution Protocol the protocol address is determined by hardware
address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
> T
» D
» C
» T,C

10 )We use the term to refer to a measure of the path that routing software use when choosing a

route.
» routing path
> routing metric
» routing
» switching
11) A network uses a ------ arranges for computers to be connected in a closed loop.

» Star Topology



» Ring Topology

» Bus Topology
» None of the given

12) An interface for thin Ethernet must have an connector , and must generate signals
according to the specification.

» RJ-45,10 Base T

» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T
13) protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
» Internet Layer
» Transport Layer
14) uses distance vector approach to define routing
» BGP
» OSPF
» RIP

» None of the given

Fall 2008

1) When an application--------------- data, it makes a copy of the data available to all other computers on
the network.



» Broadcasting

» Multicasting
» Unicasting
» None of the given

2) Ethernet uses a ------ bit static addressing scheme in which each device is assigned a unique address by
the manufacturer.

> 64
> 48
> 32
> 8
3) The product of delay and throughput measures the ______ of data that can be present on the network.
> Area
P> Volume (suppeosition)
» Length
» None of the given

4) Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction
and operating system independent are the characteristics of

» TCP
___» UDP
> IP
» None of the given
5) uses distance vector approach to define routing
» BGP

» OSPF



» RIP
» None of the given

6) Whenever it handles a packet, IP software needs to separate the destination address into a
and

» postfix, Infix
» non of these
» Infix, prefix
> prefix, suffix
7) ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.

» 32,48

> 24, 32
» 32,64
» 32,128
8) Which method of Address Resolution Protocol is useful with any hardware?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
> T

Question No: 1  ( Marks: 1) - Please choose one

encapsulates IP datagram as data area in hardware frame.

Network Interface Layer
Datalink Layer
Network Layer

A w b

None of the given



Question No: 2 ( Marks: 1) - Please choose one

field is used to identify a specific path through the network

FLOW LABEL
TRAFFIC CLASS
Both aand b
none of the given

AN

Question No: 3  ( Marks: 1) - Please choose one

IPV6 address with leading zeros is interpreted to hold an IPV4 address.
1. 96
2. 100
3. 120
4. none of the given

Question No: 4  ( Marks: 1) - Please choose one

Although the ARP message format is sufficiently general to allow arbitrary protocol and hardware
addresses. ARP is almost always used to bind a 32-bit IP address to a Ethernet address.

1. Answer (48bit)

Question No: 5  ( Marks: 1) - Please choose one

For , information about forwarding is stored in a routing table, which is initialized at

system initialization and must be updated as network topology changes.

1. Efficiency



2. Security
3. Accuracy
4. Anomalies

Question No: 6  ( Marks: 1) - Please choose one

is a technique used to Limit datagram size to small MTU of any network

Segmentation
Fragmentation
Encapsulation

A w bRk

none of the given

Question No: 7  ( Marks: 1) - Please choose one

Class A mask is 255.0.0.0 which is used for

Unicasting
Multicasting
Subnetting

All of the given

P w NP

Question No: 8  ( Marks: 1) - Please choose one

When one computer sends an ARP message to another the message travels inside the hardware frame.
Technically, placing a message inside a frame for transport is not called encapsulation.

1. True
2. False

Question No: 9  ( Marks: 1) - Please choose one




Which one of these is not a main feature of connectionless service:

1. Itincludes extension of LAN abstraction.
It has
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P Select correct option:
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P select correct option:
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For , information about forwarding is stored in a routing table, which is initialized at system initialization
and must be updated as network topology changes.

P select correct option:
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places the boundary between the first and second octets

P Select correct option:
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TCP/IP defines the term to refer any computer system that connects to an internet and runs applications

P select correct option:
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contains all information needed to deliver datagram to the destination.

P select correct option:
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The Internet service providers coordinate with the Internet assigned number authority to obtain their network numbers.

P select correct option:
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Although the ARP message format is sufficiently general to allow arbitrary protocol and hardware addresses. ARP is
almost always used to bind a 32-bit IP address to a Ethernet address.

P select correct option:
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The Current version of IP-Version 4 is old

P select correct option:
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Quiz Start Time: 11:47 AM
Question # 13 of 15 ( Start time: 11:55:16 AM ) Total Marks: 1

Whenever it handles a packet, IP software needs to separate the destination address into a prefix.

P select correct option:
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Time
Left sec( <

s)

Quiz Start Time: 11:47 AM

Question # 14 of 15 ( Start time: 11:56:03 AM ) Total Marks: 1

When one computer sends an ARP message to another the message travels inside the hardware frame. Technically,
placing a message inside a frame for transport is not called encapsulation.

P Select correct option:

MC100201881 : Ayesha Rafi 69

Time
Left sec( t

s)

Quiz Start Time: 11:47 AM

Question # 15 of 15 ( Start time: 11:56:43 AM ) Total Marks: 1

In , the protocol address assigned to a computer is chosen carefully so that computer’'s hardware
address can be computed from the protocol address using basic Boolean and arithmetic operations.

P select correct option:
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Time
Left sec( (‘

s)

Quiz Start Time: 12:01 PM

Question # 1 of 15 ( Start time: 12:01:47 PM) Total Marks: 1

There are three standard implementations to improve computational efficiency: Hashing, Direct Indexing and InDirect
Indexing

P select correct option:

Question No: 1  (Marks: 1) - Please choose one

encapsulates IP datagram as data area in hardware frame.



Network Interface Layer
Datalink Layer

Network Layer

None of the given

© N o U

Question No: 2 (Marks: 1) - Please choose one

field is used to identify a specific path through the network

FLOW LABEL
TRAFFIC CLASS
Bothaandb

none of the given

© N oo

Question No: 3 ( Marks: 1) - Please choose one

IPV6 address with leading zeros is interpreted to hold an IPV4 address.
5. 96
6. 100
7. 120
8. none of the given

Question No: 4  (Marks: 1) - Please choose one

Although the ARP message format is sufficiently general to allow arbitrary protocol and
hardware addresses. ARP is almost always used to bind a 32-bit IP address to a
Ethernet address.



2. Answer (48bit)

Question No: 5 (Marks: 1) - Please choose one

For

,information about forwarding is stored in a routing table, which is

initialized at system initialization and must be updated as network topology changes.

© N o g

Efficiency
Security
Accuracy
Anomalies

Question No: 6  ( Marks: 1) - Please choose one

© N o O

is a technique used to Limit datagram size to small MTU of any network

Segmentation

Fragmentation
Encapsulation
none of the given

Question No: 7 (Marks: 1) - Please choose one

Class A mask is 255.0.0.0 which is used for

© N oo

Unicasting
Multicasting
Subnetting
All of the given



Question No: 8 ( Marks: 1) - Please choose one

When one computer sends an ARP message to another the message travels inside the
hardware frame. Technically, placing a message inside a frame for transport is not called

encapsulation.

3. True
4. False

Question No: 9 (Marks: 1) - Please choose one

Which one of these is not a main feature of connectionless service:

2. It includes extension of LAN abstraction.

3. It has universal addressing and the data is delivered in packets frames), each with a
header

4. It combines collection of physical networks into a single virtual network.

5. It has universal addressing and the data is delivered in
packets frames), without a header

Question No: 10 ( Marks: 1) - Please choose one

Which protocol is used to test different tools.

1. ICMP
2. IGMP
3. TCP/IP



4. none of the given

Question No: 11  ( Marks: 1) - Please choose one

message is sent in response to incoming datagrams with problems.

TCP/IP
IGMP

ICMP

none of the given

M w DR

Question No: 12 ( Marks: 1) - Please choose one

Which one is NOT the function of ping program

Traceability

Reach ability
Both aand b
None of the given

M owbd P

Question No: 13  ( Marks: 1) - Please choose one

IPV6 address with leading zeros is interpreted to hold an IPV4 address.

96
100
120
none of the given

NN =



5.
Question No: 14 ( Marks: 1) - Please choose one

A datagram cannot be larger than of a network over which it is sent.
1. MTU
2. Size
3. IP header
4. None of the given

Question No: 15 (Marks: 1) - Please choose one

The Source can configure outgoing datagram'’s to avoid

Segmentation
Defragmentation
Fragmentation

None of the given

b P

Question No: 16  ( Marks: 1) - Please choose one

Which one of these is not a main feature of connectionless service:

1. It includes extension of LAN abstraction.

2. has universal addressing and the data is delivered in packets frames), each with a
header.

3. It combines collection of physical networks into a single virtual network.
It has universal addressing and the data is delivered in

packets frames), without a header.



Question No: 17 ( Marks: 1) - Please choose one

Every hardware technology specification includes the definition of the maximum size of the

frame data area, which is called the Transmission Unit

1. Least

2. Maximum
Fragment
4. Frame

w

Question No: 18 ( Marks: 1) - Please choose one

Protocol provides error reporting mechanism.

1. IGMP
SNMP

ICMP

4. none of the given

Question No: 19  (Marks: 1) - Please choose one

Source is responsible for fragmentation.

1. IPV4
2. IPV6



Question No: 20 ( Marks: 1) - Please choose one

MTU Stands for

1. Mininum transmission unit

2. Maximum transmission unit

3. Multicast transmission unit

4. None of the given
FINALTERM EXAMINATION
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Marks: 60
Question No: 1  ( Marks: 1) - Please choose one

A

---------- relies on the hardware manufacturer to assign a unique physical address to each network
interface.

» Static addressing scheme
» Configurable addressing scheme
» Dynamic addressing scheme

» None of the given
Question No: 2 (Marks: 1) - Please choose one



An
interface for thin Ethernet must have an connector , and must generate signals according
to the specification.

» RJ-45,10Base T

» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T

Question No: 3  ( Marks: 1) - Please choose one

system with redundant bridges might have a problem with in the system.
» I.oop
» Filters
» Spanning Trees
» All given choices
Question No: 4  ( Marks: 1) - Please choose one
A Bridge can
» Filter a frame
» Forward a frame
» Extend a LAN
» Do all the above
Question No: 5  ( Marks: 1) - Please choose one

is used for typical data applications (where the data rate may be unknown and bursty)
and allows use of whatever bandwidth is available at a given time.
» Constant Bit Rate (CBR) service

» Variable Bit Rate (VBR) service
» Available Bit Rate (ABR) service
» None of the given

Question No: 6  ( Marks: 1) - Please choose one



ATM

assigns each VC a identifier that is divided two parts to produce a hierarchy.

» 21-bit
» 22-bit
» 23-bit
> 24-bit

Question No: 7  ( Marks: 1) - Please choose one

of TCP/IP layering model, corresponds to basic network hardware.

» Physical Layver

» Network Interface Layer
» Internet Layer
» Transport Layer

Question No: 8 ( Marks: 1) - Please choose one

places the boundary between the second and third octets
> Class A
» Class B
» Class C
» Class D

Question No: 9  (Marks: 1) - Please choose one

UDP and TCP are both layer protocols

» Physical
» Data link
» Network

» Transport

Question No: 10  ( Marks: 1) - Please choose one



Conn

ection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided
by

» 1P
» None of the given
» TCP
» UDP
Question No: 11  ( Marks: 1) - Please choose one
protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
» Internet Layer

» Transport Layer

Question No: 12 ( Marks: 1) - Please choose one

____identifies which application program on receiving computer should receive the data
» Logical address

Source port

Logical address

None of the give

» Source port

» Destination Port

» None of the given
Question No: 13  ( Marks: 1) - Please choose one
identifies the application program that sent the data.

» Destination Port



» Source port

» Logical address
» None of the given

Question No: 14  ( Marks: 1) - Please choose one

h of the following are interior routing protocols?
» RIP
» OSPF
» BGP
» RIP and OSPF

Question No: 15  ( Marks: 1) - Please choose one

Border Gateway Protocol (BGP) uses for all communication
» UDP
» TCP
» Both UDP and TCP
» None of the given

Question No: 16  ( Marks: 1) - Please choose one

Whic

The

measures distance in network hops, where each network between the source and destination

counts as single hop.
» BGP
» OSPF
» RIP
» None of the given

Question No: 17  ( Marks: 1) - Please choose one

is based on--------

» Distance vector routing

OSPF



» Link state routing

» Path vector routing
» Distance vector routing and Link state routing

Question No: 18  ( Marks: 1) - Please choose one

performs local multicast and uses IP-in-IP encapsulation to send multicast datagrams from one site
on the Internet to another.

» Distance Vector Multicast Routing Protocol (DVMRP)

» Core Based Trees (CBT)

» Protocol Independent Multicast_ Sparse Mode (PIM-SM)

» Protocol Independent Multicast _ Dense Mode (PIM-DM)
Question No: 19  ( Marks: 1) - Please choose one

The length of time required to send a variable length packet is variable and does not require a complicated
interrupt scheme to detect completion of transmission.

» True

» False
Question No: 20  ( Marks: 1) - Please choose one

NEX
T HEADER field in the base header defines type of header and it appears at end of fixed-size base header.

» True
» False

Question No: 21  ( Marks: 1) - Please choose one

Altho
ugh message exchange can be used to bind addresses, sending a request for each binding is hopelessly
inefficient.

» True
» False
Question No: 22  ( Marks: 1) - Please choose one

Address mask defines how many bits of address are in suffix?



» True
» False
Question No: 23  ( Marks: 1) - Please choose one

A computer attached to a given network can only communicate with other computers attached to
the same network. Is this a problem with multiple networks?
> True

» False

Question No: 24  ( Marks: 1) - Please choose one

In

the 1970s large organizations began to acquire multiple networks. Each network in the
organization formed island. Employees needed to choose a computer appropriate for each

task. Sothey needed multiple screens, keyboards and computers.

» False
» True
Question No: 25  ( Marks: 1) - Please choose one

The
term self-identifying is used for Classful IP addresses because the class of the address can be computed
from the address

> itself
» prefix
» suffix
» mask
Question No: 26  ( Marks: 1) - Please choose one

In
which method of Address Resolution Protocol the protocol address independent of hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

» T,C
» D

» C



» T.D

Question No: 27  ( Marks: 1) - Please choose one

In
which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
> T
» D

e »C
» T,C

Question No: 28  ( Marks: 1) - Please choose one

Reco
nstruction of original datagram is called reassembly.
» True
» False
Question No: 29  ( Marks: 1) - Please choose one
A
computer needs a complete stack of protocols to run either a client or a server.
> True
» False
Question No: 30  ( Marks: 1) - Please choose one
TCP
uses mechanism to control the flow of data.
» door
> window

» acknowledgment
» retransmission
FINALTERM EXAMINATION
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Question No: 1  ( Marks: 1) - Please choose one
Computer networks are often called -------------- because they use packet technology.
» Ethernet
» Switch networks
» Packet networks
» None of the given
Question No: 2  ( Marks: 1) - Please choose one
A network uses a ------ arranges for computers to be connected in a closed loop.
» Star Topology
» Ring Topology
» Bus Topology
» None of the given
In a ring topology each computer is connected to other thorough a ring
Question No: 3  ( Marks: 1) - Please choose one
An --------m-- method, the network hardware designers specify how type information is included in the

frame and the value use to identify various frame types.

» Explicit frame type

» Ideal frame type
» Implicit frame type
» None of the given
EXPLICIT FRAME TYPE:
In this type the identifying value is included with frame describes types of

included data.



Question No: 4  (Marks: 1) - Please choose one

An interface for thin Ethernet must have an connector , and must generate signals
according to the specification.

» RJ-45, 10 Base T (reference not available)
» RJ-45, 10 Base 5

» BINC, 10 Base 2
» BNC, 10 Base T
Question No: 5  (Marks: 1) - Please choose one

A Bridge forwards or filters a frame by comparing the information in its address table to the
frame’s

» Layer 2 source address
» Source node’s physical address

» Laver 2 destination address  (not confirm)

» Layer 3 destination address
Question No: 6  ( Marks: 1) - Please choose one

Most WAN systems include a mechanism that can be used to eliminate the common case of duplication
routing is called

» Hierarchal address

» Default route

» Shortest path
» None of the given

Most WAN systems include a mechanism that can be used to eliminate the common case of duplication
routing is called Default route. The mechanism allows a single entry in a forwarding table to replace a
long list of entries that have the same next hope value

Question No: 7  ( Marks: 1) - Please choose one
of TCP/IP layering model, corresponds to basic network hardware.
»> Physical Layer
» Network Interface Layer
» Internet Layer

» Transport Layer



LAYER 1:
Corresponds to basic network hardware layer in OSI
Question No: 8  ( Marks: 1) - Please choose one
protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
» Internet Layer
» Transport Layer

The Internet layer in the TCP/IP reference model is responsible for transferring data between the source
and destination computers

Question No: 9  ( Marks: 1) - Please choose one

is called an end-to-end protocol because it provide a connection directly from an application on
one computer to an application on a remote computer.

> [P
» UDP
» TCP
» None of the given
UDP has the following characteristics.
It is an end-to-end protocol. It provides application-to-application communication.
Question No: 10  ( Marks: 1) - Please choose one
uses distance vector approach to define routing
» BGP
» OSPF
» RIP
» None of the given
DISTANCE-VECTOR ROUTING:
* It is very simple to implement.

* Packet switch updates its own routing table first.



e It is used in RIP.
Question No: 11  ( Marks: 1) - Please choose one

is ideal in a situation where the group is small and all members are attached to contiguous
Local Area Networks.

» Flood-and -Prune

» Configuration-and -Tunneling
» Core-Based Discovery

» None of the giveOO6E
FLOOD-AND-PRUNE:

Flood-and-prune is ideal in a situation where the group is small and all members
Are attached to contiguous Local Area Networks.
Question No: 12 ( Marks: 1) - Please choose one

Router that decrements TTL to __ sends ICMP time exceeded message, with router’s address as source
address

> 3
> 2
> 1
> 0
Router that decrements TTL to 0 sends ICMP time exceeded message, with router’s
address as source address
Question No: 13  ( Marks: 1) - Please choose one
Protocol addresses are abstractions provided by
» hardware

» software

» operating system

» internet
PROTOCOL ADDRESSES AND PACKET DELIVERY:
Protocol addresses are abstractions provided by software

Question No: 14  ( Marks: 1) - Please choose one



Although message exchange can be used to bind addresses, sending a request for each binding is
hopelessly inefficient.

» True
» False
CASHING ARP RESPONSES:
Although message exchange can be used to bind addresses, sending a request for

each binding is hopelessly inefficient
Question No: 15  ( Marks: 1) - Please choose one

ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.

> 32,48

> 24, 32

» 32,64

> 32,128
ARP is almost always used to bind a 32-bit IP address to a 48-bit Ethernet address
Question No: 16  ( Marks: 1) - Please choose one

In the 1970s large organizations began to acquire multiple networks. Each network in the organization
formed island. Employees needed to choose a computer appropriate for each task. So they needed
multiple screens, keyboards and computers.

» False
> True
In the 1970s large organizations began to acquire multiple networks. Each
network in the organization formed island. Employees needed to choose a
computer appropriate for each task. So they needed multiple screens, keyboards
and computers.
Question No: 17  ( Marks: 1) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?



> T ypes of
Features

> D esolution

> C

» T,C Use full with any hardware T
Address change affects all hosts T
Protocol address is determined by C
hardware address

Question No: 18  ( Marks: 1) - Please choose one

The general form of an IP datagram is with a header followed by data. The header contains information
that controls where and how the datagram is to be sent.

» True
» False

. Header contains all information needed to deliver datagram to the destination
computer. It contains:

* Destination address

* Source address

* Identifier

* Other delivery information
Question No: 19  ( Marks: 1) - Please choose one

To save traffic, an EGP does not summerize routing information from the autonomous system before
passing it to another autonomous system.

» True

» False
"It provides routing among autonomous systems (EGP).
Question No: 20  ( Marks: 1) - Please choose one

Which of the following is a correct representation of the IPv6?



> 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255

» 105.220.136.100.255.255.255.256.0.0.18.128.140.10.255.255
» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255.256

» 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255
Question No: 1  (Marks: 1) - Please choose one

The number of connections needed for N computer in direct point to point communication is equal to:

> (N>=N)/2
» N(N-1)
> N?

» None of the given

For ‘n’ computers connections in direct point to point communication = (n"\2 —n)/2.

Question No: 2  ( Marks: 1) - Please choose one

When an application--------------- data, it makes a copy of the data available to all other computers on the
network.

» Broadcasting
» Multicasting
» Unicasting

» None of the given (not sure)

Question No: 3  ( Marks: 1) - Please choose one

Ethernet uses a ------ bit static addressing scheme in which each device is assigned a unique address by
the manufacturer.

> 64

> 48

> 32

> 8
Ethernet uses a 48-bit static addressing scheme
Question No: 4  (Marks: 1) - Please choose one

A system with redundant bridges might have a problem with in the system.



» Loop

> Filters
» Spanning Trees
» All given choices
Reference not available
Question No: 5  ( Marks: 1) - Please choose one
The product of delay and throughput measures the ______ of data that can be present on the network.
> Area
» Volume
» Length
» None of the given

It is computed as delay time multiplied by effective throughput. It measures amount of data that can be
present in the network

Question No: 6  ( Marks: 1) - Please choose one

Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction and
operating system independent are the characteristics of

» TCP
» UDP
» 1P
» None of the given
UDP has the following characteristics.
« It is an end-to-end protocol. It provides application-to-application communication.
« It provides connectionless service.
« It is a Message-Oriented protocol.
« It uses best-effort delivery service.
« It follows arbitrary interaction.

« It is operating system independent
Question No: 7 (Marks: 1) - Please choose one



Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided
by

» None of the given
» TCP
» UDP
» IP
SERVICE PROVIDED BY TCP:
Following are the services provided by TCP:
* Connection-oriented service
* Point-to-point
» Complete reliability
* Full-duplex communication
* Stream interface
* Reliable connection startup
* Graceful connection shutdown
Question No: 8 ( Marks: 1) - Please choose one
The process of using a routing table to select a next hop for a given datagram is called
» Encapsulation
» Reassembling
> Routing or forwarding
» None of the given
Reference not available
Question No: 9  (Marks: 1) - Please choose one
uses distance vector approach to define routing
» BGP
» OSPF

> RIP



» None of the given
DISTANCE-VECTOR ROUTING:
« It is very simple to implement.
* Packet switch updates its own routing table first.
e It is used in RIP.

Question No: 10  ( Marks: 1) - Please choose one

A multicast routing scheme in which the protocol software builds a delivery tree from a central point is

called
» Distance Vector Multicast Routing Protocol (DVMRP)
» Core Based Trees (CBT)
» Protocol Independent Multicast_ Sparse Mode (PIM-SM)
» Protocol Independent Multicast _ Dense Mode (PIM-DM)

CORE BASED TREES (CBT):
A multicast routing scheme in which the protocol software builds a delivery tree

from a central point.

Question No: 11  ( Marks: 1) - Please choose one

One repeater , two repeaters the maximum cable length limitation.
» doubles, cancel

» doubles, triple

» square roots, cude roots

» and, triple
One repeater doubles, two repeaters triple the maximum cable length limitation.
Question No: 12 ( Marks: 1) - Please choose one

Whenever it handles a packet, IP software needs to separate the destination address into a

» postfix, Infix
» non of these

» Infix, prefix

» prefix, suffix

and



Whenever it handles a packet, IP software needs to separate the destination address into a prefix and

suffix
Question No: 13  ( Marks: 1) - Please choose one

Although message exchange can be used to bind addresses, sending a request for each binding is
hopelessly inefficient.

» True
» False
CASHING ARP RESPONSES:
Although message exchange can be used to bind addresses, sending a request for
each binding is hopelessly inefficient.
Question No: 14  ( Marks: 1) - Please choose one
ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.

> 32,48

> 24, 32

> 32,64

> 32,128
ARP is almost always used to bind a 32-bit IP address
to a 48-bit Ethernet address
Question No: 15  ( Marks: 1) - Please choose one
End-to-end delivery service is connection oriented.

» True

» False

End-to-end delivery service is connection less
Question No: 16  ( Marks: 1) - Please choose one

A single networking technology is best for all needs.

» True



» False

There is no single networking technology that is best for all needs
Question No: 17  ( Marks: 1) - Please choose one

In the 1970s large organizations began to acquire multiple networks. Each network in the organization
formed island. Employees needed to choose a computer appropriate for each task. So they needed
multiple screens, keyboards and computers.

» False

> True
In the 1970s large organizations began to acquire multiple networks. Each network in the organization
formed island. Employees needed to choose a computer appropriate for each task. So they needed
multiple screens, keyboards and computers.

Question No: 18  ( Marks: 1) - Please choose one
Which method of Address Resolution Protocol is useful with any hardware?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

e T Features ypes of
» C .
esolution
» D
Use full with any hardware T
» C,D
Address change affects all hosts T
Protocol address is determined by C
hardware address

Question No: 19  ( Marks: 1) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T Features ypes of
» D esolution
—»C Use full with any hardware T
Address change affects all hosts T
Protocol address is determined by C
hardware address




> T,C

Question No: 20  ( Marks: 1) - Please choose one

We use the term to refer to a measure of the path that routing software use when choosing a
route.

» routing path

» routing metric

» routing
switching

We use the termrouting metric to refer to a measure of the path that routing software use when choosing
a route

Question No: 1 ( Marks: 1) - Please choose one

In Direct point to point communication adding the Nth computer requires------------ new connections.
» None of the given

> N2

> (N2 -N)/2

disadvantage In Direct point to point communication is that adding a new computer to the network requires N-
1 new connections .(P# 23)

Question No: 2 ( Marks: 1) - Please choose one

In Point-to-Point topology there are two topologies.

» Tree and Ring

» Star and Ring

» Star and Tree

» None of the given

Question No: 3 ( Marks: 1) - Please choose one

In -------m-m-- , network occupies the smaller area like a room a floor or a building

» MAN

» None of the given

In LAN network occupies the smaller area like a room a floor or a building.(P# 4)
Question No: 4 ( Marks: 1) - Please choose one

Hardware that calculates a CRC uses two simple components.

» AND unit and XOR unit

> Shift register and XOR unit



» Shift register and AND unit
» None of the given
CRC uses just two hardware components:

Shift register

Exclusive OR ( XOR unit ) .(P# 20)
Question No: 5 ( Marks: 1) - Please choose one
CRC can detect more errors than a simple checksum.
» true
» false
Question No: 6 ( Marks: 1) - Please choose one
The Gigabit Ethernet hardware operates at a rate of --------
» 10 Mbps
» 100 Mbps
> 1000 Mbps
» None of the given
Gigabit Ethernet that operates at 1 Gbps (1000 Mbps) over fiber optics and twisted pair Ethernet cables.
Question No: 7 ( Marks: 1) - Please choose one
Formally named informally known as the twisted pair Ethernet or TP Ethernet.
» 10 Base 2
» 10 Base 5
> 10 Base T
» None of the given
10BASE-T:

This is another standard of wiring scheme. It is commonly called 10Base-T, Twisted Pair or TP Ethernet. (P#
43)
Question No: 8 ( Marks: 1) - Please choose one
An interface for thin Ethernet must have an connector , and must generate signals according to
the specification.
> RJ-45,10 Base T
» RJ-45, 10 Base 5
» BNC, 10 Base 2
» BNC, 10 Base T
Question No: 9 ( Marks: 1) - Please choose one
A system with redundant bridges might have a problem with in the system.
> I.oop
» Filters
» Spanning Trees
» All given choices
Question No: 10 ( Marks: 1) - Please choose one
computes shortest paths in a graph by using weights on edges as a measure of distance.
» Greedy algorithm
» Distance vector algorithm
> Dijksta’s algorithm
» Non of the given
Djikstra’s algorithm can accommodate weights on edges in graph. The shortest




path is then the path with lowest total weight (sum of the weight with all edges). It should

be noted that the shortest path is not necessarily with fewest edges (or hops).
Question No: 11 ( Marks: 1) - Please choose one

Basic LAN technologies such as Ethernet, Token Ring, and FDDI usea____ .

» Connectionless service paradigm

» Connection-oriented service paradigm

> Both Connectionless and Connection-oriented service paradigm

» None of the given

Question No: 12 ( Marks: 1) - Please choose one

protocols of TCP/IP layering model specify how to ensure reliable transfer.

» Physical Layer

» Network Interface Layer

» Internet Layer

» Transport Layer

LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer.
Question No: 13 ( Marks: 1) - Please choose one

An Internet Address (IP address) is a unique binary number assigned to a host and used for all
communication with host

> 48-bit

> 32-bit

» 24-bit

» None of the given
An Internet address (IP address) is a unique 32-bit binary number assigned to a

host and used for all communication with the host
Question No: 14 ( Marks: 1) - Please choose one
The address identifies the physical network to which the computer is attached, while the
identifies an individual computer on that network.
» prefix , suffix
> suffix , prefix
» suffix , suffix
» None of the given
PREFIX:

It identifies the physical network to which the computers are attached.
SUFFIX:

It identifies an individual computer on the network.
Question No: 15 ( Marks: 1) - Please choose one
places the boundary between the first and second octets
» Class A
» Class B
» Class C
» Class D
Class A places the boundary between the first and second octets. Class B places the boundary between the
second and third octets, and class C places the boundary between the third and fourth octets.



Question No: 16 ( Marks: 1) - Please choose one
places the boundary between the third and fourth octets.
» Class A
» Class B
» Class C
» Class D
Class A places the boundary between the first and second octets. Class B places the boundary between the
second and third octets, and class C places the boundary between the third and fourth octets.

Question No: 17 ( Marks: 1) - Please choose one
field of header indicates whether a datagram is a fragment or a complete datagram.

» FLAGS
» FLAGMENT OFFSET
» IDENTIFICATION
> None of the given
FRAGMENTATION:
IP uses fragmentation i.e. datagrams can be split into pieces to fit in network with small MTU. Each fragment
is an independent datagram. It includes all header fields. Bit in header indicates that the datagram is a fragment
Question No: 18 ( Marks: 1) - Please choose one

provides connectionless service.
» TCP
» UDP
» 1P
» None of the given

UDP has the following characteristics.

« It is an end-to-end protocol. It provides application-to-application communication.
* It provides connectionless service.

* It is a Message-Oriented protocol.

» It uses best-effort delivery service.

« It follows arbitrary interaction.

» It is operating system independent

Question No: 19 ( Marks: 1) - Please choose one

UDP and TCP are both layer protocols

» Physical

» Data link

» Network

» Transport

Question No: 20 ( Marks: 1) - Please choose one

Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream
interface, Reliable connection startup and Graceful connection shutdown are the services provided
by

» IP

» None of the given



> TCP
» UDP
SERVICE PROVIDED BY TCP:

Following are the services provided by TCP:
+ Connection-oriented service

* Point-to-point

» Complete reliability

* Full-duplex communication

* Stream interface

* Reliable connection startup

* Graceful connection shutdown
Question No: 21 ( Marks: 1) - Please choose one

protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
» Internet Layer
» Transport Layer
LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer
Question No: 22 ( Marks: 1) - Please choose one

identifies which application program on receiving computer should receive the data
» Logical address
» Source port
> Destination Port
» None of the given
FieldDestinationPort identifies which application program on receiving computer should receive the data.
While field source port identifies the application programs that sent the data. (reference from E-books)
Question No: 23 ( Marks: 1) - Please choose one

identifies the application program that sent the data.

» DestinationPort
» Source port
» Logical address
» None of the given
FieldDestinationPort identifies which application program on receiving computer should receive the data.
While field source port identifies the application programs that sent the data. (reference from E-books)
Question No: 24 ( Marks: 1) - Please choose one
The Border Gateway Protocol (BGP) uses for all communication
» UDP
» TCP
» Both UDP and TCP
» None of the given

BORDER GATEWAY PROTOCOL:



It is most popular Exterior Gateway Protocol in Internet. It has following characteristics:
"It provides routing among autonomous systems (EGP).
"It provides policies to control routes advertised.

"It uses reliable transport (TCP).
Question No: 25 ( Marks: 1) - Please choose one
Which of the following protocols allows the sender and receiver to enforce polices.
» RIP
» OSPF
» BGP
» RIP and OSPF
Question No: 26 ( Marks: 1) - Please choose one
uses distance vector approach to define routing
» BGP
» OSPF
> RIP
» None of the given
ROUTING INFORMATION PROTOCOL (RIP):

It has the following characteristics:

"It is used for routing within an autonomous system (IGP).

"Hop Count Metric: RIP measures distance in network hops, where each network
between the source and destination counts as a single hop.

"It uses UDP for all message transmissions.

"RIP is used over LAN. Version 1 of RIP uses hardware broadcast and version 2 allows
delivery via multicast.

"It can be used to advertise default route propagation. An organization can use RIP to
install a default route in each router.

"It uses distance vector algorithm.

Question No: 27 ( Marks: 1) - Please choose one

ICMP message transport is acted upon by getting ICMP encrypted in IP.
» True

» False

ICMP message transport is acted upon by getting ICMP encapsulated in IP (P# 117)
Question No: 28 ( Marks: 1) - Please choose one

Protocol addresses are abstractions provided by

» hardware

» software

» operating system

» internet



Protocol addresses are abstractions provided by software
Question No: 29 ( Marks: 1) - Please choose one

These packets serve same purpose on as frames on
» Intranet, LAN

» Internet, WAN

» Intranet, WAN

> Internet, LAN

VIRTUAL PACKETS:

These packets serve same purpose in Internet as frames on LAN

Question No: 30 ( Marks: 1) - Please choose one

Address mask defines how many bits of address are in suffix?

» True

» False

Address mask defines how many bits of address are in prefix. Prefix defines how much of address used to
identify network.

Question No: 31 ( Marks: 1) - Please choose one

A single networking technology is best for all needs.

» True

> False

There is no single networking technology that is best for all needs

Question No: 32 ( Marks: 1) - Please choose one

A computer attached to a given network can only communicate with other computers attached to the same
network. Is this a problem with multiple networks?

» True
» False
The chief problems with multiple networks are as follows:

* A computer attached to a given network can only communicate with other

computers attached to the same network.

Question No: 33 ( Marks: 1) - Please choose one

The term self-identifying is used for Classful IP addresses because the class of the address can be computed
from the address

> itself

» prefix

> suffix

» mask

Classful IP addresses are self-identifying because the class of the address can be computed from the address
itself

Question No: 34 ( Marks: 1) - Please choose one

Find the class of the address.

10100111 11011011 10001011 01101111

> A

»>B

» E

> C



Reference table handouts P # 87

Question No: 35 ( Marks: 1) - Please choose one

Find the class of the address:

11110011 10011011 11111011 00001111

> A

» C

> E

» B

Reference table handouts P # 87

Question No: 36 ( Marks: 1) - Please choose one

In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
> T

» D

»C

> T,C

Reference table handouts P # 97

Question No: 37 ( Marks: 1) - Please choose one

Which method of Address Resolution Protocol requires hardware broadcast?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
»D

> T

» C

» T,D

Reference table handouts P # 97

Question No: 38 ( Marks: 1) - Please choose one

Which method of Address Resolution Protocol resolution with minimum delay?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
» T,D

» C

» T

> T,C

Reference table handouts P # 97

Question No: 39 ( Marks: 1) - Please choose one

In which method of Address Resolution Protocol the implimentation is more difficult?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
> T,C

> T

» C

»D

Reference table handouts P # 97

Question No: 40 ( Marks: 1) - Please choose one

On of the design goals for unicast route propagation is

» Consistency

» inconsistency

> stability
» dynamic addressing




On of the design goals for unicast route propagation is stability—continual changes in route are undesirable
because they lead to higher jitter and datagram arriving out of order. Thus, once a unicast routing protocol
finds a shortest path, it usually retains the route until a failure makes the path unusable. (Reference from E-
book)

Question No: 41 ( Marks: 1) - Please choose one

Propagation multicast routing information differs dramatically from unicast route propagation?

> True

» False

Propagating multicast routing information differs dramatically from unicast route propagation. The difference
arises because internet multicast allows dynamic group membership and autonomous senders

Question No: 42 ( Marks: 1) - Please choose one

The IP multicast abstraction allows an application running on an arbitrary computer to leave a multicast group
at any time. While application on a computer remain a member of a group.

» One or more

» only one

» 1o

» many

Question No: 43 ( Marks: 1) - Please choose one

To save traffic, an EGP does not summerize routing information from the autonomous system before passing it
to another autonomous system.

» True

» False

To save traffic, an EGP summerize routing information from the autonomous system before passing it to
another autonomous system. More important an EGP implements policy constraints that allow a system
manager to determine exactly what information is released outside the organization. (Reference from E-book)
Question No: 44 ( Marks: 1) - Please choose one

In IPv6 the type of address used for collection of computers with same prefix. Are known as

» Anycast

» Unicast

» Multicast

»> Non of the given
Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.
Multicast: It is used for multiple destinations; possibly not at same site.
Cluster: This type of address is used for collection of computers with same prefix,

datagram is delivered to one out of cluster.

Question No: 45 ( Marks: 1) - Please choose one

Special types of addresses in IPv6 used for multiple destinations; possibly not at same site. Are known
as .

» Unicast

» Anycast

» Multicast



» Non of the given
Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.
Multicast: It is used for multiple destinations; possibly not at same site.
Cluster: This type of address is used for collection of computers with same prefix,

datagram is delivered to one out of cluster.

Question No: 46 ( Marks: 1) - Please choose one

UDP offers application programs a Message-Oriented Interface, applications can depend on protocol to
preserve data boundaries.

» True

» False

UDP offers application programs a Message-Oriented Interface. It does not divide messages into packets for
transmission and does not combine messages for delivery.

ADVANTAGES:

* Applications can depend on protocol to preserve data boundaries.
Question No: 47 ( Marks: 1) - Please choose one
Reliability is the responsibility of the layer

» Network

» Datalink

» Transport

» Application

Reliability is the responsibility of the Transport layer
Question No: 48 ( Marks: 1) - Please choose one

TCP uses mechanism to control the flow of data.
» door

> window

» acknowledgment

» retransmission

TCP uses window mechanism to control the flow of data.
Question No: 49 ( Marks: 1) - Please choose one

The time for acknowledgement to arrival of packet depends on.
> Distance to destination and Current traffic conditions
» Current traffic conditions

» Distance to destination

» non of these

The time for acknowledgement to arrive depends on:

« Distance to destination

* Current traffic conditions
Question No: 50 ( Marks: 1) - Please choose one
FDDI can transmits data at a rate of ----------

» 100 million bits per second
» 10 million bits per second



» 1000 million bits per second

» None of the given
FDDI: Fiber distributed data interconnect (FDDI) is another ring technology. Its most

important features are:

It uses fiber optics between stations and transmits data at 100Mbps.
Questiol) When an application--------------- data, it makes a copy of the data available to all other

computers on the network.
» Broadcasting
» Multicasting
» Unicasting
» None of the given

2) Ethernet uses a ------ bit static addressing scheme in which each device is assigned a unique address by

the manufacturer.
> 64
> 48
> 32
> 3

3) The product of delay and throughput measures the of data that can be present on the network.

» Area
» Volume (supposition)
» Length

» None of the given

4) Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction

and operating system independent are the characteristics of
» TCP

___» UDP



» 1P
» None of the given
5) uses distance vector approach to define routing
» BGP
» OSPF
> RIP
» None of the given

6) Whenever it handles a packet, IP software needs to separate the destination address into a
and

» postfix, Infix
» non of these
» Infix, prefix
> prefix, suffix
7) ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.

» 32,48

> 24, 32
> 32,64
> 32,128
8) Which method of Address Resolution Protocol is useful with any hardware?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
> T

» C (Supposition)

» D



» C,D

9) In which method of Address Resolution Protocol the protocol address is determined by hardware

address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?

> T
» D
> C
> T,C

10 )We use the term
route.

» routing path
> routing metric
» routing

» switching

11) A network uses a ----

» Star Topology

» Ring Topology

» Bus Topology

» None of the given

to refer to a measure of the path that routing software use when choosing a

arranges for computers to be connected in a closed loop.

12) An interface for thin Ethernet must have an connector , and must generate signals

according to the

> RJ-45,10 Base T

» RJ-45, 10 Base 5

» BINC, 10 Base 2

specification.



» BNC, 10 Base T
13) protocols of TCP/IP layering model specify how to ensure reliable transfer.
» Physical Layer
» Network Interface Layer
» Internet Layer
» Transport I.ayer
14) uses distance vector approach to define routing
» BGP
» OSPF
» RIP

» None of the given

n No: 51 ( Marks: 2)



